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1 Introduccidén

ARTA es un programa para la medicion de la respuesta de impulsos, el analisis de espectros en tiempo
real y la medicion en tiempo real de la respuesta en frecuencia. Es una herramienta para realizar
mediciones acusticas y pruebas "punto por punto" de la calidad del sonido en los sistemas de
comunicacion.

ARTA dispone de funciones de los siguientes sistemas de medicion:

1. Sistema de medicion de respuesta de impulsos con generadores de sefiales: ruido peridodico
blanco, ruido periodico rosa, MLS, ondas sinusoidales de barrido lineal y logaritmico.

2. Analizador de Fourier de doble canal con generadores de sefales: ruido blanco, ruido rosa,
ruido periddico blanco y ruido periédico rosa.

3. Analizador de Fourier de canal sencillo con generadores de sefiales: ruido periddico blanco y
ruido periddico rosa.

4. Analizador de espectros, de banda de octavas y THD con generadores de sefales: onda
sinusoidal, dos rafagas sinusoidales, multitono, ruido blanco, ruido rosa, ruido periodico
blanco y ruido periodico rosa.

Nota: El modo 2 y 3 también se pueden usar para estimar la respuesta de impulsos.

ARTA es un poderoso analizador de:

Respuesta de frecuencias limitada,

Respuesta de frecuencia suavizada (en bandas de 1/n octavas)
Respuesta de etapa,

Envolvente de la respuesta de impulsos (curva - ETC)

Curva de deterioro espectral acumulado,

Deterioro de la energia en los entornos reverberantes,
Parametros acusticos de la sala,

Medidas de inteligibilidad del habla: MTF, STI, RASTI, %AL.

NN RN =
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1.1 Requisitos

Los requisitos para usar ARTA son:

e Sistemas operativos: Windows 98/Me/2000/XP

e Procesador Pentium, Pentium III o superior, con una frecuencia de reloj de 400 MHz o
superior, y una memoria de 256MB

e Tarjeta de sonido duplex completa con reloj sincronico para conversores AD y DA

e Tarjeta de video de alta calidad

ARTA se ha usado con resultados satisfactorios con las siguientes tarjetas de sonido:

RME Fireface 800, RME DIGI96, RME HDSP

Terratec EWX 24/96 Firewire FW X24

M-audio Audiophile 2496, USB Transit, Delta 44,

YAMAHA GO 46

Digigram VxPocket 440 — una tarjeta PCMCIA para portatil

Echo Layla 24 Echo Indigo

TASCAM US-122 - USB audio

ESI Quatafire 610, U24 USB and Waveterminal,
Soundblaster X-Fi

Soundblaster Live 24 y Audigy y Extigy-USB (pero sélo a la frecuencia de muestreo de
48kHz),

e Tarjetas Turtle Beach Pinnacle y Fuji,

ARTA se puede usar con un rendimiento ligeramente menor con las siguientes tarjetas:

e Soundblaster MP3+ USB (nota: no instale un controlador USB, use el controlador por defecto
de Windows XP),

e Tarjetas de sonido y audio incorporado con cddecs AC97 (problema con ruido alto en el modo
FTT).

La instalacion de este software es simple: Siga el programa de configuracion de ARTA o simplemente
copie los archivos "ARTA.exe" y "ARTA.chm" en una carpeta y haga un acceso directo a
"ARTA.exe". Todos los datos del registro se guardaran automaticamente la primera vez que se ejecute
el programa.

Los archivos con la extension ".PIR" se registran para que se abran con el programa ARTA.
Contienen los datos de la respuesta de impulso periddica (PIR). Los resultados de otros tipos de
mediciones (respuesta en frecuencia y espectro) se pueden guardar como archivos de texto con
formato ASCII, o como archivo de superposicion.

ARTA puede exportar e importar archivos de diferentes formatos (wav, mlssa, tim y txt).

ARTA no envia los graficos a la impresora, pero se pueden copiar todos los graficos en el
Portapapeles de Windows y pegar en otras aplicaciones de Windows.
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1.2 Configuracion de la medicion

En este documento, nos referiremos a las siguientes configuraciones de medicion:

Configuracion de medicion en canal doble
Configuracion de medicion en canal sencillo
Configuracion de medicion en canal semi doble
Bucle para pruebas de tarjetas de sonido

Rl o e

La configuracion general para medicion de las pruebas de sistema es la que aparece en la Ilustracion
1.1. El canal de salida de sefal izquierdo de la tarjeta de sonido se usa como salida del generador de
sefales. La entrada de linea izquierda se usa para medir el voltaje de salida del dispositivo a prueba y
la entrada de linea derecha de la tarjeta de sonido se usa para medir el voltaje de entrada del
dispositivo a prueba. En una configuracion de canal sencillo sélo se registra un voltaje de salida del
dispositivo a prueba. En una configuracion de canal semi-doble la entrada de la linea derecha se usa
para medir el voltaje de la salida de la linea derecha. En la modalidad de bucle, la salida de linea
izquierda esta conectada a la entrada de linea izquierda y la salida de linea derecha se conecta a la
entrada de la linea derecha.

device devica
imput output
Left out - D.uT -
|
soundcard
Mot connesied
im snple channe|

misda

lustracion 1.1 Configuracion de
medicion general para pruebas de
respuesta del sistema

(D.U.T. = dispositivo a prueba)

Left imput

Las configuraciones para realizar mediciones actsticas se muestran en las Ilustraciones 1.2, 1.3, 1.4y
1.5.

w porwer amplifier

microphane
Left out %ﬂ

loudspeaker
soundcard voltage probe o

lHustracion 1.2 Configuracion
. ] .

<" de la medicion en canal doble
para mediciones acusticas

Right input

preamplifier

Para proteger la entrada de la tarjeta de sonido frente a los voltajes elevados que se generan en el
amplificador de potencia, se recomienda usar el circuito de sonda de voltaje, como aparece en la
Ilustracion 1.3. Los valores de las resistencias R1 y R2 se han de elegir para una atenuacion arbitraria
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(es decir que R1=8200 y R2=910 ohmios nos da una sonda con una atenuacion de -20,7 dB (0,0923) si
la tarjeta de sonido tiene una impedancia normal de entrada de - 10kU).

o MW y
R
power
sF:un!:li:-ard § R FENer amplifiar
line input 4.1y output
e 1

powver amplifier

microghane

loudspeaker

porwer amplifier

T

preamplifier

microghane

loudspeaker

.
<

preamplifier

lustracion 1.3 Sonda de
voltaje con proteccion frente a
sobrecarga del canal de entrada
de la tarjeta de sonido.

lustracion 1.4 Configuracion de
la medicién en canal sencillo
para mediciones actsticas

lustracion 1.5 Configuracion
de la medicion en canal semi-
doble para mediciones acusticas

lustracion 1.6 Configuracion
de bucle para pruebas de
tarjetas de sonido
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ARTA esté disefiado para realizar pruebas "punto por punto" de la calidad del sonido en los sistemas
de comunicacion. La Ilustracion 1.7 muestra la configuracion que se usa para probar esos sistemas. Se
puede obtener una interfaz para teléfonos moviles usando la entrada/salida de unos cascos auriculares.
La interfaz para la linea de teléfono normal (POTS) se muestra en la Ilustracion 1.8.

ARTA puede medir la respuesta de impulso y en frecuencia, las distorsiones de sefiales sinusoides,
sinusoides dobles, multitonos, estimar retardos, ecos e indices de transmision del habla. Se aplica una
técnica especial de medicion, con una excitacion de ruido interrumpida, para evitar el comportamiento
variable en el tiempo de estos sistemas (control de ganancia automatica, reduccion de ruido, activacion
de la voz).

3
; .
Right out attenuator
] 2amy
Left out » 3
aoundcand
Righit input =
Leftinput | / L]
L1

lustracion 1.7 Configuracion de medicion para probar los sistemas de comunicacion

autput
B et
phone 101/ 600 L2 l input
B o
L)
100/ 250 W 2200 02
10n § 560
== Iy zaner

20H7 210142 4.4V >

spundcard
e L

lustracion 1.8 Interfaz entre la salida/entrada de la tarjeta de sonido y la linea de teléfono normal
(POTS)
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1.3 La primera impresion

Al arrancar ARTA aparecera la ventana del programa que aparece en la ilustracion 1.9. Esta ventana
se llama Ventana de respuesta de impulsos (ventana imp), y sera la que se use para mostrar la
respuesta de impulsos.

[& untitled - Arta - 10| x|

File Edit View Record Analysis Setup Tools Mode Help

Cu [ 7 [[Iwe Fre Fro Sea | v | =0 mm |25 (8 659 5 9 @ U [0F | @
FFT [4095 =] window [Unifom | Delay for phase estimation (ms) [0.000 | Get | | Zero | | Inv]

Impulse response (M) tark.er
1.682 $
1172 A af Offget
0.781 hd M
0.281 Gain
0.000 | M ax
-0.391 | M
-0.781 > aam
-1.172 o
-1.5682 7| Max
0.00 1.80 2.7% B.T1 7.80 ms Scroll
Cursor: 0.000 0V, 0.000 ms (0) ]
Ready | L:-100.0dE | R:-100.0dB | Impulse Response S

llustracion 1.9 Ventana de respuesta de impulsos

Usando el mentt Mode [Modo], podra cambiar entre las tres ventanas del dominio de la frecuencia
para realizar analisis en tiempo real.

e Ventana de mediciones de respuesta en frecuencia de canal doble
¢ Ventana de mediciones de respuesta en frecuencia de canal sencillo
e Ventana del analizador de espectros

El modo de medicion se puede escoger también haciendo clic sobre los siguientes iconos de la barra
de herramientas:

Fr» - Ventana de mediciones de respuesta en frecuencia de canal doble
Fri - Ventana de mediciones de respuesta en frecuencia de canal sencillo
Spa - Ventana del analizador de espectros

Iyip - Ventana de respuesta de impulsos

Ahora haga clic sobre estos ments o iconos de la barra de herramientas para ver como funcionan las
ventanas de medicion.
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3 =100 x|
File Overlay Edit View Recorder Generator Setup Mode Help
Ca(7” |(Ive|Frz Fri Sea [ @ [ & |7 | N | = m | = &
Gen [PNpink  v| FsHz) [4g000 v FFT 8192 =] Delayims)[0.000 avg [Linear x| | Reset|
Top
FR Magnitude dB Vi LeftRight &wvg:2 ﬂ
-100.0
A -
-110.0 R
-120.0 1 Fit |
-130.0 Range
-140.0 .
-15[55& ﬂ
-160.0
170.0 et |
-180.0 FrHigh
-150.0 4| rI
-200.0
100 1000 10000 FrLow
Cursor:  23.4 Hz, -200.00 dB Frequency(Hz) R
Ready |L:-100.0d8 | R:-100.0dB | Frequency response 2Ch 2

llustracion 1.10 Ventana de respuesta en frecuencia en canal doble - Fy, (la ventana respuesta en
frecuencia en canal sencillo - Fy; es igual)

O] =|
File Overlay Edit View Recorder Generator Setup Mode Help
Ci|»” [Inp Frz Fri(Spa | 0 @ [ @ (e | N | =0 = | = &2
Gen [PNpik | FsHz) [48000 =] FFT [16384 =] wid[Unform =] 4vg [None =] | Reset]
Top
. Spectrum magnitude dBFS Left Awvg:0 ﬂ
l‘!.' -
R
-20.0 T Fit |
A
-40.0 Range
£0.0 ﬂ
-80.0
-100.0 et |
-120.0 FrHigh
4| PI
-140.0
100 1000 10000 Friow
Curzor: 20.5Hz, -187.58 dB Frequency(Hz}
RMS = -150.6 dBFS I
Ready |L:-100.0d8 | R:-100.0dB | Spectrum Analyzer v

llustracion 1.11 Ventana del analizador de espectros
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La ventana de la respuesta de impulsos es la mas importante para el anélisis de la respuesta de un
sistema. Se describira con mas detalle una vez que veamos como se analiza el espectro y la respuesta
de frecuencia del sistema.

1.4 Configuracién de hardware

Antes de comenzar a medir, tendra que configurar el hardware y los dispositivos de sonido haciendo
clic sobre Setup > Audio Devices [Configuracion > Dispositivos de audio] o sobre el icono de la

barra de herramientas =% . Obtendra el cuadro de didlogo de configuracion de la tarjeta de sonido que
aparece en la ilustracion 1.12.

Audio Devices Setup |

—Sound card
Input Device | EWX 24/96 Wave Analog =l
Qutput Device I E'wi 2496 W ave Analag j
waveFormat & 16bit ¢ 24bit 32 bit Extensible W

— 140 &mplifier Interface
Lineln Sensitivity I LineQOut Senzitivity I
[t peak - left ch] 273243 [ peak: - left ch) 2910
Eut. left preamp gain I 1 L/R channel diff. [dB] I I
Ext. right preamp gain I 0.0923 Power amplifier gain I 1

— Microphaone

[~ Microphone Used On ILeft Ch "I Sensitivity [myw/Fal I 8

Save zetup | Load zetup | Carnicel | k. I

lustracion 1.12 Cuadro de dialogo para la configuracion de los dispositivos de audio

El cuadro de dialogo Configuracién de dispositivos de audio tiene los siguientes controles:

En la seccion Sound Card [Tarjeta de sonido]:
Input device [Dispositivo de entrada] — elija la tarjeta de sonido que funciona como dispositivo de
entrada.
Output device [Dispositivo de salida] — elija la tarjeta de sonido que funciona como dispositivo de salida.
Generalmente habra de escoger la misma tarjeta como dispositivo de entrada y salida (no sera necesario
con los modos de Analizador Fourier de Doble Canal o de Analizador de Espectros).
Wave format [Formato de la onda] — elija el formato de onda Windows de 16 bits, 24 bits o 32 bits.
ARTA utiliza los controladores de sonido de Windows habituales (WMME para Windows 98 y WDM —
formato extensible para Windows XP). Le recomendamos el modo WMME y 16 bits. Asi que dejaremos la
casilla de verificacion 'Extensible’ sin activar. Por supuesto podra experimentar con modos diferentes, pero
tenga en cuenta que el modo de 32 bits no funciona con muchas tarjetas de sonido en formato WDM
Extensible. Se recomienda usar los modos de 24 o 32 bits s6lo si tiene una tarjeta de sonido de muy alta
calidad (muchas tarjetas de sonido se anuncian como de 24 bits, pero su resolucion real es inferior a 16
bits).

En la seccion 1/O amplifier interface [Interfaz del amplificador de Entrada/salida]:

10
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Lineln sensitivity [Sensibilidad de la linea de entrada] — introduzca la sensibilidad de la linea de entrada
(es decir, el voltaje pico en mV que se corresponde con la excitacion total de la entrada de la linea)
LineOut sensitivity [Sensibilidad de la linea de salida] - introduzca la sensibilidad de la linea de salida
izquierda (es decir, el voltaje pico en mV que se corresponde con la excitacion total de la salida de la linea)
Ext. Preamp gain [Ganancia del preamplificador exterior] — si conecta el preamplificador o la sonda de
voltaje a las entradas de la linea deberia introducir la ganancia del preamplificador o la atenuacion de la
sonda en el cuadro de edicion, sino déjelo como ganancia de unidad.

LR channel diff [Diferencia entre el canal izg./dch.] — introduzca la diferencia entre el nivel de los
canales de entrada izquierdo y derecho en dB.

Power amplifier gain [Ganancia de amplificador de potencia] - Si conecta el amplificador de potencia a
la salida de linea, y si necesita resultados calibrados en la configuracion del canal sencillo, habra de
introducir la ganancia de voltaje del amplificador de potencia.

La mejor manera de introducir estos valores es seguir el procedimiento de calibracion tal como se describe
en el siguiente capitulo.

En la seccion Microphone [Micréfono]:

Sensitivity [Sensibilidad] — introduzca la sensibilidad del micr6fono en mV/Pa.

Microphone used [Micrdfono usado] — active esta casilla si usa microéfono y desea que el grafico se
escale en in dB re 20iPa o dB re 1Pa. Ademas, use el cuadro desplegable para elegir el canal al que se
conecta el micréfono (le recomendamos encarecidamente usar el canal izquierdo de la tarjeta de sonido
como canal de entrada del micréfono).

Los datos de la configuracion se pueden guardar y cargar, pulsando los botones 'Save setup’ [Guardar
configuracion] y 'Load setup’ [Cargar configuracion]. Los archivos de configuracion tienen la extension '.cal'.

Antes de continuar con el programa ARTA, asegure los siguientes valores por defecto.

Nota importante: Por favor, enmudezca los canales de sefial y micréfono en la mezcladora
de salida de la tarjeta de sonido. De no hacerlo asi puede obtener una retroalimentacion
positiva durante las mediciones. Si usa una tarjeta de sonido profesional, desactive el
control directo o de latencia cero de las entradas de linea.

i Master Yolume o [m] [
COpkions  Help
bl azter Wolume W e CD Audio Line In ticrophone
B alance: Balance: Balance: Balance: Balance:
Yalurne: Walume: Walume: Yoalume: Walume:
- e T L e
™ tute al ™ Mute [ Mute ¥ ute ¥ tute
Advanced | Advanced |
|Inte|{r]l Integrated Audio

lustracion 1.13 Configuracion tipica de la salida de la mezcladora de la tarjeta de sonido (la

encontrara en el cuadro de didlogo del panel de control 'Sound and Audio Devices' [Dispositivos de

sonido y audio])
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ARTA User Manual

El comando de menu Setup > Calibrate devices [Configuracion > Calibracion de dispositivos] abre
el cuadro de dialogo 'Soundcard and Microphone Calibration' [Calibracion de la tarjeta de
sonido y del micréfono] que aparece en la ilustracion 1.14.

Soundcard and Microphone Calibration x|
—Soundcard Full scale output {myy —— —Soundcard Full scale input {my) —— —Microphone sensitivity (b Pa)
1. Conneck electronic walkmeter 1. Connect sine generator with 1. Cannect microphone an
ar scope on left oukpuk channel known output volkage on
sek range ko 2Y
! . ) Channel m Channel I Left j'
2, fGenerate sine (S00Hz) | 2. Erker voltage (peak or rms) Preamp gain I 1
Cukput level I -3dB vI 500 I b rms j
2, atkach sound calibrator
3, Enter voltmeter (scope’ value
3. Estimate Max Inpuk my | Pressure 24 dB
1000 I ' rms j
: Estimated  Current 3, Estimate Mic, Sensitivity |
4, | Estimate Max Oubpuk k! | Left I 718,33 I 718,35 my
Estimated Current Right |?21-'35‘- |?21-05‘- m'é Estimated  Current
[ 7r2z | 7722 mw || DF [oosesr [ooses dB | 20 | 20 mwpa
Gecepk | Lecepk | Gecepk |
L | -0 | =50 | -3 | -10 clB
R =0 | 0 | Ty | ] | T Cancel I Ok |

lustracion 1.14 Cuadro de dialogo para calibrar la tarjeta de sonido y el micréfono

Hay tres secciones que nos conducen a la calibracion de

(a) canal izquierdo de salida de la tarjeta de sonido,

(b) canales izquierdo y derecho de entrada a la tarjeta de sonido y

(c) calibracion del microfono.

1.5.1 Calibracion del canal izquierdo de salida de la tarjeta de sonido

Se recomienza seguir este procedimiento:

SAINAIE ol S e

Conecte el voltimetro electronico al canal de salida izquierdo.

Pulse el boton 'Generate sine (500Hz)’ [Generar onda sinusoidal (500Hz)]

Introduzca el valor medido por el voltimetro en la casilla (en mV rms).

Pulse el boton "Estimate Max Output mV* [Estimar la salida maxima en mV]

El valor estimado aparecera en la casilla 'Estimated’ [Valor estimado].

Si esta satisfecho con la medicidn, pulse el boton 'Aceptar’, y el valor estimado se convertira

en el valor actual de 'LineOut Sensitivity' [Sensibilidad de salida].

12
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1.5.2 Calibracion de los canales de entrada a la tarjeta de sonido

Podra usar un generador externo o el canal de salida de la tarjeta de sonido para calibrar los canales de
entrada. En caso de usar el canal de salida de la tarjeta de sonido como generador calibrado:

1. Establezca el volumen de entrada de la linea izquierda y derecha al maximo.
. Conecte la salida izquierda a la entrada de la linea izquierda.

3. Pulse el boton 'Generate sine (500Hz)" [Generar onda sinusoidal (500Hz)] y controle el
nivel de entrada en los medidores de pico de la parte inferior. Si la entrada de la tarjeta de
sonido se satura, reduzca el nivel del volumen de entrada a -3dB.

4. Introduzca el valor del voltaje del generador de la sefial en la casilla de edicion. (valor del

voltimetro del capitulo 1.5.1)

Pulse el boton 'Estimate Max Input mV' [Estimar la entrada maxima en mV]

6. Si esta satisfecho con la medicion, pulse el boton 'Aceptar’, y el valor estimado se convertira
en el valor actual de 'Lineln Sensitivity' [Sensibilidad de entrada].

7. Repita los pasos 1-6 para el canal de entrada derecho.

hdl

Nota: Se recomienda este procedimiento puesto que garantiza que se puede conectar la tarjeta de
sonido en modalidad de bucle. Si desea calibrar los canales de entrada con el volumen de entrada en el
maximo, muchas tarjetas de sonido requeriran una reduccion del nivel del canal de salida.

1.5.3 Calibracion del micréfono
Para calibrar el micréfono ha de disponer de un calibrador de sonido. Entonces:

1. Conecte el preamplificador del micréfono a la entrada de la tarjeta de sonido (izquierda o
derecha).

Introduzca la ganancia del preamplificador.

Conecte el calibrador de sonido al micréfono.

Pulse el boton 'Estimate mic sensitivity' [Estimar la sensibilidad del micréfono]

Si esta satisfecho con la medicidn, pulse el boton 'Aceptar’.

Nk wb

Nota: Si no conoce la ganancia del preamplificador, podra indicar cualquier valor arbitrario de
ganancia, pero ese valor se ha de usar como ganancia del preamplificador en el cuadro de didlogo
'Audio Devices Setup’ [Configuracion de dispositivos de audio].

1.5.4 Compensacion de la respuesta en frecuencia

La calidad de las mediciones depende de la calidad de los sensores empleados, es decir, de los
microfonos. Sera posible introducir la respuesta en frecuencia del sensor en ARTA y hacer la
compensacion de su respuesta en frecuencia (aplicando la inversa de la respuesta en frecuencia del
sensor a la respuesta en frecuencia medida).

Con el comando de ment Configuracién > Compensacion de respuesta en frecuencia o haciendo

clic sobre el icono MM sc obtiene el cuadro de dialogo "Frequency Response for Compensation”
[Respuesta en frecuencia para compensacion], que se muestra en la Ilustracion 1.15. El didlogo tiene
un par de controles y un grafico que muestra la respuesta en frecuencia que se usara para compensar la
respuesta en frecuencia.

El boton Load [Cargar] abre el cuadro de didlogo para cargar los archivos ASCII que contienen los
datos de la respuesta en frecuencia.

El nombre del archivo tiene que tener la extension .MIC y los datos introducidos en lineas de texto.
Las lineas que comiencen con un digito o con puntos contendran al menos dos valores: El primer valor
sera la frecuencia en HZ y el segundo es la magnitud de la respuesta en frecuencia en dB. El tercer
valor es opcional. Puede ser el valor de la fase o cualquier otro texto que se tratara como comentario.
El resto de lineas se tratan como comentarios. Después de leer el archivo de compensacidn, aparecera
la ruta del archivo en la casilla que hay debajo del grafico.
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Por ejemplo, el archivo "MBS550-B.mic" (que aparece en la Ilustracion 1.15) tiene el siguiente
contenido:

Micr6fono mb550
frec(Hz) Magn(dB)
48.280 0.34
48.936 0.28
49.601 0.21

E::' Frequency response compensation El
Range(dB)

Magnitude d

=0 : 10 kS

4.0F44 i

3.00:-
¥ Copy |

2.0f - .

1.0f4- :

0.0f:- i

A

20} 13-

3.0} 14 : Shaw

N EEE ' interpolated

L 1 ' values [
Cursor; 48.3Hz 0.3 dB Frequency (Hz)

| C:\sro'\audio 1\Arta 103\MB550-B.mic

Load | IUse frequency response compensation

llustracion 1.15 Respuesta en frecuencia tipica para un microfono electret.

o Lacasilla de verificacion "Show spline interpolated data' [Mostrar datos interpolados de
estria] nos permite ver la curva de la respuesta en frecuencia interpolada que se usara en la
compensacion de la respuesta en frecuencia.

o El botén 'Copy’ [Copiar] copia la imagen del grafico actual al portapapeles.

0 El cuadro de lista desplegable 'Range (dB)' [Rango (dB)] establece el rango dinamico de la
magnitud del grafico (10-100dB).

o El botén 'Use frequency response compensation' [Usar compensacion de la respuesta en
frecuencia] activa/desactiva la compensacion de la respuesta en frecuencia.

1.6 Obtener iméagenes de graficos y ventanas

Normalmente, trabajamos con las ventanas de graficos y los cuadros de didlogo También necesitamos
poder copiar el grafico o la imagen de la ventana de graficos.

Sera simple copiar la imagen de la ventana completa. Pulse simultaneamente las teclas Ctrl+P. Una

vez pulsado el comando se guardara la imagen de la ventana en el Portapapeles, desde el que el
usuario podra copiarlo en otras aplicaciones de Windows (MS Word, MS Paint y Adobe Paint Shop).
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Para conseguir la copia de la imagen del grafico que hay dentro de la ventana, el usuario ha de pulsar
al mismo tiempo las teclas Ctrl+C o activar el comando de ment "Edit->Copy’ [Edicion > Copiar],
o pulsar el boton correspondiente de "‘Copy' [Copiar].

En la barra de herramientas de la ventana principal, el boton 'Copy' [Copiar] aparece con el icono D

Este comando abre el cuadro de dialogo 'Copy to Clipboard with Extended Information' [Copiar
al portapapeles con informacion ampliada] que se indica en la Ilustracion 1.16. Aqui el usuario ha
de configurar tres opciones de copiado:

1) En el cuadro de edicidn el usuario introduce de forma optativa el texto que se afiadira
en la parte inferior del grafico.

La casilla de verificacion 'Add filename and date' [Afiadir nombre de archivoy
fecha] permite afiadir texto al grafico que indica el nombre del archivo, la fecha y

2)

3)

Copy to Clipboard with Extended Information x|

Enter text that will be drawn on the bottom of the graph copy

hora.

Se seleccionara Tamafo del mapa de bits] seleccionando uno de los siguientes
elementos del cuadro combinado:

Current screen size [Tamafio de la pantalla actual] - opcion de ancho y
altura variable

Smallest [Mas pequeiio] (400 pts) - grafico de ancho fijo con 400 puntos
Small [Pequefio] (512 pts) - grafico de ancho fijo con 512 puntos
Medium [Medio] (600 pts) - grafico de ancho fijo con 600 puntos

Large [Grande] (800 pts) - grafico de ancho fijo con 800 puntos
Largest [Mas grande] (1024 pts) - grafico de ancho fijo con 1024
puntos

Las opciones de ancho fijo proporcionan a la copia del grafico la relacion de aspecto

3:2.

Pulsando el boton 'OK' se copia el grafico al portapapeles del sistema.
Si se pulsa el boton 'Cancel' [Cancelar] se cancela la operacion de copia.

I My u:u:ummenﬂ Frequency compensation is recprocal to frequency response

Add filename and date

Choose bitmap size I Current screen size j Cancel |

lustracion 1.16 Cuadro de didlogo Copia al portapapeles con informacién ampliada
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lustracion 1.17 Copia del grafico, que aparece en la Ilustracion 1.15. La informacion extendida

muestra el nombre del archivo, la fecha, el tiempo y el texto definido por el usuario

16



ARTA User Manual

2 Analizador de espectros

El analizador de espectros de ARTA se presenta como analizador de espectros en base FFT a tiempo
real. Un generador incorporado proporciona las siguientes sefiales: onda sinusoidal, dos rafagas
sinusoidales, multitono, ruido blanco, ruido rosa, ruido periédico blanco (PN blanco), ruido periddico
rosa (PN rosa) y ruido hablado periddico (PN habla).

La forma de trabajo con el analizador de espectros se explicara a través del procedimiento de pruebas
de la tarjeta de sonido.

La forma mas sencilla de probar la calidad de la tarjeta de sonido es en el modo analizador de
espectros.

1. Haga una conexion en bucle para probar la tarjeta de sonido.

2. Haga clic sobre el elemento del menti Mode > Spectrum Analyzer [Modo > Analizador de
espectros] o haga clic sobre el icono de la barra de herramientas Spa.

3. Haga clic sobre el elemento del menu Generator > Setup [Generador > Configuracion] o haga

clic sobre el icono de la barra de herramientas . Obtendra un grafico como el que aparece en la
ilustracion 2.1.

Signal Generator Setup x|

— Sine generator — Two zine generator

Frequency [Hz) I 1000 Freqgl Freg2 M agn

® Defl  [TkHz [z [1:1
Peak Level (dB] | 3:|' C Defz  [il0Hz  [BkHz 141

Dither Level [Mane =] £ User 13000 fzooon 1
— Signal generator type————— 1~ Multizine generator

Spectum Im Output volurne (8] I 0 "I

mode Multitare

FR mode IPN pirtk: vI Fink: cut off [Hz] |2E| IWideband j
Drefault | Cancel I ] |

lustracion 2.1 Cuadro de dialogo para la configuracion del generador de sefial
El cuadro de didlogo tiene los siguientes controles:

La seccion Signal generator type [Tipo de generador de sefiales] presenta dos cuadros desplegables.
El cuadro desplegable Spectrum mode [Modo de espectro] establece el tipo de generador de corriente para
el andlisis de espectros:
onda sinusoidal, dos rafagas sinusoidales (para pruebas de intermodulacion), multitono, ruido blanco
continuo, ruido rosa continuo y ruido periddico con espectro blanco, rosa y hablado (PN blanco, PN rosa,
PN habla).
El cuadro desplegable FR mode [Modo de respuesta de frecuencia] establece el tipo de generador de
corriente para las mediciones de la respuesta en frecuencia:
ruido blanco continuo, ruido rosa continuo y ruido periddico con espectro blanco, rosa y hablado (PN
blanco, PN rosa, PN habla).

Nota 1: El PN (ruido periddico) es una sefial periddica similar a un ruido con un nivel de espectro controlado y

una fase aleatoria. El ruido periddico y el multitono pertenecen a la clase de sefiales multisinusoidales (que se
explicardn mas adelante).
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Nota 2: La sefial de prueba de fluctuacion es una sefial sinusoidal con una frecuencia igual a 1/4 de la frecuencia
de muestreo y con unos bits de BMS conmutados con una frecuencia igual a 1/192 de la frecuencia de muestreo.

Seccion Sine generator [generador sinusoidal]:
Frequency [Frecuencia] - introduzca la frecuencia de la sefial sinusoidal en Hz.
Peak Level [Nivel pico] — elija el nivel de salida con respecto al nivel de la escala completa (0dB a -90dB).
Dither Level [Nivel de ruido aleatorio] — Elija: Ninguno, 16 bit, 18 bit o 20 bit

La seccion Two sine generator [Generador de dos rafagas sinusoidales] permite elegir entre las tres
combinaciones posibles de frecuencias y de ratios de magnitud:

Defl - definir f1=11KHz, f2=12KHz, ratio de amplitud 1:1

Def2 - definir f1=100Hz, f2=8KHz, ratio de amplitud 1:4

User [Usuario] — introduzca dos frecuencias sinusoidales y el ratio de amplitud

La seccion Multisine generator [Generador multisinusoidal] se emplea para configurar los parametros del
multitono y del ruido periddico.

Output volume [Volumen de salida] — elija el nivel de salida en referencia con el nivel de la escala
completa (0dB a -20dB).

Pink cut-off [Corte rosa] — introduzca la frecuencia baja de corte en Hz, para el ruido rosa periddico.

Multitone [Multitono] — elija el tipo de sefial multitono (banda ancha, habla, ITU T O.81, década
inferior, década superior).

Ahora elija:
Spectrum mode generator type [Tipo de generador de espectros]: Sinusoide
Frequency [Frecuencia]: 1000Hz
Peak level [Nivel pico]: -3dB
Dither level [Nivel de ruido aleatorio]: 16 bit.

4. Usando la barra del dialogo, elegimos:

Gen [Sine v| FsiHe) [4s000 =] FFT[16384 v| wid[Kaker | Ava [None v | Reset|

Fs (Hz): 48000Hz (frecuencia de muestreo)

FFT: 16384 (numero se muestras en el cuadro de analisis de FFT)
Wnd: Kaiser (ventana de sefal para evitar pérdidas en el analisis de FFT)
Avg: Ninguno (compensacion de la sefal)

Los mismos parametros se pueden configurar en un cuadro de didlogo 'Spectrum Analysis Setup'
[Configuracion de analisis de espectros] que aparece en la Ilustracion 2.2. (se obtiene haciendo clic
sobre el elemento de ment Setup > Measurement [Configuracion > medicion]). Usando este cuadro
de dialogo se puede configurar (1) el canal de entrada preferido, (2) los parametros de compensacion y
(3) la resolucion FFT.

Spectrum Analysis Setup |

— Input channel —FFT rezolution
ILeft 'I FFT size |15384 *I
i o I K.aizer i I
—&veraging
Sampling rate IdEEIEIEI *I
Type IN:::ne vI

M ax averages |'| an

Drefault | Cancel | ak I

lustracion 2.2. Configuracion de analisis de espectros
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El cuadro de dialogo tiene los siguientes controles:

Seccién Input channel [Canal de entrada]
Elija: Canal izquierdo o derecho como canal activo de entrada de la tarjeta de sonido.
Seccién Averaging [Compensacion]:
Type [Tipo] Elija: Ninguno, lineal, exponencial o mantener pico
Max. Averages [Compensaciones maximas]: Introduzca el nimero maximo de compensaciones.

Seccion FFT resolution [Resolucion de FFT]:
FFT size [Tamafio FFT] - elija el namero de muestras del bloque FFT (4096, 8192, 16384, 32768, 65536 y

131072)
Window [Ventana]: Elija: Ventana uniforme, Hanning, Blackman3, Blackman4, Kaiser o de techo plano.
Sampling rate [Frecuencia de muestreo]: elija: 8000, 11025, 16000, 22050, 32000, 44100, 48000, 88200

096000 Hz.

5. Elija: Input channel [Canal de entrada]: Izquierdo.

6. Prepare la mezcladora de sonido de Windows:
e Active el canal de entrada de linea
e Enmudezca el canal de entrada de linea de la mezcladora de salida.
Ajuste el volumen de la linea de salida a la maxima sensibilidad de salida.
Ajuste el volumen de la linea de entrada cerca de la sensibilidad de entrada minima.

7. Con el comando de menu Setup > Spectrum Scaling [Configuracion > Escala de espectros]

( Peec ), 0 haciendo clic con el botdn derecho del ratén en la zona del nombre del gréafico, se abre el
cuadro de dialogo 'Spectrum Scaling' [Escala de espectros] (que se muestra en la ilustracion 2.3).
Use este cuadro de didlogo para configurar (1) la escala de magnitud, (2) la ponderacion de potencia y
(3) las medidas de distorsion.

x|
— Scaling — Power
* dBF5 ¢ dEv(SPL) ¢ PSD
B Wigighting INnne *I
Yollage units dB -
Freszure unitz Iu:IB re 20 uPa vI Show RMS Level ¥
— Diistortion
Default
V¥ THD Mormalize with full power [ _l
¥ THD+N Low cut-off (Hz] |20 Hresz |
[~ IMD 2nd and 3rd arder IMD [~ Cancel |
[ Multtane T2+ Frequency weighting [ ITI

llustracion 2.3. Escala de espectros

Seccion Scaling [Graduacion]:
Magnitude Scaling [Graduacion de magnitud]: dBFS (dB en la escala completa),
dBV o SPL (nivel de presion sonora),
PSD (modo de densidad espectral de potencia
en dB V/\Hz).
Voltaje units [Unidades de voltaje]: dBW o dBu.

19



ARTA User Manual

Pressure units [Unidades de presion]: dB re 20uPa o dB re 1Pa (valido sélo si se
conecta y activa un micréfono).

Seccion Power [Potencia]:
Power Weighting combo box [Ponderacion de potencia] — Elija: Sin filtro, filtro A, B o C para
estimacion de la potencia ponderada de la sefial.
Show RMS level [Mostrar nivel RMS] — active esta casilla para que se muestre el nivel de
potencia en la parte inferior del grafico.

Seccion Distortion [Distorsion]:
THD = distorsiones armonicas totales (en pruebas de respuesta sinusoidal)
THD+N = distorsiones armonicas totales + ruido (en pruebas de respuesta sinusoidal)
IMD = distorsiones de intermodulacion (en pruebas de respuesta de dos rafagas sinusoidales)
Multitone TD+N [Multitono TD + N] — active esta casilla para que se muestre la distorsion total
+ ruido (TD+N) en pruebas de respuesta de multitono.
Normalize with full power [Normalizar con plena potencia] — active esta casilla para obtener
una THD normalizada con potencia de sefial que incluya los armonicos superiores.
Low cut-off (Hz) combo box [Cuadro combinado de corte bajo (Hz)] — establece un corte bajo
de frecuencia en las mediciones de THD+N.
2nd and 3rd order IMD [IMD de 2°y 3er orden] — active esta casilla para mostrar la distorsion
de intermodulacion de 2° y 3er orden, tal como se define en las normativas SMPTE, DIN, CCIF y
1IEC.
Frequency weighting [Ponderacion de frecuencia] — active esta casilla para usar la ponderacion
de frecuencia (A,B,C) en las mediciones THD+N y TD+N.

8. Active las siguientes casillas: THD, THD+M y Mostrar nivel RMS.

9. Comience la grabacion haciendo clic sobre el icono de la barra de herramientas L (o a través del
menu Recorder > Run [Grabadora > Iniciar]. Obtendra una respuesta como la que aparece en la
ilustracion 2.4. Esta ilustracion se puede obtener con los comandos copiar/pegar (menu Edit > Copy
[Edicion > Copiar]).

Suba lentamente el volumen del canal de entrada de linea (con el mezclador de la tarjeta de
sonido) hasta que llegue a un nivel de pico cercano a -3dB FS.

Spectrum magnitude dBFS Left Avd
a0
-20.0
-30.0
-G0.0
-80.0
-100.0
-120.0 .
o N Ve ey
-140.0 ; "
100 1000 10000
Cursor; 999.0 Hz, -2.95 4B FrequencyiHz
RMS = -2.7 dBFS THD =0.0011 % THO+N =0.0050%

lustracion 2.4 Espectro de un generador sinusoidal de 1 kHz para la tarjeta de sonido Terratec EWX
24/96 en modo bucle. Ventana de sefial: Kaiser, tamano FFT: 16384, Fs: 48000Hz.

La parte inferior de la Ilustracion 2.4 muestra el valor del espectro en la posicion del cursor
(frecuencia y magnitud), el nivel de RMS y las distorsiones. El cursor aparece como una linea fina que
se puede mover pulsando el boton izquierdo del ratén o las teclas de desplazamiento izquierda y
derecha en el teclado.
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Si obtiene un THD+N menor del 0,1%, tiene una tarjeta de sonido que podra usar.
Si obtiene un THD+N menor del 0,01%p, tiene una tarjeta de sonido buena.

Nota:
Durante la medicion podra usar la barra de control para cambiar el tipo de compensacion, borrar la

compensacion, cambiar la frecuencia de muestreo, cambiar el tipo de sefial de excitacion y el tamafio
de FFT.

Podra cambiar cualquier parametro del grafico (rango dinamico, gama de frecuencias y eje) en el
cuadro de dialogo 'Spectrum graph setup’ [Configuracion del gréfico del espectro] (llegara a este
cuadro haciendo clic sobre el elemento de ment Setup > Graph setup [Configuracion >
Configuracion del gréafico] o haciendo clic sobre el boton derecho del raton en la zona del grafico).
La forma mas sencilla de ajustar los margenes del grafico es usando la barra de control derecha. Las
funciones de los botones de la barra se explican en la Ilustracion 2.5.

Changes graph top magnitude margin

Fit plotted curve to graph top magnitude margin

Changes graph magnitude range

Opens dialog box for the setup of graph margins

Changes graph high-frequency margin

2 Ed et | e

Changes graph low-frequency margin

llustracion 2.5 Barra de control para configurar los margenes del grafico (también se usan para las
ventanas de las respuestas en frecuencia)

Nota: Las teclas rapidas para cambiar el margen superior de la magnitud del grafico son las teclas
"Arriba" y "Abajo" y la rueda de desplazamiento del raton (el grafico se movera arriba y abajo).

2.2 Procedimiento de estimacidn de espectros

El espectro que aparece en la Ilustracion 2.4 se ha obtenido con el siguiente procedimiento:
1. Se envia una sefial de entrada de frecuencia f y se transforma en una secuencia discontinua X,
de longitud N=tamafio FFT (el nimero de muestras de la ventana de adquisicion sera igual a
'FFT size' [Tamafo FFT], y se podra elegir entre: 4096, 8192, 16384, 32768, 65536 o
131072).

2. Lasecuencia discontinua de entrada se multiplica por una secuencia de ventana W, (se explica
mas adelante).

3. La Transformada Discontinua de Fourier
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N-1
Xk — anxne—jZﬂkﬂ/N
=0

se calcula usando el algoritmo FFT. Este calculo nos da los componentes espectrales en la
forma de valores complejos en las frecuencias discontinuas.

fk=k Af,
donde Af es una resolucion espectral DFT
Af =1fs/N.
Para sefiales reales, hay N/2 componentes espectrales de potencia de una sola cara Gy:

G,= X,/N|* - dccomponent
G, =2|X,/N|, k=12.N/2-1

4. El espectro de magnitud se expresara en uno de los siguientes modos de graduacion:

Modo de graduacion Nivel Unidades
Nivel pico 10 log(2Gy) dBFS
(referencia a la escala

completa)

Nivel RMS 10 log( Gy x (sensibilidad_entrada / dBV
(espectro de potencia) | ganancia preamp)”) (0 dBu)
Densidad espectral de | 10 log( Gy x (sensibilidad_entrada / dBV/\Hz
potencia ganancia_preamp)” / Af) (o dBu/NHz)

Nota: Si se activa la casilla Use Microphone [Usar micréfono] del cuadro de dialogo ‘Audio
device setup' [Configuracion de dispositivos de audio], los niveles de RMS o PSD se
elevan en 20log;o( 2x10” Pa) x sensibilidad micréfono(mV/Pa) ).

5. El grafico del espectro muestra los niveles de las magnitudes espectrales como graficos de
lineas.

Nota: El espectro DFT se define como un conjunto discontinuo de frecuencias, de forma que seria
mas apropiado mostrar el espectro como un grafico de barras discontinuo. Sin embargo, cuando
tratamos con una cantidad grande de componentes espectrales, como es el caso en ARTA, el
grafico de lineas nos proporciona una mejor impresion visual de las magnitudes espectrales.

La parte inferior de la Ilustracion 2.4 muestra:

e RMS — Nivel RMS de una sefal de entrada — definida como 10 log;o (suma de todos los
componentes del espectro de potencia DFT) Si la ponderacion de potencia, en el cuadro de
didlogo 'Spectrum Scaling' [Graduacién de espectro], esta definida como filtro A, B o C, se
ponderara cada uno de los componentes espectrales, antes de realizar la suma de espectros,
con una respuesta de magnitud de los filtros A, B o C (consulte la definicion de estos filtros en
la seccion 2.4).

e THD - distorsion armonica total—se define como un porcentaje de la raiz cuadrada del ratio
de la suma de potencia de los armoénicos superiores (H, Hs,..) respecto de la potencia del
armoénico fundamental de la sefal (H1).

H +H] +.+H;
2

THD :100\/ (%)

1
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Se suele usar la siguiente definicion alternativa:

H;+H;+.+H;

H+H;+H;+.+H

THD =100 (%)

En el denominador se usa la potencia de la sefial distorsionada completa. Esta definicion se
encuentra mas cerca del valor de las distorsiones armonicas que se miden con
instrumentaciones analogicas en sistemas de ruido bajo. En un sistema con un ruido elevado,
una medicion de mayor calidad, equivalente a la instrumentacion analégica, es la de THD*N.

e THD+N - distorsion armodnica total mas ruido—se define como un porcentaje de la raiz
cuadrada del ratio de la suma de potencia de los armoénicos superiores y la potencia del ruido
(N) que también incluye distorsion y potencia de ruido.

THD + N =100 HarmonicPower + NoisePower (%)
TotalPower

Con la instrumentacion analogica, se obtiene Potencia Arménica + Potencia del Ruido
aplicando un filtro de muesca a la frecuencia fundamental. El valor RMS de la sefial y la sefial
con el armoénico fundamental en muesca se miden en algunas bandas de frecuencia
predefinidas, generalmente desde un corte de frecuencia bajo (10, 20 0 100 Hz) hasta un corte
de frecuencia alto (22, 30 u 80kHz). ARTA no usa la limitacion de alta frecuencia. Se realiza
de forma automatica con el filtro antisolapamiento de un conversor AD de entrada. El corte de
frecuencia bajo puede ser definido por el usuario.

Nota: Si no hay sefial en la entrada de la tarjeta, el RMS mostrara la relacion Sefial/ruido en el canal
de entrada.

2.2.1 Compensacion de espectros

La compensacion de espectros de potencia nos da una estimacion de las magnitudes espectrales de las
sefales que son mayores de una secuencia adquirida sencilla. ARTA ofrece la compensacion de
potencia con una ponderacion lineal y exponencial, y una compensacion de mantenimiento de pico.

Ejercicio: Elija una compensacion lineal, exponencial o de mantenimiento de pico, y compruebe
como se comportan de diferente manera.

Nota: La compensacion de potencia no reduce el nivel de ruido. Simplemente da un nivel de ruido
medio.

A continuacion se explica brevemente la ponderacion de compensacion de potencia. Para secuencias
de entrada M con componentes espectrales X', k=1,2, .. N/2-1, las magnitudes espectrales
compensadas Y, se obtienen de la siguiente forma:

e Linear averaging [Compensacion lineal] - las magnitudes espectrales compensadas Y, de

secuencias de entrada M se obtienen sumando los espectros de potencia de igual importancia
/M.

W =y

e Exponential averaging [Compensacion exponencial] — se suele emplear para hacer el
seguimiento de espectros con variacion lenta. Pone relevancia en los acontecimientos
recientes, suaviza las variaciones en las altas frecuencias y pone en evidencia las tendencias a
largo plazo. ARTA usa un filtro de suavizado que simula un filtro analdgico de primer orden y
paso bajo con una constante temporal T:
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VO =acv ! a-ay (X, [

La constante a sera igual a T fs/( T f; +1). En ARTA, T esta predefinido como 10 veces el
tiempo de adquisicion de una secuencia sencilla.

e Peak hold [Mantenimiento de pico] — realmente no se trata de compensacion, sino que
simplemente Y,™ son iguales a los valores maximos de los componentes espectrales,

V| = max(|X;

), i=12,.,M

Se pueden restringir la cantidad maxima de compensaciones en el cuadro de dialogo 'Spectrum
analysis setup’ [Configuracion del andlisis del espectro] que aparece en la Ilustracion 2.2 (llegara a
este cuadro haciendo clic sobre el elemento de menu Setup > Measurement [Configuracion >
Medicién]).

Nota: En la estimacion clasica del espectro de potencia es habitual compensar los registros que se
hayan solapado en el tiempo. Esto no se ha incluido en ARTA puesto que esta orientado a las
mediciones de respuestas de sistema con tipos de sefales predefinidos que sean periodicos en la
ventana de analisis.
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El anélisis de DFT nos da un espectro exacto solo si la sefial adquirida es periddica dentro de la
ventana de adquisicion. Sino es asi, se habra de aplicar una ventana de sefial para eliminar los errores
de "pérdidas" (es decir, al analizar el espectro de sefiales sinusoidales estos errores provocar un
espectro con un lobulo lateral - ver la Ilustracion 2.5a). La creacion de ventanas de sefal es una
operacion en la que la secuencia de entrada X, se multiplica por una secuencia de igual longitud w, que
se llama la ventana de sefial. ARTA ofrece las siguientes ventanas de sefial: Ventana uniforme, de
techo plano, Hanning, Blackman3, Blackman4 y Kaiser. Se definen en la Tabla 2.1.

Uniforme (rectangular) Wh=1,

paran=0,1,2,.., N-1

Hanning wy = 0.5 (1 — cos(Yn)),

Yn=2mn/N

Blackman 3 términos

Wy = 0.42 — 0.5cos(Yn) + 0.08cos(2y,);

Blackman 4 términos
(Blackman — Harris)

W, = 0.35875 - 0.48829¢05(Yn)

+0.14128cos(2y,) - 0.01168cos(3Yy);

Techo Plano Wy =(1-1.93cos(y,) + 1.29 cos(2y,)

- 0.388 cos(3yn) + 0.0322 cos(4yy) ) / 4.6402

2
[2n—N +1]
I I-|—
P
Kaiser wW. =

, Where 1,(x)= i

) 1,(8)

K Y’
N

Tabla 2.1 Definicion de las ventanas de sefial empleadas en ARTA

Para aplicar la ventana de sefial, se recomienda seguir estas normas:
e Para sefiales no periddicas continuas (ruido) use la ventana Hanning

e Para medir las distorsiones armonicas y de intermodulacidn use la ventana Kaiser o

Blackman4

e Para calibrar con una sefial sinusoidal, use la ventana de techo plano

e Para el ruido periddico, los multitonos y otras sefiales periodicas dentro de la ventana de

adquisicion, use la ventana Uniforme

Ejercicio: Cambie la ventana de sefial y repita las mediciones. Los resultados normales se muestran en

la Ilustracion 2.6.

Spectrum iLeft) Spectrum {Left) Spectrum (Lefty

\ ]

Spectrurm (Left Spectrum (Left Spectrum (Left

\ s e i
fla . B
I td 'y
1000 1000 1000
a) Uniforme b) Hanning ¢) Techo plano

1 .\\ AL Ly Ll nla

oA Nkl LA iabiveto u»ﬁtjrwv

1000 1000 1000

d) Blackman3 ¢) Blackman4 f) Kaiser

lustracion 2.6 Espectro de una
sefial sinusoidal de 1kHz con las
ventanas siguientes aplicadas:

a) Uniforme,

b) Hanning,

¢) Techo Plano,

d) Blackman3,

¢) Blackman4,

f) Kaiser

(Magnitudes mostradas de
20dB/div).
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2.2.3 Configuracion del grafico del espectro

El comando de menu Setup > Graph Setup [Configuracion > Configuracion de gréaficos] (o
haciendo clic con el botén derecho del raton en la zona del gréafico) abre el cuadro de dialogo
'‘Configuracion del grafico del espectro’ (Ilustracion 2.7). Use este cuadro de dialogo para ajustar (1)
el rango dinamico que se muestra, (2) la gama de frecuencias visible y (3) la resolucion del eje de
frecuencias.

Spectrum Graph Setup El

—Magritude asiz———— [~ Freq. range [Hz]—— — Frequency axi=

Top [dB] I':I High IEDUDEI Type Log -
Fange [dB] |140 L s |2EI Smu:u:uthinglh-? octave TI

Fit ta graph top | Wiew all | Filtered smoathing [
Crefault | |lpdate | Cancel I kK |

lHustracion 2.7 Cuadro de dialogo para la configuracion del grafico de espectro

Seccién Magnitude axis [Eje de magnitud]:
Top (dB) [Superior (dB)] - introduzca el nivel de dB del margen superior del grafico
Range (dB) [Rango (dB)] — introduzca el rango de magnitud del grafico

Seccién Freq. range (Hz) [Gama de frecuencias (Hz)]:
High [Alta] - introduce la frecuencia mas elevada que se muestra (en Hz)
Low [Baja] - introduce la frecuencia mas baja que se muestra (en Hz)
View All [Ver todo] - introduzca las frecuencias altas y bajas que permiten ver todos los componentes del
espectro de DFT.

Seccidn Frequency axis [Eje de frecuencia]:
Type [Tipo] — Hay cuatro tipos de resolucion del eje de frecuencia disponibles:

Linear [Lineal] — El espectro de DFT aparece en un eje de frecuencia lineal

Logarithmic [Logaritmico] — El espectro de DFT aparece en un eje de frecuencia logaritmico

Octave smoothing [Suavizado de octavas] - se muestran los niveles de potencia en bandas de octavas
suavizadas (en barrido)

Octave bands [Bandas de octavas] - se muestran los niveles de potencia en bandas de octavas
discontinuas (simulacion de RTA)

Smoothing [Suavizado] — Los modos de suavizado de octava y bandas de octavas son utiles para controlar
los espectros de las sefiales de banda ancha. La resolucion de frecuencia de estos modos se puede determinar
en 1/n de octava, en la que n puede ser: 1, 2, 3, 6,9, 12y 24.

Filtered smoothing [Suavizado filtrado] — Los filtros de suavizado de 1/n octavas tienen, por defecto,
caracteristicas de pared de ladrillos, pero si se activa la casilla "Filtered smoothing' [Suavizado filtrado]
los filtros tendran caracteristicas de los filtros IEC de clase I (filtros Butterworth de paso de banda de seis
polos).

2.2.4 Configuracion de los colores del grafico y del estilo de la cuadricula

Los colores del grafico se pueden cambiar dentro de dos categorias: Fondo y primer plano.

o Elusuario cambia el color del fondo de "Negro" a "Blanco" haciendo clic sobre el comando
del menu Edit > B/W background color [Ediciéon > Color del fondo B/N] o sobre el icono

de la barra de herramientas F .
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O Elusuario indica un color de primer plano arbitrario para cada elemento del grafico usando el
cuadro de dialogo 'Edit->Colors and grid style' [Edicion > Colores y estilo de cuadricula].
Asi se abre el cuadro de dialogo "Color Setup' [Configuracion del color sonido] que aparece
en la [lustracion 2.8. Haciendo clic con el boton izquierdo del raton sobre un rectangulo de
color se abre el cuadro de dialogo estandar de Windows 'Color' que se muestra en la
Tlustracion 2.9.

Nota 1: Si se activa la casilla de verificacion 'All overlays with same color’ [Todas las
superposiciones con el mismo color], todas las superposiciones se dibujaran con el mismo
color.

Nota 2: Si se activa la casilla de verificacion 'Dotted graph grid' [Cuadricula con linea de
puntos], la cuadricula del grafico se dibujara con lineas de puntos.

Color Setup 5'
Graph background I overlayl |
Graph border I Overlay2 |
Flot pen1 | Overlay3
Plot pen2 e overlays [
Plot pen3 — EIE L
) Overlays [
Grid color |
i overlay7 I
SubGrid color | Overlays N
Cursor color I overlays [
Marker color I Overlay1l0 [N
Target Overlay color I Overlayll [
Overlay1? [
Dotted grapharid [~ overlay13 |
—
All overlays with same color [~ Overlay14
Overlay1s [N
Default I Cancel | oK |
Color Setup il
Graph background [ Overlayl [N
Graph border I Overlay2 [N
Plot pen1 I Overlays I
Plot pen2 I Overlays NN
Plot pen3 I Overlays [
) Overlays I
Grid color |
. e overlay7 (I
SubGrid color Overlays NN
Cursor color I Overlays NN
Marker color | Overlay1o N
Target Overlay color I Overlay1l N
Overlayiz [
Dotted grapharid [ overlay1z [
[
Al overlays with same color [~ Overlay14
Overlay1s I
Default | Cancel I oK |

llustracion 2.8 Cuadros de didlogo para la configuracion de los colores del grafico a) del fondo en
negro y b) del fondo en blanco
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AR §
Al ed |
HMEEEEE N
e i 0 0 i ] B
T N

Custam colors:

| 8 H 8 § 0 § § |
{ 8 8 8 0 8 N § |

Define Cugtom Colars >3 "

s I Cancel |

llustracién 2.9 Selector de colores de Windows

Se utilizan los colores para dibujar las curvas de la siguiente forma:

El trazo 1 se usa para dibujar la respuesta de impulso limitada, el espectro y la magnitud de la
respuesta en frecuencia.

El trazo 2 se usa para dibujar la funcién de fase o coherencia,

El trazo 3 se usa para dibujar la respuesta de impulso no limitada.

El boton 'Default’ [Defecto] restaura los colores por defecto.

2.3 Resolucion de frecuencia de los analizadores de DFT y bandas de octavas

La resolucion de frecuencia se define como una diferencia minima de frecuencia necesaria para
diferenciar dos componentes espectrales. Depende de (1) la frecuencia de muestreo (fs), (2) el
‘Tamafo FFT’y (3) la ventana de sefal aplicada.

El anélisis de DFT de N muestras de entrada nos da N/2 componentes espectrales cuyo espectro de
potencia iguala la potencia de la sefial que se puede obtener con un filtro de paso de banda que tenga
un ancho de banda constante Af =f;/ N, en las frecuencias fy = kKAf, k=0,1,2,..N/2-1. El ancho de
banda también depende de la ventana de sefal aplicada. La tabla 2.2 muestra el ancho de banda de
ruido efectivo y la eliminacion del 16bulo lateral de las ventanas de sefial que se usan en el ARTA.

Ventana: Ancho de banda efectivo: | Eliminacion del 16bulo lateral:
UNIFORME 1.0 13 dB

HANNING 1.5 31,5dB

BLACKMAN3 1.7268 66 dB

BLACKMAN4 2.0044 94 dB

KAISER 2.2183 130 dB

TECHO PLANO | 3.7703 73,6 dB

Tabla 2.2 Caracteristicas de las ventanas de sefial ARTA

En los analizadores de bandas de octava el espectro de potencia se mide en una frecuencia fy en una
banda de frecuencia que tiene un ancho de banda relativo constante. En un filtro de 1/n octavas, el
ancho de banda relativo es igual a
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1 1
Ah _ (230 -2 )

Por ejemplo, el filtro de 1/3 octava tiene un ancho de banda que es el 23% de la frecuencia central.

En ARTA, las frecuencias centrales se determinan con la expresion:

1
f,=2"f_,, f,=2"f1,

con 1 kHz como valor de referencia. Esta féormula nos da unos valores cercanos a las frecuencias
estandar de la tabla 2.

En ARTA, la energia de la banda de octavas se estima afiadiendo las potencias espectrales de
depositos de DFT en una banda de octavas 1/n, pero solo si al menos hay tres componentes espectrales
DFT que contribuyen a dicha banda. Este requisito quiere decir que el ancho de banda de una banda de
1/n octava ha de ser mayor que el doble del ancho de banda de resolucion de DFT, lo que nos da que la
frecuencia mas baja de una banda de 1/n octava es:

£
fIowes’r 22— 1 1
(2 2n __ 2 2n )

Por ejemplo, para una frecuencia de muestreo fs = 48000Hz y un nimero de muestras N=16384, la
frecuencia menor de los espectros de DFT es igual a 2,93 Hz, la banda de 1/3 octava menor es 25 Hz 'y
la banda de 1/12 octava menor es 100Hz.

16.0 20.0 25.0
315 40.0 50.0
63.0 80.0 100
125 160 200
250 315 400
500 630 800
1000 | 1250 | 1600
2000 | 2500 | 3150
4000 | 5000 | 6300
8000 | 10000 | 12500
16000 | 20000 | 25000

Tabla 2.3. ISO 266 — Frecuencias centrales preferidas de bandas de 1/1 octava y 1/3 octava. (La
primera columna muestra las frecuencias de banda de 1/1 octava)

hand-pass
XJ'_|: f X

-20dB

1]'_‘_‘1
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lustracion 2.10 Suma de potencias espectrales en un paso de banda de
a) filtro de pared de ladrillos, b) filtro de paso de banda Butterworth de 6 polos.

En ARTA, se puede calcular power Py [Potencia Py] en la banda fy < f < fy, de dos formas:

1.

Potencia de salida de un filtro de paso de banda de pared de ladrillos — Primero, se asume
que cada componentes DFT consigue una densidad espectral de potencia constante G,/ Af en
la region de frecuencia NAf-Af/2 < f < nAf +Af /2 (de esta forma obtenemos una densidad
espectral continua a trozos). A continuacion, se obtiene la potencia de una banda como la
integral de la funcion de densidad espectral continua, de fix a fo Este proceso se muestra en la
Ilustracion 2.10a).

Potencia de salida de un filtro de paso de banda Butterworth de 6 polos - Primero, el espectro
de potencia se pondera con una magnitud cuadrada de la respuesta del filtro de paso de banda.
A continuacion, se calcula Py como la suma de los componentes espectrales de potencia entre
frecuencias en las que la respuesta del filtro es de -20dB. Este proceso se muestra en la
Ilustracion 2.10b).

El primero método es el que se prefiere en ARTA.

La densidad espectral de potencia de la banda kava es Py /( - fi).
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2.4 Nivel RMS

El nivel de la sefial RMS se muestra en la parte inferior izquierda del grafico, pero sélo si se ha
activado el boton 'Show RMS Level' [Mostrar el nivel RMS] en el cuadro de didlogo 'Spectrum
Scaling' [Graduacion de espectro] (Ilustracion 2.3). La unidad del nivel de RMS es dBFS o dBV, pero
si se usa el microfono, la unidad sera dB re 20uPa o dB re 1Pa.

El mismo cuadro de didlogo tiene una seccion 'Power — Weighting' [Potencia — ponderacién], en la que
el usuario elige aplicar, a la sefial de entrada, uno de los filtros de ponderacion estandar IEC 60651
(tipo A, B o C). De ser asi, la etiqueta del nivel aparece con la letra (A), (B), o (C). La respuesta en
frecuencia de estos filtros de ponderacion aparece en la Ilustracion 2.11.

|

B,

20 50 100 200 500 1k 2k 5k 10k
[ [Hz]
lustracion 2.11 Ponderacion de frecuencia A, By C (IEC 60651)

El valor RMS se define como:

ARTA usa una constante de integracion T igual a la duracién de un bloque FFT (los ejemplos se
muestran en la Tabla 2.4).

FFT - longitud 4096 8192 16384 32768 65636 131072
T (fs = 48000Hz) segundos 0.085 0.170 0.341 0.682 1.365 2.730
T (fs = 44.100Hz) 0.093 0.185 0.371 0.743 1.486 2972
segundos

llustracion 2.4 Duracion del bloque de FFT (para frecuencias de muestreo de 48000 Hz a 44100 Hz)
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2.5 Registro de tiempo
El registro de tiempo de la ltima sefial capturada se puede ver en una ventana "Time record’

[Registro de tiempo] (en la Tlustracion 2.12). Se puede activar haciendo clic sobre Recorder > Time
record [Grabadora > Registro de tiempo] o sobre el icono de la barra de herramientas L

=

Fil= Edit

Time record (%) RMS = 1.450 \/ , Crest: 2.0 dB Channel
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o
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Cursor: 1.856 W, 2521 ms (121) Gate:  1.952 m= (24

:

lustracion 2.12 Registro de tiempo de la tltima sefal capturada

La curva muestra la sefal correctamente graduada, el valor RMS y el factor de cresta (ratio de valor
pico y valor RMS). La linea amarilla indica la posicion del cursor, y la linea roja indica la posicion del
marcador.

Puede cambiar el marcador y la posicion del cursor pulsando y arrastrando los botones izquierdo y
derecho del raton.
Haga doble clic sobre el boton derecho del raton para activar o desactivar el marcador.

La etiqueta "Cursor:’ [Cursor:] indica el informe de la magnitud de la sefial en la posicion del cursor
(tiempo en ms o posicion de la muestra — con llaves). La etiqueta 'Gate:" [Limitacion] indica el
informe para la diferencia en tiempo (y muestras) entre el cursor y el marcador.

Los botones del cristal derecho sirven como comandos para desplazarse por la curva de la sefial, para
ampliar la imagen, para cambiar la ganancia y la compensacion vertical.

Comandos de zoom:
Up [Arriba] — aumenta la ampliacion
Down [Abajo] — reduce la ampliacion
All [Todos] — muestra todos los puntos
Max [Mé&x] — muestra los puntos entre el cursor y el marcador, pero si se desactiva el marcador, amplia
el grafico a un nimero de puntos de la pantalla.

Comandos de Gain [Ganancia]:
Up [Arriba]- incrementa el factor de ganancia
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Down [Abajo] — reduce el factor de ganancia
Min — establece el factor de ganancia minima
Max [Max] — establece el factor de ganancia maxima

Comandos de Offset [Compensacion]:
Up [Arriba] — aumenta la compensacion vertical
Down [Abajo] — reduce la compensacion vertical
Null [ninguna] — establece una compensacion vertical cero

Comandos de Scroll [Desplazamiento]:
Left [izquierda] — desplaza la curva hacia la izquierda.
Right [derecha] — desplaza la curva hacia la derecha

El cuadro combinado "Channel’ [Canal] muestra el canal que se esta empleando actualmente
(izquierdo o derecho).

Se pueden usar las siguientes teclas de acceso directo:

Teclas arriba y abajo - para cambiar la ganancia

Teclas Ctrl+arriba y Ctrl+abajo - para cambiar la compensacion vertical
Teclas izquierda y Ctrl+izquierda — para desplazar la curva hacia la izquierda.
Teclas derecha y Ctrl+derecha — para desplazar la curva hacia la derecha

Teclas Shift+izquierda y shift+derecha — para mover el cursor hacia la izquierda y la derecha

Tecla Repag y Avpag - para cambiar el factor de ampliacion

Arrastrando el raton a la zona de las etiquetas se desplaza la curva horizontal y verticalmente.

Haciendo doble clic sobre el boton izquierdo del botdn sobre la zona del eje de tiempo cambia la

etiqueta de posicidon tiempo/muestra.
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2.6 Control de los espectros de sefiales de banda ancha

En la configuracion de medicion en bucle, exploraremos las siguientes sefiales de excitacion aleatoria:

¢ Ruido blanco continuo - use la ventana Hamming y compensacion

¢ Ruido rosa continuo - use la ventana Hamming y compensacion

e Ruido periddico blanco (PN Blanco). - use la ventana Uniforme sin compensaciéon

e Ruido periddico rosa (PN rosa). - use la ventana Uniforme sin compensacion
¢ Ruido de habla periddico (esta sefial se usa solamente para la estimacion del indice de

transmision de habla — STI).

Nota: Los analizadores clasicos de sonido en tiempo real usan la excitacion del espectro rosa para un
analisis de la respuesta del altavoz en banda de octava o en octava suavizada. En un caso ideal
(después de la compensacion) la excitacion del espectro rosa da una respuesta plana en el modo de
Espectro de Potencia (dBFS o dBV RMS). Si usamos la excitacion del espectro blanco, el analisis en
banda de octava o en suavizado de octava nos da la respuesta plana en el modo PSD (modo de
densidad espectral de potencia).

Es importante estudiar las caracteristicas de las sefiales de espectro blanco y rosa, puesto que se usaran
para estimar la respuesta en frecuencia y la respuesta de impulso.

Ejercicio:

Primero, configure:

Generador: Ruido blanco

Graduacion PSD

Tamano FFT: 32768

Fs (Hz): 48000Hz

Ventana: Hanning

Eje de frecuencia: Suavizado de octava, 1/3 oct, 20Hz-20000Hz
Compensacion: Ninguno

Obtendra el espectro que aparece en la ilustracion 2.13.

Spectral density dBW sgri(HZ) (173 och Left Awvi

-30.0

-35.0

-40.0
_%.Djﬁ\ oy LT Pt R P

-&0.0
-55.0

-G0.0
-G5.0
-ro.a

100 1000 10000
Curzer;  20.15 Hz, -43.87 db FregquencyHz
RMS = -16 dBW

lustracion 2.13 Densidad espectral con suavizado de octava del generador de ruido blanco
(graduacion PSD)

Tenga en cuenta que la densidad espectral de una breve secuencia "blanca" no es plana. La ondulacion
es muy alta (£10 dB).

Si repetimos las mediciones con la modalidad de compensacién en Lineal, después de 20
compensaciones obtenemos el espectro que se muestra en la [lustracion 2.14. La ondulacion se reduce
a £1 dB. Usando 100 compensaciones, la ondulacion se puede reducir a £0,2dB.
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Spectral density dBMIsgri{HZ (173 octh Left Awvg:20
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lustracion 2.14 Densidad espectral con suavizado de octava del ruido blanco después de 20
compensaciones (graduacion PSD)
Ahora, si cambiamos a:

Generador: Ruido periodico blanco (PN Blanco).
Ventana: Uniforme

obtendremos el espectro que aparece en la ilustracion 2.15.

Spectral density dBW sgri{HZ) (173 och Left A
]
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Curzor:  20.15 Hz, -45.67 db Fregquency{Ho
RMS = -2.2dBY

lustracion 2.15 Densidad espectral con suavizado de octava del ruido blanco perioddico

Es obvio que la sefial de ruido periddico tiene una densidad espectral perfectamente plana sin
necesidad de compensacion ni de ventanas de senal.

Nota: El mismo resultado se puede obtener con una excitacion de ruido rosa (PN rosa) y una
graduacion a dBFS o dBV.
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2.7 Ruido Periodico

Un ruido periddico es una sefial que pertenece a la clase de sefiales multisinoidales de fase aleatoria
(RPMS). Es una sefial periddica de cero cc que contiene M componentes sinusoidales, cada uno con
una fase aleatoria:

M
g(t)= z A cos(2zkf t+¢,), ¢, =random e [0,27]

k=1

En ARTA, una sefial multisinusoidal de banda ancha se genera usando el DFT inverso:

, , k=0
donde A, ={ . @Oy =@, |aleatorio € [0,27[], Py =0

ARTA introduce tres tipos de ruido periodico:
1. PN Blanco — tiene A= const, y un espectro blanco

2. PN Rosa - tiene A, =\2A, y sus magnitudes espectrales se reducen 3dB/oct (después de
cierta frecuencia de corte — véase la Ilustracion 2.16). En ARTA, la frecuencia de corte de
baja frecuencia variable se puede cambiar en el cuadro de dialogo 'Signal Generator Setup'
[Configuracion del generador de sefiales] El ruido rosa se suele usar en las modalidades de
banda de octava o suavizado de 1/n octava con graduacion dBV (véase la Ilustracion 2.15),
puesto que proporciona una respuesta de frecuencia lineal en bandas con un ancho de banda
relativo constante.

3. PN Habla - tiene magnitudes espectrales determinadas por la norma IEC 60268-16 sobre
medicion del Indice de Transmision del Habla (véase la Ilustracion 2.18).

Las amplitudes de estas sefiales tienen una distribucion normal y un factor de cresta de 12-13dB. Si se
sigue procesando, el factor de cresta se puede reducir a valores inferiores a 6dB. En ARTA la
generacion de ruido perioddico se introduce con un factor de cresta inferior a 10dB.

Spectral density dBVIsgri(HZ Left Awvi:l
a

200
250
300 =
-35.0
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-45.0
-50.0 =
-55.0
-60.0
-B5.0

10 100 1000 10000
Cursar.  11.7 Hz, -22.93 dB Fregquencyi{Hz)
RMS = -2.8 dBW

lustracion 2.16 Densidad espectral con suavizado de octava del ruido periddico rosa (graduacion
PSD)
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0 Spectrum magnitude dBY {153 och Left Awg:
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lustracion 2.17 Densidad espectral con suavizado de octava del ruido periddico rosa (graduacion
dBV)

Spectrum magnitude dBY {113 ocf) Left Avg:l
o
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lustracion 2.18 Densidad espectral con suavizado de 1/3 octava del ruido periédico del "habla"
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2.8 Pruebas con sefales de dos rafagas sinusoidales

La excitacion con sefiales de dos rafagas sinusoidales se suele usar para medir las distorsiones de
intermodulacion. En el cuadro de dialogo "Signal generator setup' [Configuracion del generador de
sefales] el usuario podra elegir entre dos configuraciones de medicion predefinidas (11kHz y 12kHz,
con un ratio de magnitud 1:1, y 100Hz y 8kHz, con un ratio de magnitud 4:1) o configurar su propia
configuracion (dos frecuencias sinusoidales y un ratio de magnitud).

Para medir las distorsiones de intermodulacion, siga este procedimiento:
1. Tipo de generador: Dos rafagas sinusoidales

2. En el cuadro de dialogo 'Spectrum Scaling’ [Graduacion del espectro] active la casilla IMD.

— Digtartion
v THD Mormalize wath full power [
[v THD+M Low Fr. [Hz) |20
¥ IMD 2nd and Zd order IMD [
[ bultitore 7O+ Usze freq. weighting [
lHustracion 2.19

3. En el cuadro de dialogo ‘Signal generador setup’ [Configuracion del generador de sefial],
establezca dos frecuencias sinusoidales en la seccion de Usuario en 11.000 Hz y 12.000 Hz, y un ratio
de amplitud de 1:1, tal como se muestra en la I[lustracion 2.20.

— Two zine generator

Freqgl FreqZ kd agn

© Defl  [3kHz  [iakHz  [1:1
" Defz  [250Hz BkHz 14:1

& User 11000 f1zoo0 1 4

lustracién 2.20

4. Defina:
Graduacion del eje de frecuencia: Logaritmico
Compensacion: Lineal
Ventana: Kaiser
Spectrum magnitude dBFS Left Avd: 26
]
200
-40.0
-60.0
0.0
-100.0
1200 =y |
T A s Pttt
-1a0.4 100 1000 10000
Cursar. 224 Hz, -121.92 dB Fregquency(Hz)
RS = -5.5 dBFS IhADr =0.0012 %

lustracion 2.21 Distorsiones de intermodulacion de la tarjeta de sonido Terratec EWX 24/96 (medida
con dos rafagas sinusoidales: 11kHz y 12kHz)
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El ejemplo de la Ilustracion 2.21 muestra el espectro de intermodulacion para la excitacion de 11kHz
y 12 kHz. Observe el componente dominante de intermodulacion a 1 kHz (es la diferencia entre 11
kHz y 12 kHz).

2.8.1 Definicion de intermodulacion y distorsion

La distorsion de intermodulacion no lineal se caracteriza por la aparicion, en la salida del dispositivo,
de frecuencias que son combinaciones lineales de las frecuencias fundamentales y todos los arménicos
presentes en las sefales de entrada. Los componentes armonicos por si mismos no se suele considerar
que caractericen la distorsion de intermodulacion.

Para explicar como ARTA estima la distorsion de intermodulacion se usa la notacion I(nfl+mf2) para
expresar la magnitud del componente espectral de intermodulacion en la frecuencia nfl+mf2. El
espectro de la sefial de excitacion tiene dos componentes con magnitudes I(f1) e 1(f2). Es habitual
decir que nfl+ mf2 es un componente de distorsion del orden n+m.

Hay varios métodos para expresar el porcentaje de distorsion de intermodulacion:

» Método de potencia

» Métodos SMPTE (Asociacion de Ingenieros de Television y Cine) y normativa DIN 45043
* Método de la normativa IEC-60286

» Método de la normativa CCIF (ahora ITU_R)

Discutiremos brevemente estos métodos a continuacion.

Meétodo de potencia
La distorsion de intermodulacion se calcula como la raiz cuadrada de la relacion entre la suma de
potencia de los componentes de los productos de intermodulacion y la potencia de la sefial total.

2.1 (nfy £ mf)
IMD,,,,, =100 |———™0 : %
" PR+ (L) + 21 (nf, £mfy)

m,n=0

En ARTA, s6lo se usan los componentes mayores, para 1 <m,n < 8.
Metodo IEC 60268

Para las mediciones de altavoces, la normativa IEC 60268 — 5 define dos factores:
."/f)‘f): =100 ](fl +jl)+[(f2 _fl) %

Factor de distorsidn de modulacion de 1) 2° orden
Factor de distorsion de modulacion de vD. =100 2+ 2/)+ 1/, -21) ,, 3er orden
T 1(f,)

Estos factores muestran distorsiones de intermodulacion dominantes cuando f2 >> f1, es decir, para las
pruebas de altavoces usaremos f2 = 8.5 fl.

Para las mediciones de la distorsion del amplificador, cuando 2 = f1, la normativa IEC 60268 — 3
define dos factores:

2nd order Difference frequency distortion factor DFD2 = lOOM %
A +If)

3rd order Difference frequency distortion factor DFD3 =100 1@/, = /312~ o) %
I(f)+1(f2)

39



ARTA User Manual
Método DIN 45043 (SMPTE)

Este método asume que f2>> fi, generalmente fi= 250Hz, f2= 8.000Hz en DIN, o fi= 60Hz, f>=
7.000Hz en la normativa SMPTE. El ratio de amplitud es I(fi): I(f2) = 4:1.

El método de medicion de SMPTE esta determinado por la instrumentacion analdgica. Primero, la
sefial distorsionada de salida esta filtrada con un filtro de paso alto a 2.000 Hz para eliminar la
influencia del componente I(fi). Entonces, la sefial filtrada no tiene modulacion de amplitud en la
frecuencia f2, y est4 filtrada en el paso bajo a 700 Hz para obtener la potencia de los componentes de
modulacion a f2+ nfi. S6lo se usan unos pocos componentes. Finalmente, la distorsion IM se expresa
como la raiz cuadrada de la relacion entre la potencia de modulacion y la potencia de I(f2).

ARTA aplica la definicion de la normativa DIN que se denomina factor de intermodulacion total:

IMD,,, = 100\/2 he nf})zt;()fz Y

En esta expresion, las amplitudes de las bandas laterales se suman (en rms) y se expresan como
porcentaje del nivel de frecuencia superior. Este factor de intermodulacion esta muy cerca del valor de
la distorsion de intermodulacion que se puede medir con instrumentacion analdogica SMPTE.

Método CCIF (ITU-R)

La normativa CCIF para las mediciones de la distorsion de intermodulacion recomienda la excitacion
con dos componentes de frecuencia muy poco separados. Se recomienda usar fi= 13kHz, f2= 14kHz en
15kHz sistemas limitados, o fi= 19kHz, f2= 20kHz para pruebas del amplificador. El ratio de amplitud
recomendado es I(fi): I1(f2) = 1:1.

Los productos de intermodulacién dominantes se encuentran en frecuencias de diferencia. El DFD de
segundo orden se encuentra en la frecuencia f2 - fi,, los DFDs del tercer orden se encuentra en las
frecuencias 2f2- fi, 2fi - f2, y después los DFDs en las frecuencias 3f2 - 2fi, 3fi - 2f2, ... etc.

Muchos instrumentos analdgicos que forman la medicion de la normativa CCIF miden so6lo
distorsiones de frecuencia de diferencia de 2° orden DFD2, es decir

IMD ccir = DFD2 (en instrumentacién analdgica)

Algunos instrumentos CCIF miden también la distorsion de frecuencia de diferencia de 3er orden
DFD3.

Debido a la separacion de frecuencias cercanas, esta técnica se usa también en algunos analizadores de
frecuencia de barrido.

Los analizadores FFT modernos son capaces de medir todos los productos de distorsion. ARTA
genera informes DFD2 y DFD3 y de distorsion de intermodulacion total (IMD), calculados con el
método de potencia usando los veinte componentes de espectro de intermodulacion mas fuertes.

Cdémo calcula y genera informes ARTA sobre las distorsiones de intermodulacion
ARTA usa todos los métodos descritos para calcular la distorsion de intermodulacion. La eleccion del
método elegido se determina automaticamente a partir de la relacion entre las frecuencias f2y fi, de la

siguiente forma:

* Sif2/fi<2 ARTA usa el método CCIF y elabora el informe sobre la distorsion de frecuencia de
diferencia DFD2 y DFD3 mas IMD (definido con el método de potencia).
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* Sif2/ fi>7 ARTA usa el método DIN (SMPTE) y genera el informe sobre la distorsion de
modulacion: IMDomw, MD2 y MD3.

* Si2 <f2/fi<7 ARTA usa el método de Potencia y genera el informe IMD

La relacion de amplitudes, si difieren de las recomendaciones en las normativas, deberian ser incluidos
en un informe adicional para el usuario.

2.9 Pruebas de multitonos

Las pruebas de multitonos se han hecho muy importantes para probar la calidad de las sefales de
audio con codificacion digital. Los multitonos pertenecen a la clase de sefiales multisinusoidales. Son
una suma de varias sefiales sinusoidales con amplitudes y fases constantes que se optimizan para
obtener el factor de cresta mas pequefio.

En ARTA se introducen las siguientes sefiales de multitono:

. Rango de banda ancha Sefiales sinusoidales espaciadas 1/3 octava de 20Af a fs/2. Factor de
cresta 12 + 1dB

. Rango del habla Sefiales sinusoidales con espaciado lineal desde 100Hz a 500Hz, mas
sefales sinusoidales espaciadas 1/3 octava desde S00Hz a 8kHz. Las
fases estan optimizadas para un factor de cresta 10 = 1dB.

J ITU T 0O.81 39 sefiales sinusoidales con frecuencias espaciadas 100Hz (de 100 Hz
a 3800 Hz) Las fases se determinan segun la Recomendacion O.81 de
ITU_T. Factor de cresta 10 £ 1dB

o Rango de la década inferior Diez sefiales sinusoidales, espaciadas 1/3 octava en una
década inferior al rango de muestreo. Factor de cresta 10 + 2dB

. Rango de la década superior ~ Diez senales sinusoidales, espaciadas 1/3 octava en una
década superior al rango de muestreo. Factor de cresta 10 + 2dB

Todos los componentes multitonos se generan de forma que cada frecuencia sinusoidal coincide con
una frecuencia de depdsitos de DFT. Y por esto, a la hora de analizar la respuesta del multitono no se
necesita aplicar una ventana de sefial.

La Ilustracion 2.22 muestra el espectro del multitono del "habla" a través de un sistema GSM. Observe
un alto porcentaje de distorsiones.

Nota: El término TD+N (distorsion total + ruido) es bastante nuevo. Aun no esta aceptado en ninguna
norma. Significa: TD+N es el porcentaje de la raiz cuadrada de la relacion entre la potencia de
todos los depdsitos de ruido y la potencia del multitono.
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lustracion 2.22 Espectro del multitono del "habla" que pasa a través de dos teléfonos moviles de un
sistema GSM.

Nota: Las pruebas de distorsion con sefiales multitonos parece que son la tinica medida significativa
de las distorsiones en sistemas codificados.

2.10 Control de la dinamica de medicién

Durante las mediciones el usuario podra comprobar el rango dinamico de medicion en los cuadros
medidores de pico de la Barra de Estado que aparece en la Ilustracion 2.23.

Ready |[Li-2.8d6  |R:-3.4dE | Spectrum nalyzer 4

lustracion 2.23 Barra de estado de las pantallas ARTA

El texto de la izquierda muestra el contexto actual del ment.

El cuadro de texto de la derecha muestra la modalidad de medicion.

Cuadros de texto izquierdo y derecho: Muestran los niveles maximos a escala completa de los canales
de entrada izquierdo y derecho durante la medicion. Estos "medidores de pico" tienen un rango

dinamico de -100 a 0dB.

Si se sobrecargan los canales de entrada, los niveles de pico muestran el texto "OVRL".
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2.11 Superposicion de espectros

La superposicion es una curva que se muestra de forma permanente detras de la curva actual medida.
Durante o después de las mediciones, el usuario podra configurar la curva actual como superposicion
haciendo clic sobre el comando del menti Overlay > Set [Superposicion > Fijar] o pulsando las
teclas Ctrl + A. A modo de ejemplo, en la Ilustracion 2.24 se muestran dos curvas: La curva de
magnitud del espectro actual y una superposicion. En la modalidad de analisis de espectros so6lo se
permite hacer una superposicion.

[¥" untitled - Arta -10] x|
File Owerlay Edit View Recorder Generator Setup Mode Help
Ca|»” [Inp Frz Fri(Spa | ¢ @ [ @ (Ve & | =0 =) B2
Gen INn:-ne "I Fz[Hz) |4EEIEIEI "I FFT |15384 "I Wind |Hanning j Ay ILinear j Hesetl
Top
Spectrum magnitude dBF3 Left Avg:39 -
-20.0 0 -
R
o T Fit
A
500 e
Y
-20.0 j
-
-100.0
Set
-120.0 i
Vi W FrHigh
-140.0 | |
-1e0.0 100 1000 10000 Friow
Curgor: 20.5Hz, -119.82 dB Frequency(Hz) Jj
RKS = -100.9 dBFS{A)
Ready |L:-86.8d8 |R:-85.8dB | Spectrum Analyzer i

lustracion 2.24 Espectro después de 47 compensaciones (negro) y superposicion que mantiene los
valores del espectro después de 2 compensaciones.

La superposicion se puede almacenar en un disco (comando del menu Overlay > Save
[Superposicion > Guardar]) o cargar de un disco (comando del menu Overlay > Load
[Superposicion > Cargar]). Las superposiciones se almacenan en archivos de formato binario con la
extension —OVS.

La superposicion se elimina con el comando del ment Overlay > Delete [Superposicién > Borrar].

En la ventana de respuesta en frecuencia se usan las superposiciones casi de la misma forma, pero se
almacenan en archivos con extension .OVF.

Nota: Los valores se la curva de espectro actual se han de guardar en archivos de texto (comando del
menu File > Export ASCII [Archivo > Exportar ASCII]) El archivo almacenado contiene lineas
de texto con valores de frecuencia en Hz y magnitud en dB.
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3. Teoria de las mediciones de respuesta en
frecuencia

3.1 Relaciéon Entrada/Salida LTI

La medicion de la respuesta en frecuencia se basa en el analisis clasico de Fourier que establece que
cada senal de tiempo, con una energia finita, tiene su correspondiente transformada de Fourier. En un
analisis de sistema se asume que se excita un sistema lineal invariante en el tiempo (LTI) con una
sefal x(t) que como salida tiene la sefial y(t) Ambas sefiales X(t) y y(t) tienen sus correspondientes
transformadas de Fourier X(f) y Y(f).

x(£) A8 hytd)
X () - ¥

llustracién 3.1. Sistema LTI

La relacion entre la entrada y la salida de un sistema LTI, en el dominio de la frecuencia, se puede
expresar como:

Y(F)=X(H)H(F)
en la que la funcion completa H(f) se denomina una respuesta en frecuencia:

Y(f)

H(f)= X ()

— |H ( f )|ei(/7(f)
|[H(f)| se denomina una respuesta de magnitud, y ¢(f) una respuesta de fase. La respuesta en frecuencia
muestra como el sistema cambia el espectro de la magnitud y de la fase de una sefial de entrada.

La transformada de Fourier inversa de la respuesta de frecuencia se denomina respuesta de impulso.
Se escribe como h(t).

El producto X(f) H(f) tiene una pareja Fourier en el dominio temporal definida por la circunvolucion
X()®h(t). Esta circunvolucion es igual a la senal de salida y(t):

y(t) = x(H) @ h(t) = Th(r)x(t ~7)dr

La funcion h(t) se llama la respuesta de impulso del sistema, puesto que es una respuesta del sistema a
una excitacion de la funcion-6 de un impulso. Esto es obvio, puesto que analizando la circunvolucion
AH®h(t), se obtiene:

h(t) = Th(r)é‘(t —-7)dr

La respuesta en frecuencia del sistema se suele calcular usando el espectro cruzado de entrada-salida y
el espectro automatico de entrada. Al volver a escribir la expresion de la funcion de transferencia de la
siguiente forma:
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_Y(F) _Y(H)X(f) _Sy(f)
X(f)  X(H)X'(f)  S,(f)

H(f)

obtenemos la respuesta de frecuencia dividiendo el espectro cruzado de entrada-salida con el espectro
automatico de entrada (el asterisco indica un valor conjugado complejo) Esta ecuacidn se suele
denominar el estimador H.

Los pares de transformadas de Fourier del espectro cruzado S(f) y del espectro automatico de entrada
Sx(f) son la correlacion cruzada Ryy(t) y la correlacion automatica (Ru(t)), es decir.

R,() < S, (f)  "correlacién cruzada"

R,(t) < S, (f)  "correlacion automatica"

Si la entrada del sistema tiene un espectro blanco ( Sy(f)=1), entonces R (t)=0(t), la respuesta de
impulso es igual a la correlacion cruzada de entrada-salida;

h(t) ~R,,(t), silaentrada tiene un espectro blanco

Es importante usar el estimador H1 para la estimacion de la respuesta de frecuencia (e impulso) ya que
se demostrara que este estimador ofrece unas buenas propiedades a la hora de reducir la influencia del
ruido y las distorsiones.

La teoria anterior serd valida sélo para entornos sin ruidos y para sefales de excitacion con duracion
infinita. En la practica siempre tenemos algun ruido presente y so6lo se pueden analizar sefiales de
duracion finita.

La Ilustracion 3.2 muestra el sistema de medicion tipico en las mediciones acusticas. La sefial
generada por el ordenador g, después del filtrado D/A con una funcién de transferencia D, se aplica al
sistema de prueba que tiene una funcion de transferencia H. Tenga en cuenta que H representa el
mejor ajuste lineal de una funcion de transferencia no lineal posible. Se obvia el ruido del generador.
La salida del dispositivo de prueba, junto con un ruido de sistema afiadido n, es adquirido por el
ordenador como una secuencia de sefial discreta y. El proceso de adquisicion implica usar un filtro
antisolapamiento que tenga una funcion de transferencia A.

Moise

/A filter " A/D filter
g D H A v

DT

A X

lustracion 3.2 Diagrama de bloques para el sistema de medicion

Nota: En las mediciones acusticas obviamos la influencia del ruido del generador y el ruido del canal
de entrada X, puesto que son mucho menores que el ruido y las distorsiones en el canal de salida y.

En un sistema de canal doble la entrada al dispositivo de prueba es adquirida por el ordenador como
secuencia discreta X. En un sistema de canal sencillo no se mide la sefial en la entrada del sistema, y se
considera la sefial conocida g como excitacion del sistema.

En las siguientes secciones trataremos los sistemas de medicion de canal doble y canal sencillo.

3.2 Sistema de canal doble con excitacién de ruido continuo

En un analizador de Fourier clasico la excitacion es un ruido aleatorio y la respuesta en frecuencia se
estima dividiendo el espectro cruzado compensado X Y entre el espectro automatico compensado X X
de la N secuencias discretas de entrada y salida X; y Yes. Definimos el estimador H; como:
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SV, (1% (F)
H,(0)=- = <Sxy(f)> (H, estimator)
X, (1% (1) (S0

1

Donde H(f) denota la respuesta en frecuencia estimada. Los corchetes <> denotan el valor
compensador. El estimador H; proporciona una prevision polarizada de la funcion de transferencia real
H(f), que depende del ruido, las distorsiones y el retardo entre el canal de entrada y salida.

Cuando so6lo el ruido aporta a la polarizacion, el efecto de la compensacion se puede expresar con la
ecuacion.

1 (N(F)'(F)) o)
Y (G(F)6'(f)) [p(f)f

Observe que el término sefial se afade de forma coherente, mientras que la parte aleatoria del ruido no
se suma la potencia.

La conclusion es que las compensaciones reducen el nivel de ruido proporcionalmente a una raiz
cuadrada del niimero de compensaciones, mejorando asi la medicion S/N por 10log(n). Si existen
distorsiones no lineales, entonces parte del ruido del sistema es coherente con una sefial generada, y
una mejor medida de la proporcionalidad del ruido+distorsion y un numero de compensaciones es 1 /y
\/n, donde y es la funcidén de coherencia entrada-salida, definida como;

. I{Sy(D)F
(S (F))-(S,,(1))

La funcion de coherencia es una medida de la proporcion de la potencia en y que se debe a las
operaciones lineales de la sefial X. Al estimar la funcion de transferencia, la funcién de coherencia es
una comprobacion ttil de la calidad de los datos empleados. El valor de coherencia maximo es 1. En
ARTA se puede ver la coherencia, asi que serd posible comprobar la coherencia asociada con las
mediciones de "canal doble". En la practica, necesitamos que y* esté cerca de 1 para garantizar una
buena estimacion, pero hemos de tener en cuenta que la coherencia tiene sentido so6lo si el nimero de
compensaciones es mayor de 1.

uncorrelated
signal
| input excitation - continuous noise l,"]lr \|\3¢ |
I systam output :fi-_'_\ililr::-'_'_} |
FFT block FETblack | FFTbiock | FFT black !

delay
lHustracion 3.3 Tlustracion de estimacion sin correlacion en un analizador de Fourier clasico
Los principales problemas en el analizador de Fourier clasico con la excitacion de ruido continuo son:
e La sefal de excitacion no tiene un espectro constante. Esto genera una polarizacion del ruido
selectivo de frecuencia. Es elevado en las frecuencias en las que el espectro del generador
tiene muescas. Esta polarizacion de la resolucion se puede reducir enormemente

incrementando el nimero de ciclos de compensaciones. Se recomienda hacer al menos 8§
compensaciones de espectro y controlar la funcidén de coherencia.
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En un sistema con un retardo grande entre la entrada y la salida (véase la Ilustracion 3.2), es
decir, al medir la respuesta del altavoz en la sala, o la respuesta de sistemas de comunicacion
con un retardo grande, habra una correlacion baja entre las sefiales de entrada y salida
medidas. En ARTA es posible retardar la adquisicion del canal de entrada, de forma que se
elimina este tipo de error. Pero, si medimos la respuesta de frecuencia en un entorno altamente
reverberante, no sera posible compensar todos los retardos posibles.

Ambos problemas se pueden eliminar usando la excitacion de ruido periodico.

3.3 Sistema de canal doble con excitacion de ruido periddico

Si la excitacion se realiza con N secuencias diferentes de ruido periddico, el estimador de la respuesta
de frecuencia puede tener también la forma:

H,(f)=

- Yi(F)X/(F)
2, 1)

1
NG X ()X (F)

Este tipo de compensacion se denomina la compensacion asincrona en el dominio de la frecuencia.
Tedricamente tiene la misma potencia de reduccion de ruido y distorsiones que el estimador H;, pero
se prefiere usar el estimador H; puesto que nos permite controlar la funcién de coherencia. En ARTA
nos referimos a ambos métodos como la compensacion en el dominio de la frecuencia.

preavaraging | pﬁusel preaveraging |

input signal
I 1 | 1 I 1 I | 2 | 2 | 2 | PM noize
FFT block FFT block N
outpu
deiey l:l signal

lustracion 3.4 Tlustracion de la generacion y adquisicion de sefial durante la compensacion

asincronica en el dominio de la frecuencia.

Para su aplicacion correcta, se han de cumplir dos condiciones:

El inicio de la adquisicion ha de ser posterior al ciclo de pre-compensacion que es necesario
para alcanzar la respuesta en estado estacionario.

Después de cada bloque adquirido, se ha de detener la generacion de sefial, y se ha de generar
la nueva secuencia de ruido periddico.

La longitud del bloque FFT ha de ser igual a la longitud de la secuencia generada de ruido
periodico.  Esto garantiza que las sefales generadas y adquiridas estan siempre
correlacionadas, asi que no habra polarizacion debida al retardo entrada/salida.

Este método de excitacion — con el ruido periddico interrumpido — es la mejor forma de realizar
mediciones de la respuesta de frecuencia en sistemas de comunicacion que se activan con la voz y que
tienen un procesado de sefial que varia con el tiempo (control de ganancia y reduccion de ruido
automatico). El ruido interrumpido mantiene el canal de comunicacion en estado "activo", mientras
que se hacen las mediciones en un intervalo pequefio de tiempo para garantizar la estacionalidad del

sistema.

Si la excitacion se realiza con una secuencia periddica tUinica, N veces repetidas (véase la Ilustracion
3.5), el estimador puede tener también la forma:

47



ARTA User Manual

YO=30 50=3x0) He<w>=;“—f)

Este tipo de compensacion se denomina la compensacion sincrdnica en el dominio temporal. Este
estimador reduce el ruido aleatorio del sistema, pero no puede reducir las distorsiones no lineales y el
ruido estacionario que es periddico dentro del periodo de excitacion.

praavaraging | measurameant
input signal
I | | I | [ | PN noise
FFT block FFT block FFT black FFT block
output
| I I I | signal

delay

lustracion 3.5 Tlustracion de la generacion y adquisicion de sefial durante el proceso de
compensacion sincronica en el dominio temporal.

La calidad de la estimacion de la respuesta de frecuencia depende del ruido, tal como se indica a
continuacion:

1. Lainfluencia del ruido es elevada en frecuencias cercanas a fy/2, en las que echamos de menos
la energia que excitacion, que se filtra con un filtro de suavizado D/A. El problema se
soluciona en ARTA con el filtrado digital de la respuesta de impulso estimada en la frecuencia
inferior a la frecuencia de corte del filtro antisolapamiento del convertidor.

2. La influencia del ruido es también alta en frecuencias extremadamente bajas, puesto que el
sistema esta acoplado en CA. Esto implica que se han de usar tarjetas de sonido con una
frecuencia de corte muy baja.

En las mediciones acusticas, el periodo del multisinusoide ha de ser mayor al tiempo de reverberacion
- Teo. El siguiente razonamiento demuestra este requisito. La respuesta actstica de la sala tiene el
ancho de banda de picos de resonancia igual a 2.2/T¢. Si escogemos que la diferencia de frecuencia
entre dos componentes multisinusoidales sea inferior a la mitad de este valor, para permitir que se
aumenten todas las resonancias de la sala, podremos llegar a la conclusion de que el periodo del ruido
periodico haya de ser igual o mayor al tiempo de reverberacion. Ademas, también se concluye que la
longitud del ciclo de pre-compensacion ha de ser mayor o igual al tiempo de reverberacion.
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3.4 Sistema de canal sencillo para estimaciones de respuesta en frecuencia

En un sistema de canal sencillo solo se registra la sefial de salida del dispositivo a prueba. La sefial de
excitacion no se mide en la entrada del dispositivo sino que se asume que es la sefial conocida g que se
genera en la memoria del ordenador. El diagrama del sistema de medicion se muestra en la [lustracion
3.6.

noise

DA filter ASD filter

:
L H {(+) 4 ¥

g

D.UT

llustracion 3.6 Diagrama del sistema de medicion de canal sencillo (D — conversor digital a
analogico, A - conversor de analdgico a digital, g - sefial discreta generada)

La respuesta en frecuencia estimada He es la relacion entre el espectro cruzado YG* y el espectro
automatico GG*:

)= S (ap(r)» ALNUE (D

En el mejor de los casos, es decir, cuando no hay ruido, obtenemos:

H.(f)=H(f)A(f)D(f)

Vemos que la respuesta en frecuencia estimada esta siempre polarizada con funciones de transferencia
de los conversores A/D y D/A. No es nada malo, como se podria pensar en un principio, puesto que de
esta forma obtenemos una buena relacion Sefial/Ruido en frecuencias extremadamente bajas y altas
(los conversores A/D y D/A eliminan los espectros en las bajas frecuencias y cerca de fs/2). Esto es
especialmente importante si usamos tarjetas de sonido baratas que pueden tener una frecuencia de
corte inferior alta.

Tedricamente, la técnica de compensaciones de un sistema de canal doble se puede aplicar a un
sistema de canal sencillo, pero debido a las limitaciones del controlador de sonido de Windows, que
no mantiene la sincronicidad entre la reproduccion y grabacion de la sefial, sélo se puede aplicar la
compensacion sincronica en el dominio temporal. La respuesta de fase no se puede estimar con
precision absoluta.

Para finalizar:
El sistema de canal sencillo se recomienda como sistema de medicion cuando usamos tarjetas de
sonido de baja calidad. Es apropiado para medir la magnitud de la respuesta de frecuencia, pero no
proporciona una respuesta de fase absoluta y precisa.
Si deseamos usar el canal del micréfono para la tarjeta de sonido, sélo podremos aplicar un

sistema de canal sencillo, puesto que la entrada del micréfono de todas las tarjetas de sonido es
monofonica.
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4 Medicion de respuesta en frecuencia a tiempo real

4.1 Interfaz del usuario para la medicién en tiempo real de la respuesta en
frecuencia

La medicion en tiempo real de la respuesta en frecuencia se puede controlar desde dos ventanas:

Fr» Ventana de respuesta en frecuencia de canal doble
Fr; Ventana de respuesta en frecuencia de canal sencillo

Ambas ventanas tiene la misma forma de la interfaz de usuario, con las siguientes diferencias
funcionales.

1. En una modalidad de canal sencilla la sefial de excitacion tiene que ser el ruido periddico,
mientras que en la modalidad de canal doble la sefial de excitacion también puede ser el ruido
continuo.

2. En el modo de canal sencillo s6lo se muestra la magnitud de la respuesta de frecuencia,
mientras que en la modalidad de canal doble se puede mostrar también la respuesta de fase y
la funcién de coherencia.

Las mediciones se controlan con comandos de menti, didlogos, iconos en barras de herramientas
(Ilustracién 4.1) y una barra de control (Ilustracion 4.2).

Copy 1o Measuremeant Start Start Spectrum Auidic Ganeralor
clipboard modes recarding generator scaling devices setup

' ! T

i 7 Ime|Frz FRi Sea | 0 @ | @ (7 N | =0 sm

1 1 rtr 1

Background Stop Stop Measurament FR WView lime
color B recording generator setup  compensation record

llustracion 4.1 Ventana de la respuesta en frecuencia — iconos de la barra de herramientas

Gen [Firk noise ¥ FsiHz) [48000 v FFT [16384 =] Delayims)[0.000 fwg [Nore  v| | Reset|

llustracion 4.2 Ventana de la respuesta en frecuencia — barra de control

La barra de control tiene los siguientes controles:

Gen - elija el tipo de senal de generador

Fs (Hz) - elija la frecuencia de muestreo

FFT - elija el nimero de muestras de un bloque FFT

Delay (ms) [Retardo] - introduzca el retardo en el sistema medido (usado s6lo en una modalidad de canal
doble)

Avg - elija el tipo de compensacion (Ninguna, lineal, exponencial)

Reset [Borrar] - borra las compensaciones

Para hacer una medicién en tiempo real de la respuesta en frecuencia, seran necesarios los siguientes
pasos:
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1. Introduzca la ventana de respuesta en frecuencia de canal sencillo o doble, y conecte el sistema de
medicion tal como se indica en el capitulo 1.

2. Active el cuadro de dialogo ‘Audio device setup’ [Configuracion del dispositivo de audio]
haciendo clic en el menti Setup > Audio devices [Configuracion > Dispositivos de audio] o
haciendo clic sobre el icono de la barra de herramientas =¥ . Use este cuadro de dialogo para
configurar los parametros de entrada y salida de la tarjeta de sonido, la ganancia de la sonda de voltaje,
la ganancia del amplificador de potencia (s6lo para la modalidad de 1 canal) y la sensibilidad del
microfono (si usa el microfono).

3. Active el cuadro de dialogo ‘Signal generador setup’ [Configuracion del generador de sefial]
haciendo clic en el ment Generator > Configure [Generador > Configurar] o haciendo clic sobre el
icono de la barra de herramientas . Use este cuadro de dialogo para elegir el tipo de sefial de
excitacion (ruido blanco, ruido rosa, PN blanco, PN rosa). En la modalidad de canal simple, solo se
permite la excitacion con ruido periddico (PN blanco o PN rosa). Si usa la excitacion de PN rosa,
establezca la frecuencia de corte inferior. Ademas, determine el volumen de salida de la tarjeta de
sonido. Nota: La eleccion del tipo de generador se suele hacer usando la barra de control.

4. Active el cuadro de dialogo ‘Frequency Response Measurement setup’ [Configuracion de
medicion de la respuesta en frecuencia] haciendo clic en el ment Setup > Measurement

[Configuracion > Medicién] o haciendo clic sobre el icono de la barra de herramientas B Este
cuadro de dialogo se muestra en la [lustracion 4.3.

Frequency Response Measurement Setup El

—FFT resalution — Meazurement canfig

FFT size 4096 i Frefered input channel ILE:ft "I
Wfirndow Irifarm hd Fropagation delay [ms] IU

Sampling rate |1EE|I:|IZI TI Ireeert Phase of input channel [
— Averaging — Multizine averaging

Tupe INDHE vI Generate preaveraging cycle W

haw averages I'I Q0o Frequency domain averaging

— Twio channel mode
" Magnitude " Magnitude+Phase * Magnitude+Coherence

Drefault Cancel | | aF. I

lHustracion 4.3 Cuadro de dialogo para a configuracion de la medicion de la respuesta en frecuencia

El cuadro de didlogo para la configuracion de la medicion se usa de la siguiente forma:

Seccion FFT resolution [Resolucion FFT]:

FFT size [Tamafio FFT] - elija el nimero de muestras de un bloque FFT

Sampling Rate [Frecuencia de muestreo] — elija la frecuencia de muestreo en Hz,

Window [Ventana] — elija la ventana de sefial (usado so6lo con el ruido continuo o una excitacion
externa)
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Seccidon Averaging [Compensacion]:
Type [Tipo] - elija el tipo de compensacion (Ninguna, lineal, exponencial)
Max averages [Maximo de compensaciones] — introduzca el nimero maximo de compensaciones,

Seccién Measurement config [Configuracion de la medicion]:

Preferred input channel [Canal de entrada preferido] — elija el canal de entrada de la tarjeta de
sonido que se emplea para medir la salida de un dispositivo a prueba,

Propagation delay [Retardo de propagacion] — introduzca el retardo en el sistema medido (no usado
en la modalidad de canal sencillo),

Invert Phase of input channel [Invertir la fase del canal de entrada] — active esta casilla para
cambiar la polaridad de la sefial de entrada.

Seccién Multisine averaging [Compensacion de multisinusoidales]
Preaveraging [Pre-compensacion] — active esta casilla para activar el ciclo de pre-compensacion
(generalmente esta casilla de verificacion deberia estar siempre activada),
Frequency domain averaging [Compensacion en el dominio de frecuencia] — active esta casilla para
usar la compensacion en el dominio de la frecuencia (no se usa en la modalidad de 1 canal)
Two Channel mode [Modalidad de canal doble] - elija la configuracion del grafico para modalidad
de canal doble (Magnitud, Magnitud + Fase y Magnitud + Coherencia). En la modalidad de canal
sencillo, sdlo se representa la respuesta de magnitud.

5. Active el cuadro de didlogo ‘Frequency response graph setup’ [Configuracién del grafico de la
respuesta en frecuencia] haciendo clic en el menu Setup > Graph setup [Configuracion >
Configuracion del gréafico] o haciendo clic con el raton en la zona del grafico. Este cuadro de dialogo
se muestra en la Ilustracion 4,4. Use este cuadro de didlogo para ajustar (1) el rango dindmico que se
muestra, (2) el rango de frecuencias que se muestra y (3) la resolucion del eje de frecuencia.

Frequency Response Graph Setup El

— Dynamic range [dB]——— — Freq. ranage [Hz] Frequency aris

Graph top I'm':' High IEI:”:":":I Tvpe IL':'Q j
Graph range [100 Low |20 Smoathing [1/3 octave  ~ |

Fit to graph top | Yiew all |
Fressure unitz Iu:IB re 20uPa AW j
Drefauilt | |lpdate | Cancel I ()% |

lustracion 4.4 Configuracion del grafico de la respuesta en frecuencia

Los controles de este cuadro de didlogo son:

Seccién Dynamic range [Rango dinamico]:

Graph top (dB) [Parte superior del grafico] — introduzca el nivel en dB para el margen superior del
grafico

Graph range (dB) [Rango del gréfico] — introduzca el rango de magnitud del grafico

Fit graph top [Ajustar la parte superior del grafico] - Con este boton se ajusta el valor superior (dB)
de la magnitud maxima del grafico actual.

Seccion Freg. Range (Hz) [Rango de frecuencias]:
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High [Alta] — introduzca la frecuencia mas alta que se muestra (en Hz)

Low [Baja] — introduzca la frecuencia mas baja que se muestra (en Hz)

View All [Ver todas] — con este boton se ajustan la frecuencia alta y baja para que se puedan ver todos
los componentes del espectro DFT.

Seccion Frequency axis [Eje de frecuencias]:
Type [Tipo] — Hay cuatro tipos de la resolucion del eje de frecuencias disponibles:
Linear [Lineal] — eje de frecuencias lineal.
Logarithmic [Logaritimico] — Eje de frecuencias logaritmico.
Octave smoothing [Suavizado de octavas] — Bandas de octavas con barrido logaritmico
Octave bands [Bandas de octava] — bandas de octava discontinuas
Smoothing [Suavizado] — Ajuste la resolucion de suavizado a 1/n octava, en la que n puede ser: 1, 2, 3,
6,9, 12y 24.
El filtro de suavizado tiene las caracteristicas del filtro IEC de la Clase I (filtro Butterworth de paso de
banda de seis polos).

6. Finalmente, podra iniciar la medicion haciendo clic sobre el comando de menu Recorder > Run
[Grabadora > Iniciar] o haciendo clic sobre el icono de la barra de herramientas L

Durante las mediciones podra usar la barra de control para cambiar el tipo de compensacion, borrar la
compensacion, cambiar la frecuencia de muestreo, y cambiar el tipo de sefial de excitacion y el tamafio
de FFT. También podra cambiar cualquier parametro del grafico (rango dinamico, rango de
frecuencias y eje) activando el cuadro de didlogo ‘Graph setup’ [Configuracion del gréfico] (haga
clic sobre el ment Setup > Graph setup [Configuracion > Configuracion del grafico] o haciendo
clic con el boton derecho del raton en la zona del grafico).

Las teclas de acceso directo para cambiar el margen superior de la magnitud del grafico son las teclas
Arriba y Abajo del teclado y la rueda de desplazamiento del raton. Con estas teclas se mueve el grafico
hacia arriba y hacia abajo.

7. Podré detener las mediciones en cualquier momento haciendo clic sobre Grabadora > Fin o sobre
el icono de la barra de herramientas ™ iError! Nombre de archivo no especificado.. La duracion de la
medicion depende del tipo de compensacion. Si no se usa compensacion, las mediciones se repiten
hasta que el usuario detiene la grabacion. Si se usa compensacion, la medicion se detiene cuando se
alcanza el nimero méaximo de ciclos de compensacion o cuando el usuario detiene la grabacion.

4.2 Rango dinamico en las mediciones de la respuesta en frecuencia

Con el siguiente ejemplo, se mostrara como comprobar el rango dindmico disponible mientras que se
mide la respuesta en frecuencia en los modos Fr; v Fro.

Comience en la modalidad Fg;. Conecte la tarjeta de sonido en modo bucle (canal izquierdo y derecho)
y ajuste los siguientes datos:

Tipo de generador: PN Rosa

Nivel del generador: 0 dB

FFT: 32768

Compensacion: Ninguno

Comience la grabacion del canal izquierdo. Obtendra la figura de la respuesta en frecuencia en bucle
que aparece en la [lustracion 4.5.
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llustracion 4.5 Respuesta en frecuencia de Terratec EWX 24/96 en modo bucle

Ahora desconecte el canal de entrada izquierdo y mida la respuesta. Lo que mide ahora es un suelo de
ruido del canal de entrada. Haga una medicion sin la compensacion y guarde la curva medida como
superposicion (comando de menu File > Set as overlay [Archivo > Establecer superposicion]). A
continuacion repita la medicion con una compensacion = 100.

En ambos casos, configure el eje de Frecuencia en la ‘Frequency Response Graph Setup’
[Configuracion del grafico de respuesta de frecuencia] a ‘Octave-smoothed’ [Suavizado de
octava] con una resolucion ‘1/3 octave' [1/3 octava].

Obtendra la curva del suelo de ruido que aparece en la Ilustracion 4.6. Observe que el nivel absoluto
del suelo de ruido nos da realmente el maximo rango dinamico que se puede obtener con una tarjeta de
sonido.

Lo que vemos es que la compensacion reduce un suelo de ruido y aumenta un rango dindmico, pero no
de igual forma en todas las frecuencias.

. FR Magnitude dB ViV (1/3 oct) Left Awg:100
A
R
-18.0
T
-30.0 A
-45.0
-80.0
-T8.0
_,---'—'_'_'_‘-H_F
800 —, e St
. ——r] T _——
“\-\\ o TR e N e il L,
-105.0 — =
HHH\.:/“‘N—'—HW'—'—'_’_#M
-120.0
100 1000 10000
Cursor:  20.2 Hz, -81.90 dB Frequency{Hz)
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llustracion 4.6 Rango dinamico en la modalidad FR1 para la tarjeta de sonido EWX 24/96, sin
compensacion (curva superior) y con compensacion (curva inferior).

Ahora conecte el canal derecho en el modo bucle y repita la medicion en la modalidad FR2.
Compruebe la modalidad ‘Frequency domain averaging’ [Compensacion en el dominio de la
frecuencia] en el cuadro de didlogo ‘Frequency Response Measurement Setup’ [Configuracion de
la medicion de la respuesta en frecuencia]. Obtendra una respuesta en frecuencia casi perfectamente
plana y un rango dinamico tal como se muestra en la Ilustracion 4.7.

. FR Magnitude dB VAV (1/3 oct) Left/Right Awg:100
A
R
-15.0
T
-20.0 A
-45.0
800
760
_,—o—‘—'_'-'_'-ﬂ
B e n it Sl
800 "“’-W
W
-120.0
100 1000 10000
Cursor:  20.2 Hz, -103.16 4B Frequency{Hz)

lustracion 4.7 Rango dinamico en la modalidad FR2 para la tarjeta de sonido EWX 24/96, sin
compensacion (curva superior) y con compensacion (curva inferior).

Vemos que la compensacion en el dominio de la frecuencia, en la modalidad FR2, nos da un rango
dindmico ligeramente mas grande que en la modalidad FR1. Esta ganancia en el rango dinamico sera
mas pronunciada al medir sistemas que exhiben distorsiones no lineales.

La compensacion permite mediciones con un rango dinamico grande, pero solo si usamos la tarjeta de
sonido de alta calidad. La Ilustracién 4.8 muestra la comparacion del suelo de ruido para dos tarjetas
de sonido (Audio integrado Intel y sistema de sonido de muy alta calidad RME Fireface 800). Durante
las mediciones ambas tarjetas estaban en modo de 16 bits, pero la diferencia en el rango dinamico es
de 30-50 dB.

0 FR Magnitude dB VAV (1/3 oct) Left Awvg:11
A
R
-20.0 T
A
-40.0
-£0.0
_\-\-‘-\-\-"\—\_rl".ﬂ-\-\-
-80.0 S ] BEEEES S
-100.0
.
~120.0 = S et
Www
-140.0
10 100 1000 10000
Curzor: 202.5Hz, -79.26 dB Frequency(Hz)

lustracion 4.8 Rango dinamico en modo FR1 sin compensacion para sonido integrado Intel (curva
superior) y RME Fireface 800 (curva inferior).
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Nota: Los anteriores ejemplos muestran curvas con un suavizado 1/3 octava. El
suavizado de la curva de la respuesta de frecuencia se hace de forma diferente cuando se
realiza el suavizado de la magnitud del espectro. ARTA usa un planteamiento de primero
interpolar y compensar la respuesta en el eje de la frecuencia logaritmica, a continuacion
hace el suavizado mediante la circunvolucion de esa respuesta con la respuesta del filtro
Butterworth de seis polos de paso de banda.

4.3 Superposiciones de respuestas en frecuencia

En las ventanas de la respuesta en frecuencia los siguientes comandos de menu se utilizan para
manejar las superposiciones:

Overlay [Superposicion]
Set overlay [Establecer superposicion] — establecer la respuesta en frecuencia actual como
superposicion
Delete overlay [Borrar superposicion] — eliminar la superposicion
Load overlay [Cargar superposicion] — cargar el archivo con la superposicion de la respuesta en
frecuencia
Save overlay [Guardar la superposicion] — guardar la respuesta en frecuencia en un archivo de
superposicion
Generate target response [Generar respuesta objetivo] — generar una superposicion con respuesta de
filtros de cruce estandar
Delete target response [Borrar respuesta objetivo] — generar una superposicion con respuesta de filtros
de cruce estandar

Aqui tratamos con dos tipos de superposiciones. El primer tipo se puede fijar a partir de la curva actual
usando el comando ‘Overlay > Set overlay"' [Superposicion > Establecer superposicion] o
cargandolo de un disco con el comando 'Overlay->Load overlay' [Superposicion > Cargar
superposicion]. Se puede mostrar s6lo una superposicion de este tipo. Este tipo de superposicion se
puede guardar en el disco usando el comando ‘Overlay > Save overlay' [Superposicion > Guardar
superposicion]. Los nombres de los archivos de superposicion tienen la extension ".ovf'.

El segundo tipo de superposiciones son respuesta de filtros objetivo definidos por el usuario. Se
pueden generar usando el cuadro de dialogo ‘Target Filter response’ [Respuesta de filtro objetivo]
que aparece en la [lustracion 4.9. Se activa con el comando 'Overlay > Generate target response’
[Superposicion > Generar respuesta objetivo].
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Target Filter Response x|

Reference passband sensitivity: 20l [dg)
~Filter type I
01, Butterwort™I order
v Low - pazs 02, Butterwaorth - I order
03, Bessel - IT order
I~ High - pass 04, Linkwitz - II order

05, Butterworth - III order
&, Bessel - 11T order

[~ Band - pass

. Butterworth - IV order
03, Bessel - IV order
09, Linkwitz - IV order
10, Butterworth - W order
11, Bessel - V order
12, Butterworth - VI order

Lower: I S00 Mz 13, Bessel- VI order

14, Linkwitz - VI arder

Cancel | | QK I

—Crossover frequendes

Upper: 1000 | [Hz]

lustracion 4.9 El dialogo para generar una superposicion con la respuesta de filtro objetivo del filtro
de cruce del altavoz

La seleccion de respuestas filtro objetivo se hace a partir del conjunto de las respuestas de filtro de
cruce del altavoz. El usuario elige el tipo del filtro de cruce 6ptimo del cuadro desplegable de la
derecha y determina los parametros de dicho filtro:

Reference passband sensitivity [Sensibilidad de la banda de paso de referencia] - un valor arbitrario
para la sensibilidad de la banda de paso del altavoz

Filter Type [Tipo de filtro] - paso bajo, paso de banda o paso alto

Crossover frequencies [Frecuencias de cruce] - dos casillas de edicion para introducir las frecuencias
superiores e inferiores del filtro de cruce.

Un tercer tipo de superposiciones son respuestas arbitrarias definidas por el usuario provenientes de un
archivo ASCII (con el comando de menu ‘Overlay > Load target response’ [Superposicion >
Cargar respuesta objetivo]).

El contenido deberia tener el formato .frd.

* se puede usar un asterisco al inicio para designar un comentario opcional
* magnitud de frecuencia (dB)

1000 32
1020 33
1040 34

De forma opcional, la tercera columna puede contener el valor de la fase.
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4.4 Obtencidn de la respuesta de impulso a partir de la respuesta en
frecuencia medida

A continuacion discutimos como obtener la respuesta de impulso a partir de la respuesta de frecuencia
medida. Tomamos como ejemplo la respuesta de frecuencia del sistema GSM que aparece en la
[lustracion 4.10.

Nota: Un nivel elevado de distorsiones y el ruido, incluso después de compensar 34 bloques FFT,
proporciona una respuesta en frecuencia con enormes ondulaciones.

=

File Owverlay Edit View Recorder Generator Setup Mode Help
| oufr [Iwe|FeoFroSea e @ [0 @7 | = m|= &)

Gen [FNpink  =| FsiHz] [16000 =] FFT [4096  =| Delayims)[0000  Awg [Linear | | Reset|

Top

Fr. &punse magnitude dB 0 LeffRight Avg:34 ﬂ
10.0 | | —

00 1
100 P i B L 'M
200

Fit|

:31:1.::1 "‘FI !I Range

o A 4
et

A
PR

-G0.0 -.- u

-7on i [
-s0.0 |
-a0.0 | FrHigh
100 1000 10000
Cursar 23.4 Hz, -51.57 dB Fregquency(Hz) |+
Ready |L:47.6d8 |R:-52.0dB |Frequency response 2Ch 4

llustracion 4.10 Respuesta en frecuencia del sistema GSM. (fs = 16000Hz, compensacion lineal,
tamafio del bloque FFT 4096 muestras o 235 ms, generador: PN rosa con frecuencia de corte 200Hz).

Haciendo clic sobre el icono de la barra de herramientas Iy (0 el menu Mode > Impulse response
[Modalidad > Respuesta de Impulso]) abre el cuadro de didlogo que aparece en la Tlustracion 4.11.
Una confirmacion a la pregunta: “Convertir a respuesta de impulso”, con el boton "Yes' [Si] se abre la
ventana de respuesta de impulso (Tlustracion 4.12) que contiene la vista temporal de la respuesta de
impulso.

L) E Convert bo impulse response?
[

Yes Mo
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llustracion 4.11 Cuadro de dialogo para obtener la respuesta de impulso a partir de la respuesta en
frecuencia

Nota: La conversion a la respuesta en impulso se puede hacer usando el comando de ment 'File >

Save as PIR' [Archivo > Guardar como PIR]. Este comando transforma la respuesta en frecuencia
actual en una respuesta en impulso que la archiva como un archivo .PIR.

[ Untitled - Arta =101 %]

File Edit View Record Analysis Setup Tools Mode Help

Ca [ 7 [[Inp FRZ Fl Sea | B [ =0 mm | (=3 (75 29 G 8 @3 (2 ¥ | @2
FFT |4|:|E|E vI Window ILlnifl:nrm vI Delay for phase estimation [mz] IEI.EIEIEI | Getl | Eeru:ul | IrwI

Ir‘nr:uMgg responge (MR Marker

. 59 pal

207.799
155,599

& | Cffzet
103,299 =

- Nulll
51.950 —

0.000 ]'-— G it

-51.050 - Ma:-:l
1L Y | Min |
-185.0499 -
2077949 Zoom

| Al |
0.00 46 50 Q3.00 139.80 186.00 ms
Cursor: 330,082 oV, 18.750 ms (3007 Gate: 204750 ms (3276) | Maw
Ready |L:-100.0d8 | R:-100.0dE | Impulse Response 4

lustracion 4.12 Ventana de respuesta de impulsos

En la ventana de respuesta de impulso podremos modificar la vista de una respuesta de impulso de la
misma forma y con los mismos controles que en la ventana de registro de tiempo.

La linea amarilla indica la posicion del cursor, y la linea roja indica la posicion del marcador.

El “‘Cursor’: La etiqueta "Cursor:' [Cursor:] indica el informe de la magnitud de la sefial en la posicion del
cursor (tiempo en ms o posicion de la muestra — con llaves). La etiqueta ‘Gate:' [Limitacién] indica el informe
para la diferencia en tiempo (y muestras) entre el cursor y el marcador. De forma alternativa, se puede establecer,
en el comando de menu “View > Gate Time (m @ 344m/s)’ [Ver > Tiempo de limitacion (m @ 344m/s)’]
para mostrar la distancia equivalente de la propagacion de la onda sonora.

Puede cambiar la posicion del marcador y del cursor pulsando y arrastrando las teclas izquierda y derecha del
raton. Haga doble clic sobre el boton derecho del raton para activar y desactivar el marcador. Lo mismo se puede
hacer con los botones Set [Fijar] y Del [Borrar] del panel derecho. Otros botones sirven para hacer zoom sobre
el grafico, para cambiar la ganancia [gain] y la desviacion [offset] vertical. El comando Zoom All [Ampliar
todos] — muestra todos los puntos de la sefial. El comando Zoom Max [Max Ampliacion] — muestra los puntos
entre el cursor y el marcador, pero si se desactiva el marcador, amplia el grafico a un nimero de puntos de la
pantalla.

Se pueden usar las siguientes teclas de acceso directo:
Teclas arriba y abajo - para cambiar la ganancia
Teclas Ctrl+arriba y Ctrl+abajo - para cambiar la compensacion vertical
Teclas izquierda y Ctrl+izquierda — para desplazar la curva hacia la izquierda.
Teclas derecha y Ctrl+derecha — para desplazar la curva hacia la derecha
Teclas Shift+izquierda y shift+derecha — para mover el cursor hacia la izquierda y la derecha
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Tecla Repag y Avpag - para cambiar el factor de ampliacion

Arrastrando el raton a la zona de las etiquetas se desplaza la curva horizontal y verticalmente.
Haciendo doble clic sobre el botdn izquierdo del boton sobre el area del eje de tiempo cambia la etiqueta de
posicion tiempo/muestra.

En este ejemplo, el marcador (linea roja) esta en la posicion del maximo. Es decir, a 207,7 ms desde el
cursor (linea amarilla). La etiqueta Limitacion muestra esta diferencia (realmente nos da la cantidad de
retardo del sistema).

Nota: El cursor esta colocado en una posicion de referencia para mediciones de canal
doble. Es la posicion de retardo cero. En ARTA, la posicion referente es el indice de
muestra 300.

En la modalidad de medicion de canal sencillo, la posicion de retardo cero no esta fija —
ARTA siempre pone en la posicion de referencia la primera muestra cuya amplitud sea
20dB inferior al maximo de la respuesta de impulso.

En la configuracion de mediciones, un parametro — el retardo del sistema - es bastante arbitrario. El
retardo esta siempre presente en las mediciones acusticas (debido a la propagacion del sonido desde el
altavoz al microfono). También estd siempre presente en todos los sistemas procesados digitalmente,
especialmente, es bastante grande en un sistema GSM.

Si repetimos las mediciones, pero con la casilla de edicion Propagation Delay [Retardo de
propagacion] en la ventana FR2 configurado a 204,7 ms, obtenemos la respuesta de impulso que se
muestra en la [lustracion 4.13.

Impulse response (mynd

166.228
124679
23120 L
414560
0.000
-4 A60
-B3.120
-124.679
-166.239

0.00 2325 456,50 F0.00 9325 ms
Curzor 567 65 oW, 18750 ms (32007

llustracion 4.13 Respuesta de impulso medida con una compensacion del retardo de propagacion
Abhora, el maximo de la respuesta de impulso estara cercana a la posicion referente de "retardo cero".
Quiere decir que las mediciones se realizan con unas sefiales de entrada y salida maximamente

correlacionadas.

Es extremadamente importante para estimar el retardo adecuadamente al medir con excitacion con
ruido continuo.

Nota: En ARTA se pueden guardar la respuesta de impulso como archivo de formato *.PIR
usando el comando de menu File > Save [Archivo > Guardar] o File > Save as [Archivo
> Guardar como]. La descripcion de las operaciones del archivo se incluye en el siguiente
capitulo.
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4.5 Archivos PIR

ARTA usa un formato binario especial para mantener los datos medidos de la respuesta de impulsos
en archivos cuya extension serd .PIR.

Ademas de los datos medidos, los archivos .PIR pueden contener texto definido por el usuario de
longitud arbitraria. El usuario podra introducir cualquier tipo de texto en el cuadro de edicion del
cuadro de dialogo 'File Info' [Informacidn de archivo] (véase la Ilustracion 4,14). Este cuadro de
dialogo se puede abrir haciendo clic sobre el comando de ment File > Info [Archivo > Informacion].

x

File: Untitled

Samplerate: 16000 Hz
Length in samples: 4096
Length in ms: 256,000 ms
Input Device: voltage probe

User supplied additional informations:

Here you enter what you want to... ;I

lustracion 4.14 Cuadro de dialogo para ver ¢ introducir la informacién del archivo

El formato del archivo binario .PIR es el siguiente:

char filesignature[4] // cuatro caracteres de firma: "P","I","R","\O"
unsigned iInt version; // version de formato de archivo

int infosize; // longitud del texto definido por el usuario
al final del archivo

int reservedl; // 0;

int reserved2 // 0;

float fskHz; // frecuencia de muestreo en kHz

int samplerate; // frecuencia de muestreo en Hz

int length; // longitud pir

int inputdevice; // 0 - voltprobe, 1l-mic, 2-acc

float devicesens; // V/N o V/Pa (para entrada de micréfono)

int numchannels; // medicion en canal sencillo o doble

int avgtype; // tipo de compensacion (O-tiempo o 1-
frecuencia)

int numavg; // numero de compensaciones empleadas en las
mediciones

int bfiltered; // filtro antisolapamiento forzado en el canal
2

int genused; // tipo de generador

float peakleft; // valor pico (ref. 1.0) en el canal de entrada
derecho

float peakleft; // valor pico (ref. 1.0) en el canal de entrada
derecho

float reservedl; // 0

float reserved?2; // 0
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float reserved3; // 0
float pir[length]; // datos pir
char infotext[infosize]; // texto introducido por el usuario

ARTA puede exportar datos de la respuesta de impulso en tres formatos:
1) Archivo .wav de 16 bits de Microsoft (maximo de PIR de 32000)

2) Archivo ASCII MLSSA

// Todas las lineas comienzan con espacio inicial, en el siguiente
orden:

Cero (0).

Intervalo de muestreo en milisegundos.

Numero total de puntos de datos para seguir.

Puntos de datos.

Cadena de nombre.

3) Archivo ASCII — Archivo de texto con lineas de comentario y lineas con dos columnas de datos
(tiempo en segundos y amplitud en voltios)

// Algun comentarios
// tiempo (segundos) amplitud (V)

0.01 0.234
0.02 045
0.03  -0.98

ARTA puede importar datos de la respuesta de impulso en cuatro formatos:

1. Archivo .wav de 16 bits de Microsoft (maximo de .wav establecido en un valor 1.0 en el
archivo .pir)

2. Archivo .tim MLSSA binario
3. Archivo ASCII MLSSA — tal como se describe antes

4. Archivo ASCII — tal como se describe antes (también acepta formatos de tiempo ASCII
CLIO)
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5 Medicidon de larespuesta de impulsos

La ventana de la respuesta de impulsos tiene una barra de herramientas y una barra de dialogo. Los
iconos y los controles de estas barras se usan principalmente para configurar y accionar varios analisis

a partir de la respuesta de impulsos medida. So6lo un icono de la barra de herramientas ( > )yel
comando de menu (Record > Impulse Response [Grabadora > Respuesta de impulsos]) estan
dedicados a las mediciones. Activandolos se obtiene el cuadro de didlogo para medir directamente la
respuesta de impulsos usando tres sefiales de excitacion: Ruido periddico, ondas sinusoidales de
barrido y secuencias binarias de longitud maxima (MLS).

El cuadro de dialogo "Impulse response measurement’ [Medicion de la respuesta de impulsos] se
muestra en la [lustracion 5.1. Es una hoja de propiedades con tres paginas:

e Ruido periddico
e Barrido (onda sinusoidales de barrido)
e MLS (Secuencia de longitud maxima)

Cada hoja sirve para configurar y hacer la medicion de una respuesta de impulsos. Se debatira mas
adelante cuando usar cada tipo concreto de excitacion.

5.1 Medicidn de la respuesta de impulsos con excitacion de ruido periédico

Los principios de la medicion de respuesta de impulsos son las mismas que en el analizador de Fourier
que se ha descrito antes. La tnica diferencia es que en esta medicion no vemos los resultados de la
medicion a tiempo real. Los resultados de la medicion estaran disponibles en la ventana de la respuesta
de impulsos.

En la medicion de respuesta de impulsos, el usuario ha de realizar cuatro acciones:

1. Configurar los parametros de medicion.

2. Pulsar el boton Record [Registro] y espere a que acabe la medicion (durante 1a medicion el
boton Record aparece en gris).

3. Controlar los niveles de entrada. Si la entrada esta limitada, detenga la medicion, pulsando de
nuevo el boton Record, y reduzca el volumen de entrada y salida. En la parte inferior del
cuadro de dialogo el viimetro muestra el voltaje pico de entrada durante el registro o
generacion de sefial. Tenga en cuenta que las barras del viimetro cambian al color rojo si el
canal de entrada esta sobrecargado.

4. La medicion suele detenerse cuando se adquieren todas las compensaciones. Pulse el boton
Ok para volver a la Ventana de la respuesta de impulsos.
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Impulse response measurement ﬂ

Periodic Moise |Sweep| MLS I

— Periodic noise generastor——————  — Reconder
Sequence length Iﬂ Prefered input channel m
Sampling rate {Hz) [16000 = Dual channel measuremert mode W
Time constant: 102400 ms Invert Phase of input channel [~
Moise spectrum IPi”k j‘ Mumber of averages |1—
Output valume (dB) ID_LI Frequency domain 2Ch averaging [
Pink cutoff (Hz) 200 Filter dual channel impulse response [~

Generate | Recod |
e e e

lustracion 5.1 Cuadro de dialogo para la medicion de la respuesta de impulsos usando la excitacion
de ruido peridodico

Los controles que se usan para la medicion de la respuesta de impulso con la excitacion del ruido periodico son:

Sequence length [Longitud de la secuencia] — elija el nimero de muestras en un periodo del ruido
periddico

Sampling Rate [Frecuencia de muestreo] — elija la frecuencia de muestreo,

Noise Spectrum [Espectro de ruido] — elija la forma espectral del ruido (Rosa, Blanco o Habla),
Output Volume [Volumen de salida] — elija el volumen de salida en dB,

Pink cutoff-Hz [Corte rosa-Hz] — introduzca la frecuencia de corte del ruido periddico rosa,

Preferred input channel [Canal de entrada preferido] — elija el canal de entrada de la tarjeta de sonido
que se emplea para medir la salida de un dispositivo a prueba,

Dual channel mode [Modo de canal doble] — elija el modo de canal sencillo o doble,

Invert Phase of input channel [Invertir la fase del canal de entrada] — activar esta casilla para cambiar
la polaridad de la sefial de entrada.

Number of averages [NUmero de compensaciones] — introduzca el nimero de compensaciones
Frequency domain 2ch averaging [Compensacién de canal doble en el dominio de frecuencia] —
active esta casilla para usar la compensacion en el dominio de la frecuencia

Filter dual channel response [Filtrado de la respuesta de canal doble] — Active esta casilla para usar el
filtro “antisolapamiento” de la respuesta de impulso (se elimina el ruido cerca de fy/2 en el modo de canal
doble),

Generate [Generar] — iniciar o detener el generador,

Record [Grabacidn] — iniciar o detener la medicion (grabacion y generacion de sefial),

Default [Defecto] — seleccionar la configuracion por defecto

OK - cierra el cuadro de didlogo y vuelve a la ventana de respuesta de impulsos, que contendra la nueva
respuesta de impulsos periddica grabada.

Esc - cierra el cuadro de didlogo y vuelve a la ventana de la respuesta de impulsos, sin modificar su
contenido.
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5.2 Medicion de la respuesta de impulsos con excitacion de ondas sinusoidales
de barrido

Generalmente las ondas sinusoidales de barrido se definen como sefal sinusoidal g(t) con una funcién
de fase que varian con el tiempo ¢(1):

g(t) =sin(27 p(1))

La frecuencia instantanea de esta sefial se define como:
do(t)
f(t)=—""<
() ot

En ARTA se usan dos tipos de ondas sinusoidales de barrido; una con una dependencia de tiempo-
frecuencia logaritmica y otra lineal. Una sefial sinusoidal de barrido lineal se define con la siguiente
funcion de fase:

pt)= ft+(f,— f)t*/2T

En la que T denota la duracion total del barrido (en segundos), f; es la frecuencia de inicio y f, esla
frecuencia de parada.

Se define una onda sinusoidal de barrido logaritmico, conforme a Farina, con la siguiente funcion de
fase:

fT
In(f,/f,)

t
—In(f,/f
Tn(z 1)_

p(t) = (e )

En ambos casos, el factor de cresta es 3dB, un valor mucho menor que el factor de cresta del ruido.
Quiere decir que la medicion con una onda sinusoidal de barrido nos da una relacion sefial/ruido
elevada.

(Como usa ARTA la onda sinusoidal de barrido en una medicion de respuesta de impulso?

ARTA trata las ondas sinusoidales de barrido como sefiales no periodicas y las usa como sefales de
excitacion en un analizador Fourier con un estimador H1. La idea basica se muestra en la Ilustracion
5,2. Primero, se genera la secuencia de la onda de barrido de longitud N. En el mismo momento,
ARTA inicia la adquisicion del bloque de 2N muestras para un andlisis de FFT. Sera importante
duplicar la longitud de la secuencia adquirida en una medicidn actstica puesto que garantiza que se
recogen todos los reflejos de la sala. Un requisito adicional en las mediciones acusticas es que la
duracion de la secuencia generada sea mayor que el tiempo de reverberacion de la sala.

Swept-sine of length M Swept-sine of length N
| Excitation
FFT black of length 2M FFT block of length 2M

| | | | Measured output

lustracion 5.2 Principios de la generacion de las ondas sinusoidales de barrido y la adquisicion de
sefial en ARTA
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Impulse response measurement I ﬂ

Perodic Moise Sweep II'U'ILS I

— Sweep generator — Recorder

Seqguence length Iﬂ Prefered input channel m
Sampling rate (Hz) |16000 - Dual channel measurement mode [+
Time constart: 1024.00 ms Invert phase of input channel [~
Output volume (dB) Iﬁ Mumber of averages I‘I—
Logfrequency sweep W Filter dual channel impulze response [

Generate voice activation W Record |
Center peak of impulze responze. [
I e I S Defaut |

ok | Cancel |

lustracion 5.3 Cuadro de dialogo para la medicion de la respuesta de impulsos usando una onda
sinusoidal de barrido

Los siguientes controles se usan para la medicion de la respuesta de impulsos usando la excitacion de la onda
sinusoidal de barrido:

Sequence length [Longitud de la secuencia] — elija el nimero de muestras en un periodo de la onda
sinusoidal de barrido

Sampling Rate [Frecuencia de muestreo] — elija la frecuencia de muestreo,

Output Volume [Volumen de salida] — elija el volumen de salida en dB,

Log-frequency sweep [Barrido de frecuencia logaritmica] — elija la dependencia tiempo-frecuencia
logaritmica o lineal

Generate voice activation [Generar la activacion de voz] — seleccione esta casilla para activar una sefial
especial de tipo voz Sera necesario en un sistema activado por la voz.

Preferred input channel [Canal de entrada preferido] — elija el canal de entrada de la tarjeta de sonido
que se emplea para medir la salida de un dispositivo a prueba,

Dual channel measurement mode [Modo de medicion de canal doble] — seleccione esta casilla si desea
el modo de medicién de canal doble,

Invert Phase of input channel [Invertir la fase del canal de entrada] — activar esta casilla para cambiar
la polaridad de la sefial de entrada.

Number of averages [NUmero de compensaciones] — introduzca el nimero de compensaciones, aunque
no se suele usar,

Record [Grabacion] — iniciar o detener la medicion (grabacion y generacion de sefial),

Filter dual channel response [Filtrado de la respuesta de canal doble] — Active esta casilla para usar el
filtro “antisolapamiento” de la respuesta de impulso (para eliminar el ruido cerca de fy/2 en las mediciones
en modo de canal doble),

Center impulse response [Centrado de la respuesta de impulsos] — seleccione esta casilla para activar
la grabacion de la parte de la respuesta de impulso no causal (inicio anterior). Esta parte de la respuesta de
impulso (en la estimacion con un barrido logaritmico) contiene las imagenes de respuesta de impulsos
inducidas por distorsion.

Default [Defecto] — seleccionar la configuracion por defecto

OK - cierra el cuadro de didlogo y vuelve a la ventana de respuesta de impulsos, que contendra la nueva
respuesta de impulsos periddica medida.

Esc - cierra el cuadro de didlogo y vuelve a la ventana de la respuesta de impulsos, sin modificar su
contenido.
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Notas: La onda sinusoidal de barrido es una sefial de excitacion 6ptima para la medicion rapida de
una respuesta de impulsos acustica sin compensacion. Nos proporciona una estimacion mejor que
otras sefiales de excitacion en entornos acusticos que varian con el tiempo y sistemas ligeramente no
lineales.

La onda sinusoidal de barrido no una sefial de excitacion buena si el entorno genera un gran nivel de
ruido coloreado o impulsivo. También nos da una mala estimacion en el sistema que tiene un control
de ganancia automatica sensible a la frecuencia o la supresion automatica del ruido. En aquellos casos
en los que la excitacion con ruido periddico nos da una estimacion mejor.

5.3 Medicion de la respuesta de impulsos con excitacion MLS

Una sefial de Secuencia de Longitud Maxima (MLS) es una sefial de impulsos con intercambio casi-

aleatorio que indica: +1y -1. Se puede analizar como secuencia binaria de N ceros o unos, que es
L . om _ )

periodico con un periodo N =2"-1. El MLS se puede generar con registros de cambio conectado en

retroalimentacion. Las conexiones de retroalimentacion se definen con algun polinomio primitivo de

orden m-avo. Por ejemplo, la Ilustracion 5.4 muestra la generacion de una secuencia MLS con el

polinomio

b(x)=x* +x* +1

Estos son polinomios de cuarto orden y la secuencia MLS generada tiene una longitud (periodo) N =
2f-1=15.

Estados de registros de

cambio
KOR a3 a2 al a0
1 1 0 0 0
1 1 0 0
N N N output 1 1 1 0
a il bl I ol dn i 1 1 1 1
0 1 1 1
o+ X+ 0+ 0 o+ 1 1 0 1 1
0 1 0 1
1 0 1 0
1 1 0 1
output  —= | 0 1 1 0
— 0 0 1 1
= e Al 1 0 0 1
I pertod I I 0 1 0 0
0 0 1 0
0 0 0 1
1 0 0 0

lustracion 5.4 Generacion de secuencia MLS con registros de cambio

Cada secuencia MLS tiene las siguientes caracteristicas:

1. La funcién de autocorrelacién es constante R =4 1 k=0

2. Elvalor CC esigual a 1/N

3. El factor de cresta es 1 (0dB)
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Para N mayores, un valor CC (1/N) se acerca a cero. Entonces, la autocorrelacion es igual a 1 para
k=1, sino es igual a cero. El espectro de potencia S, y la autocorrelacion Rg son parejas Fourier:

N-1
S:X — Z Rlz(xe—jZan/N =1

k=0

Este espectro de potencia es una constante, que significa que la secuencia MLS tiene un espectro
blanco. Cuando la excitacion del sistema tiene un espectro blanco la correlacion-cruzada de una sefial

de salida con una sefial de entrada es proporcional a la respuesta de impulsos del sistema (h, ~ R}?).

Una simple generacion de hardware y una computacion de correlacion rapida fueron la razon principal
para la popularidad de una instrumentacion de base MLS (la correlacion con una secuencia MLS se
puede hacer con la transformada Hadamard que es un algoritmo mas rapido que un FFT).

La segunda razon para la popularidad de MLS es una propiedad tedrica MLS que tiene el factor de
cresta mas bajo posible. En realidad, cuando se genera el MLS con una tarjeta de sonido, esto no es
verdad, puesto que la sefial MLS cambia en la salida del filtro "antisolapamiento” conversor D/A y al
pasar a través de cualquier otro filtro. Un valor de factor de cresta de 6dB a 9dB es comun en la salida
de las tarjetas de sonido de PC.

El mayor problema con la sefial MLS es que algunas de las subsecuencias de MLS estan
correlacionadas y pueden generar graves distorsiones al medir la respuesta de sistemas no lineales. Y
es por eso que las ondas sinusoidales de barrido y el ruido periédico son sefiales mejores para medir la
respuesta en frecuencia de sistemas que presentan una ligera no linealidad.

Impulse response measurement El

Periodic Nuisel Sweep MLS |

—MLS generator — Recorder
Sequence length I‘IEEES TI Prefered input channel ILeft TI
Sampling rate (Hz) 16000 - Use second channel as reference [
Time constant: 1023.594 ms Invert Phase of input channel [~

Output volume (dB) - Number of averages |1

Generate MLS | Recod |

llustraciones 5.5 Cuadro de didlogo para la medicion de la respuesta de impulsos usando MLS

68



ARTA User Manual

Los siguientes controles se usan para la medicion de la respuesta de impulsos usando la excitacion MLS:

Sequence length [Longitud de la secuencia] — elija el nimero de muestras en un periodo de MLS,
Sampling Rate [Frecuencia de muestreo] — elija la frecuencia de muestreo,

Output Volume [Volumen de salida] — elija el volumen de salida en dB,

Preferred input channel [Canal de entrada preferido] — elija el canal de entrada de la tarjeta de
sonido que se emplea para medir la salida de un dispositivo a prueba,

Use second channel as reference [Usar el segundo canal como referencia] - active esta casilla para
configurar la medicion en modo semi-doble (se estima un retardo de entrada/salida de precision de una
muestra),

Invert Phase of input channel [Invertir la fase del canal de entrada] — activar esta casilla para
cambiar la polaridad de la sefial de entrada.

Number of averages [NUumero de compensaciones] — introduzca el namero de compensaciones (usando
la compensacion sincronica)

Record [Grabacidn] — iniciar o detener la medicion (grabacion y generacion de sefial),

Default [Defecto] — seleccionar la configuracion por defecto

OK — cierra el cuadro de didlogo y vuelve a la ventana de respuesta de impulsos, que contendra la nueva
respuesta de impulsos periddica medida.

Esc - cierra el cuadro de dialogo y vuelve a la ventana de la respuesta de impulsos, sin modificar su
contenido.

Al usar una sefial MLS, so6lo se permite la configuracion de canal sencillo o de canal semi-doble. En la
configuracion del canal semi-doble el segundo canal se usa como referencia de tiempo, pero la
estimacion de la respuesta de impulsos se hace como en el sistema de canal sencillo (de esta forma se
puede estimar un retardo de entrada/salida de precision de una muestra, pero la funcion de
transferencia estimada est4 polarizada por las funciones de transferencia de los conversores A/D y
D/A).

Algunas recomendaciones generales:

e Elsistema con base MLS es inferior a los sistemas accionados por ondas sinusoidales de
barrido o por ruido peridédico cuando se implemente con una tarjeta de sonido de PC normal.

e [El sistema con base de ondas sinusoidales de barrido nos proporcionan la mejor estimacion en
un entorno de bajo ruido.

e Elsistema de medicion con una excitacion de ruido rosa periddico nos da la estimacion mas
robusta, y se puede considerar como sistema de uso general.

5.4 Procedimientos basicos de edicion

El subment Edicion permite usar los siguientes comandos para editar una respuesta de impulsos:

Invert [Invertir] — cambia la polaridad de la respuesta de impulsos cambiando simplemente el
signo de la respuesta de impulsos.

Rotate at cursor [Girar en el cursor] — cambia la respuesta de impulso de forma que la
posicion punto actual del cursor se convierte en el primer punto de la respuesta de impulsos y
los puntos anteriores se convierten en el Gltimo punto de la respuesta de impulsos. Sera util para
editar la respuesta de impulso periddica (las que se hayan obtenido con un ruido periodico o con
una excitacion MLS).

Scale [Escala] — se usa para multiplicar la respuesta de impulso con una constante arbitraria o

valor de expresion aritmética. Este comando activa el cuadro de didlogo Pir Scaling’
[Graduacién Pir] que se muestra en la Tlustracion 5.6.
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Pir Scaling x|

Enter number or arithmetic expression ko scale PIR:

SH(E*100)

Cancel | (0] 4 I

lustracion 5.6 Cuadro de dialogo para la graduacion arbitraria de una respuesta de impulsos

En el cuadro de edicion el usuario introduce una constante del punto flotante o una expresion
aritmética compuesta por:

e Numeros enteros,

e Numeros de coma flotante,

e Operadores — por orden de prioridad: Exponenciacion (*), multiplicacion (*, /), suma (+, -)

e Corchetes () para agrupado.

Ejemplo: La expresion valida para introducir la escala equivalente de 0,7 dB es la expresion 10"
(0.7/20).

La graduacion se suele usar para escalar la respuesta de campo cercano de un altavoz para obtener la
estimacion de la respuesta de campo lejano.

Ejemplo: La medicion de los altavoces en la respuesta de la sala no nos puede dar una estimacion de
la respuesta de bajos en campo abierto. Para obtenerlo medimos la respuesta de bajos en el campo
cercano de los altavoces pyr y escalar la respuesta con un factor que es igual a la relacion del radio de
la membrana con el doble de la distancia normal de medicion r.

a
p(r)za Pne

Las respuestas obtenidas de esta forma son una buena aproximacion de la respuesta de campo abierto
del altavoz montado en una caja infinita (27), para frecuencias por debajo de 200Hz.
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6 Analisis del sistema a partir de la respuesta de
Impulsos

La respuesta de impulsos es una caracteristica del sistema fundamental. Usandola, ARTA puede
estimar los siguientes datos:

Respuesta de frecuencia limitada y suavizada 1/n octavas,

Respuesta de etapa,

Envolvente de respuesta de impulsos (o curva tiempo energia — ETC),
Curva de deterioro espectral acumulado (CSD),

Curva de deterioro de energia y parametros acusticos de la sala,
Funcion de transferencia de modulacion del habla (MTF),

Indice de transmision del habla (STI y RASTI).

NNk~

Estos analisis se pueden activar en el submenti Analysis [Analisis] o haciendo clic con el botén
izquierdo del raton sobre uno de los iconos de la barra de herramientas "verde" que se muestra en la
Ilustracion 6.1.

Record DFT Impulse  Cumulative
Copy to Measurement im FR
N pulse frequency response Spectral ST
clipboard mindes response comgeansation 'ETWEE envelope Decay

' R oo

Cn 7 |[Ine FrZ Fri Sea | 0 | =0 mm | (=2 3 B9 055 A2 &S 2 0F | &

f L A |

Background Audio Smoothed Enes
color BIW devices  frequency P O MTF RASTI
SEIUFI rasponssa PO

lustracion 6.1 Ventana de la respuesta de impulso — iconos de la barra de herramientas

Las siguientes secciones describen los métodos de analisis de la respuesta de impulsos.

6.1 Respuesta de impulsos limitada y de frecuencia

6.1.1 Respuesta de impulsos limitada

En muchos casos sera util analizar sélo una parte de una respuesta de impulsos, lo que se denomina
respuesta de impulsos limitada. La Transformada de Fourier (DFT) de la parte "limitada en tiempo"
de una respuesta de impulsos nos da una respuesta de frecuencia limitada.

La Ilustracion 6.2 muestra los componentes que determinen la parte "limitada" de la respuesta de
impulsos. el cursor, el marcador y la longitud del bloque de FFT.

ARTA sigue estas normas:

1. Siel marcador esta activo, la limitacion esta determinada como parte de una respuesta de
impulsos entre el cursor y el marcador. En un analisis FFT todas las muestras que queden fuera
de la limitacion se ponen a cero.

2. Si el marcador no esta activo, entonces la limitacion se determina como parte de una respuesta de
impulsos que comience en la posicion del cursor y tenga una longitud igual a la longitud del FFT
actual. Para establecer la longitud actual del FFT, podra usar la barra de dialogo (Ilustracion 6.3)
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o activar el cuadro de didlogo "Impulse Response Analysis Setup' [Configuracién del analisis
de la respuesta de impulsos].

Las partes limitadas y no limitadas de la respuesta de impulsos se dibujan con diferentes colores.

Impulse response UV
Jrl:ursur marker
e | FFT.

2108.408
184.822
108.748 |-
G874
0.000
-54.874
-108.748
-184.822
-210.488

517 12.83 20.50 28.17 3583 msz
Cursor: 387120 nW, S.583 ms (2668)

lustracion 6.2 Componentes que determinen la parte "limitada" de la respuesta de impulsos. El
cursor, el marcador y la longitud del bloque de FFT.

FFT |1I]24 "I YWindow IHann 12% "I Delay for phaze estimation [mz] IEI.EEI | Getl | Zer-:nl I Irwl

lustracion 6.3 Barra de didlogo de la ventana de respuesta de impulsos

Controles de la Barra de dialogo:
FFT — elija el tamafio de un bloque FFT
Window [Ventana] - elija el tipo de ventana de sefial
Delay for phase estimation (ms) [Retardo para estimacion de fase (ms)] — introduzca el intervalo de
tiempo para la posicion del cursos como punto de referencia para la estimacion de la fase (normalmente la

distancia desde la posicion del cursor a la posicion del maximo de la respuesta de impulsos).

Get [Obtener] — obtener el intervalo de tiempo entre el cursor y el marcador y definirlo como retardo
para la estimacion de la fase.

Zero [Cero] — establece un retardo cero

Inv - cambia la polaridad de la respuesta de impulsos
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Impulse Response Analysis Setup e i |
— Gated time window——————— ETC - windouw
Pl Rirnuarn letgth I‘IIZ|24 Vl Tupe IHaIf-Hann "I
[FFT length]

Wan if FFT length < gate v Delay for phase estimation——;

Window type IHann'IE.EZ vl Time [ms] II:IE1
Drefault | Cancel | (] 8 I

lustracion 6.4 Cuadro de dialogo para la configuracion del analisis de la respuesta de impulsos

Controles de la seccion Gated time window [Ventana de limitacion temporal]:

Maximum length (FFT length) [Longitud méxma (longitud FFT)] - elija la longitud (tamafio) del
bloque FFT.

Warn if FFT length < gate [Aviso si la longitud FFT < limitacidn] — active esta casilla si desea que se
le avise cuando la longitud FFT es menor que la limitacion

Window type [Tipo de ventana] — seleccione el tipo de ventana: Uniforme, Hann12%, Hann25% o Hann
50%.

Seccién ETC window [Ventana ETC]:

Type [Tipo] - elija la ventana para la estimacion del ETC (envolvente de la respuesta de impulsos:
Uniforme, Half-Hann, Habla, Causal

Seccion de Delay for phase estimation [Retardo para la estimacion de fase]:

Time (ms) [Tiempo (ms)] — establecer el intervalo de tiempo desde la posicion del cursor hasta la
posicion de referencia para estimacion de la fase (normalmente es una distancia desde la posicion del
cursor hasta la posicién del maximo de la respuesta de impulsos).

Antes de realizar la estimacion de la respuesta de frecuencia limitada a partir de una respuesta de
impulsos limitada en tiempo, ha de establecer el tipo de ventana que se le aplicara a la respuesta
limitada. Podra aplicar las siguientes ventanas: Uniforme, Hann12%, Hann25% o Hann 50%. El
porcentaje que aparece detras del nombre Hann quiere decir que se aplica la mitad de la ventana
Hanning en el porcentaje de la parte final de la ventana para atenuar levemente la respuesta de
impulsos. En la Ilustracion 6.5 se muestra un ejemplo de la ventana Hann12%.

Impulse raspanee LW

=TT Y S — .................................... ...............................
184,623 T

100749 H | i

SAETH | -

.o0] AN

54,574
074 -
-154.523
-242.408 |

517 12.83 2080 2817 2683 ms
Curzar: 38T A20 i, 2555 ms (203

lHustracion 6.5 Ejemplo de una respuesta de impulsos de un altavoz en una sala pequeia (ademas,

también se muestra la ventana Hann12% - determina la parte de la respuesta de impulsos que se usara
para estimar la respuesta de frecuencia “limitada’)
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6.1.2 Respuesta de frecuencia limitada

Para obtener la respuesta de frecuencia limitada a partir de una respuesta de impulsos con ventana,
podra elegir entre dos comandos de menu:

'Analysis > DFT frequency response’ [Anélisis > Respuesta de frecuencia DFT] - abre la ventana que
muestra la respuesta de frecuencia no suavizada.

'Analysis > Smoothed frequency response’ [Analisis > Respuesta de frecuencia suavizada] - abre la
ventana que muestra la respuesta de frecuencia suavizada.

[E' Smoothed frequency response (all.pir) h - |I:I|£|
File Overlay Edit View Smoothing

o Tap
FR Magnitude dB VY (smoothed 1/6 oct) ﬁ Fit |

20.0 /“LNH_._,:-\J\ Fiange
ﬂ [a]

15.0 ;
oo M

__,_.f-/ T \\ Smoothing
n_'n \ [13 =]

=D

-5.0
-10.0
-15.0
300 II| High Fr
o | <
-20.0 ].'F Low Fr
’ 100 1000 10000
Cursor: 88.8 Hz, 13.95dB Frequency {Hz) ;I;I
I tag M+F'| Ph | [ad | Recaord I Overlay | B M | Copy |

A

llustracion 6.6 Ventana de respuesta de frecuencia suavizada (La barra horizontal, dibujada
en color de cursor, denota la region de la frecuencia en la que el requisito de ancho de banda-
tiempo no se satisface).

La Ilustracion 6.6 muestra la Ventana de respuesta de frecuencia suavizado. La barra
derecha contiene controles para la configuracion del margen del grafico (los mismos controles que
estan en las ventanas de respuesta de espectro y de frecuencia). Se puede usar un cuadro desplegable
adicional ‘Smoothing’ [Suavizado] para establecer la resolucion de suavizado. La barra inferior tiene
varios botones:

Boton Mag — elija el grafico de magnitud

Boton M+P — elija el grafico de magnitud + fase
Boton Ph — elija el grafico de fase

Boton Gd — elija el grafico de retardo de grupo
Boton Record — para repetir la medicion,

Boton Overlay — para gestionar las superposiciones,
Boton Copy — para copiar el grafico al portapapeles,
Boton B/W — para cambiar el color de fondo.

La misma presentacion se encuentra en la ventana de respuesta de frecuencia DFT (pero sin los ments
y controles para Suavizado y Superposiciones).

La ilustracion 6.7 muestra ejemplos de las respuesta de frecuencia no suavizados y con suavizado de
1/3 octava. La comparacion de las dos curvas muestra que la respuesta suavizada nos da una
“tendencia general” y realmente la mejor perspectiva de la respuesta de frecuencia. Las grandes
ondulaciones en la respuesta de frecuencia no suavizada (DFT) son la consecuencia de los reflejos de
la sala.
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llustracion 6.7 Ejemplos de a) respuesta de frecuencia no suavizados y b) con suavizado de 1/3
octava.

ARTA ofrece suavizado de 1/1, 1/2, 1/3, 1/6, 1/12 y 1/24 octava. Los filtros de suavizado se describen
en el capitulo 2.3.

Dynamic range [dB]—— 1 Freq. range [Hz]
Graph top IF High freq Im
[araph range |5|:|_ Law freq Igu_ Default

Cancel

Thick plot lines [~ Wiew all |
K.

Time-Bandwidth W

|lpdate

FIELEIF

llustracion 6.8 Cuadro de dialogo para la configuracion del grafico.

La configuracion de los margenes del grafico y de la presentacion se podré ajustar con la barra de
control derecha y con el didlogo de configuracion del grafico, que aparece en la [lustracion 6.8.
(comando de menu View > Setup [Ver > Configuracion]. Los controles son los mismos que en las
ventanas de respuesta de frecuencia y de espectro, ademas de eso, el usuario puede ajustar el rango
para el grafico de fase y de retardo de grupo, y usar las dos casillas de verificacion adicionales.

Thick plot lines [Lineas gruesas] — permite dibujar curvas con un trazo grueso,
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Time-Bandwith [Ancho de banda-tiempo] — desactiva el dibujo de curvas con frecuencias en las que
la limitacion hace que el producto ancho de banda-tiempo sea menor a 1.

La aplicacion de la limitacion, de duracion T, influye en la resolucion de frecuencia. Si se activa la
casilla ‘“Time-Bandwidth’ [Ancho de banda — tiempo] (o menu View > Time-Bandwidth
requirement [Ver > Requisitos ancho de banda —tiempo]), ARTa s6lo mostrara los componentes de
la respuesta de frecuencia para las frecuencias en las que f, > 1/T. Si no se activa esta opcion, entonces
ARTA mostrara todos los depositos de frecuencia DFT, y la barra horizontal de la parte inferior del
grafico indicara la region de la frecuencia en la que el requisito de ancho de banda-tiempo no se ha
satisfecho (Ilustracion 6.6).

El Apéndice nos da una descripcion completa de los ments en la ventana de Respuesta de frecuencia
suavizada y la ventana Respuesta de frecuencia DFT.

6.1.3 Fase minimay retardo de grupo

Ademas de los graficos de Magnitud y Fase el usuario puede ver el grafico de Fase Minimay
Retardo de grupo. Las variaciones de los modos del grafico de la respuesta de frecuencia se realizan
con el menu View [Ver]. Tendra los siguientes elementos desplegables:

Magnitude [Magnitud] — muestra la magnitud de la respuesta de frecuencia
Magn+Phase [Magnitud + Fase] — muestra la magnitud y la fase de la respuesta de frecuencia
Phase [Fase] — muestra la fase de la respuesta de frecuencia
Group delay [Retardo de grupo] — muestra el retardo de grupo
Minimum phase [Fase minima] - muestra la fase minima del sistema
Unwrap Phase - mostrar la fase sin envolver
Excess phase [Exceso de fase] — active la casilla para ver el exceso de fase
Excess group delay [Exceso de retardo de grupo] — active la casilla para mostrar el exceso de retardo de
grupo
Sound pressure units [Unidades de presion de sonido]
dB re 20uPa/1V - unidad para el nivel de presion en los estandares acusticos
dB re 20uPa/2.83V - unidad usual para la sensibilidad del altavoz
dB re 1Pa/1V - unidad para el nivel de presion en las recomendaciones ITU T
Setup [Configuracion] — activa el cuadro de didlogo para la configuracion de los mérgenes del grafico
Time-Bandwidth Requirement [Requisitos ancho de banda-tiempo] — si se activa esta casilla, se
trazan solo las curvas de las frecuencias en las que el producto ancho de banda — tiempo es mayor de 1.

Una definicion sencilla de fase minima es: Una caracteristica de fase del sistema para la que se puede
realizar un sistema equivalente con las mismas caracteristicas de magnitud y un cambio de fase
minimo (sobre todas las frecuencias). La diferencia entre la fase y las caracteristicas de la fase minima
se suele llamar exceso de fase.

Matematicamente, la fase minima se puede estimar a partir de la magnitud de la respuesta de
frecuencia usando la transformada de Hilbert. ARTA, asi como otros programas similares, usa el DFT
para calcular la transformada de Hilbert. Introduce la periodicidad en la estimacion de la fase minima
y nos da un resultado que se acerca a la fase minima verdadera solo en las frecuencias inferiores a fy/4.

Para definir el retardo de grupo, primero analizamos la respuesta de frecuencia H (jw) de la siguiente
forma:

H ( Ja)) = A(a))ej(ﬂ(”)) — ea(a))+j(p(w)

Donde: A(w)= | H(jw) | esla respuesta de magnitud, ¢ @) es la respuesta de fase y o ) es el
logaritmo de la respuesta de magnitud.

Si asumimos que un sistema ideal tiene una respuesta de frecuencia H(j®) = const., la distorsion lineal
de la respuesta de frecuencia se puede expresar como:
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I dH(jo) _Fith®)} _ j da(w) de(w)
H(jw) d(jo)  Fh®} ~ d(@) d(e)

Donde F denota la Transformada de Fourier.

Esta expresion muestra que hay dos tipos de distorsiones lineales — debido a los cambios de magnitud
y fase. La parte real de esta expresion se define como un retardo de grupo T:

_do() _ Re[ F{th<t)}}

T d(w)

Fih(t)}

Lo que muestra esta expresion es que el retardo de grupo se puede estimar a partir de la respuesta de
impulso del sistema.

Para obtener una estimacion aceptable del retardo de grupo, se han de cumplir dos condiciones:

1. Larespuesta de impulsos ha de deteriorarse completamente dentro de la region limitada,
2. Elretardo de grupo ha de ser menor de la mitad del tamaiio de FFT. Si no se cumple esta
condicion, obtenemos el valor negativo del retardo de grupo.

A veces es ttil analizar el exceso de retardo de grupo. Es el retardo de grupo obtenido del exceso de
fase.

6.1.4 Gestion de superposiciones

En la ventana de respuesta de frecuencia suavizada el usuario podra establecer la curva actual de
respuesta de frecuencia como superposicion. También podra definir algunas curvas de superposicion
como respuesta del filtro objetivo de cruce.

Las funciones que se pueden hacer con las superposiciones se tratan en el meni Overlay
[Superposicion]. Tendra los siguientes elementos desplegables:

Set as overlay [Establecer superposicion] — se fija la curva de impedancia actual como superposicion
Set as overlay Below cursor [Establecer superposicion por debajo del cursor] — guarda la parte de
la curva actual por debajo del cursor como superposicion

Set as overlay Above cursor [Establecer superposicion por encima del cursor] — guarda la parte de
la curva actual por encima del cursor como superposicion

Manage Overlays [Gestor de superposiciones] — activa el cuadro de didlogo 'FR Overlay Manager'
[Gestor de superposiciones de respuestas de frecuencia] para editar la lista de superposiciones.

Delete all [Borrar todo] — Borra todas las superposiciones

Delete last [Borrar ultima] — Borra la tltima superposicion

Generate target response [Generar respuesta objetivo] — Generar una superposicion con respuesta
de filtros de cruce estandar

Load target response — carga la curva objetivo a superponer de un fichero ASCII(.frd format)

Delete target response [Borrar respuesta objetivo] — Generar una superposicion con respuesta de
filtros de cruce estandar

El comando de ment ‘Generar respuesta objetivo’ sirve para generar superposiciones con las

caracteristicas Optimas de las respuestas de filtros de cruce, y el comando de menu ‘Cargar respuesta
objetivo’ sirve para cargar el objetivo arbitrario que se encuentra en un archivo ASCII (formato .frd).
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Overlay colors x|

FR Overlay manager x|

Maanitude response | Color
Bl ] E—
[ al130.pir I
éal45I-pir I —
]
]
]
]
]
]
Add | Add above crsl Delete =el | Colaor | Cancel | I
Replace sel | Add below ors | Celete all | Chedc.ﬁ.]ll ok I Cancel | | Ok I

lustracion 6.9 Cuadros de dialogo 'FR Overlay Manager' [Gestor de superposiciones de
respuestas en frecuencia] y 'Overlay colors' [Colores de la superposicion]

Otras funciones avanzadas con superposiciones se podran hacer usando el cuadro de dialogo 'FR
Overlay Manager' [Gestor de superposiciones de respuestas en frecuencia] (que se muestra en la
Ilustracion 6.9). Se activa con el comando 'Overlay > Manage Overlays' [Superposicion > Gestor
de superposicién].

Algunos botones del cuadro de didlogo duplican los comandos de menu:
Add [Afadir] — establece la curva actual como superposicién
Add above crs [Afadir encima del cursor] — guarda la parte de la curva actual por debajo del cursor
como superposicion
Add below crs [Afiadir debajo del cursor] — guarda la parte de la curva actual por encima del cursor
como superposicion
Delete all [Borrar todo] — Borra todas las superposiciones

Otros botones permiten realizar funciones avanzadas en los elementos del menu desplegable
seleccionados:
Replace sel [Sustituir la seleccion] — sustituye la superposicion seleccionada por la curva activa actual
Delete sel [Borrar la seleccion] — Borra todas las superposiciones seleccionadas
Color — cambia el color de los elementos seleccionados usando el cuadro de dialogo 'Overlay Colors’
[Colores de superposicion] que se muestra en la [lustracion 6.10.

Haga clic con el ratdn sobre el elemento de la lista desplegable y sucedera lo siguiente:
Un solo clic - selecciona los elementos
Un solo clic sobre la casilla de verificacion — hace que sea visible o invisible la superposicion
Doble clic - permite editar el nombre de la superposicion

Todos los elementos de la lista se pueden hacer visibles pulsando sobre el boton 'Check All* [Activar
todo].

6.1.5 Edicion de la respuesta de frecuencia suavizada

El elemento del menua Edit [Edicion] tiene los siguientes elementos:

Copy [Copiar] — copia el mapa de bits del grafico al portapapeles
Colors and grid styles [Estilos de colores y cuadricula] — configura los colores del grafico y estilo de la
cuadricula
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Thick Pen [Trazo grueso] — si se activa esta casilla, se aumenta el grosor actual del trazo del grafico
Cut below cursor [Cortar debajo del cursor] — corta los valores del grafico por debajo del cursor
Cut above cursor [Cortar encima del cursor] — corta los valores del grafico por encima del cursor
Scale level [Nivel de escala] — escala el nivel actual con un término arbitrario (diferencia en dB)
LF box diffraction [Difraccién de caja en bajas frecuencias] — Escala los niveles con la respuesta de la
difraccion en bajas frecuencias de la caja del altavoz
Subtract overly [Restar superposicion] — resta los niveles del grafico de superposicion del grafico actual
Subtract from overlay [Restar de la superposicidn] - resta niveles del grafico actual de la superposicion
Power average with overlays [Compensacion de potencia con superposiciones] — hace que la
magnitud actual sea la compensacion de potencia de la magnitud actual y las magnitudes de las
superposiciones visibles y elimina todas las superposiciones que se muestran de manera opcional.
Merge overlay below cursor [Fusionar la superposicién por debajo del cursor] — fusiona los valores
de la superposicion de la curva actual por debajo del cursor
Merge overlay above cursor [Fusionar la superposicién por encima del cursor] — fusiona los valores
de la superposicion de la curva actual por encima del cursor

Los elementos 'Corte por debajo del cursor’, "Corte por encima del cursor' y "Nivel de escala’ se
usan normalmente para combinar dos graficos, uno para la respuesta de frecuencia alta y otro para la
respuesta de frecuencia baja.

Lo mismo se puede hacer con el comando ‘“Merge’ [Fusionar]. En este caso, la curva resultante se
puede exportar en formato de archivo ASCII (Magnitud + Fase).

El elemento de ment 'Nivel de escala’ abre un cuadro de dialogo (Tlustracion 6,10) en el que el
usuario introduce un nivel arbitrario (en dB) para escalar la respuesta de magnitud. Esta operacion no

cambia la respuesta de impulso. Solo cambia la respuesta en frecuencia que se estd mostrando
actualmente.

Scale Magnitude x|

Enter value in dB to scale magnitude

| 6 dB
Cancel | QK I

llustracion 6.10 Cuadro de dialogo 'Magnitud de Escala'

Los elementos de ment Subtract overlay [Resta superposicion] y Subtract from overlay [Resta de
la superposicion] se puede usar para obtener la diferencia entre dos respuesta (es decir, la calibracion
de la respuesta de microfonos con la otra calibrada). Después de estas operaciones la curva de
superposicion se hace invisible.

Los elementos de menti Power average with overlays [Compensacidn de potencia con
superposiciones] permiten crear un nuevo grafico de magnitud activo que sea la compensacion de
potencia de la magnitud activa mas las magnitudes de las superposiciones existentes El usuario
selecciona si las superposiciones actuales se borran después de esta accion.

Nota: Las operaciones Resta, Fusion y potencia se pueden efectuar solo si se ha obtenido la curva
actual y las superposiciones visibles a partir de respuestas de impulso que tengan la misma frecuencia
de muestreo y el mismo tamafo de FFT.

6.1.6 Escala de difraccion de caja del altavoz en baja frecuencia

El elemento de menu 'LF box diffraction’ [Difraccidn de caja en bajas frecuencias] abre el cuadro
de dialogo (Ilustracion 6,11). En este cuadro de dialogo el usuario introduce la forma de la caja
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(esférica, cuadrada o rectangular), el ancho y la altura de la caja del altavoz. Estos valores se usan para
definir la funcion de transferencia de graduacion W(f) que se usa para estimar la respuesta en campo
abierto para la respuesta del altavoz que se mide montado en una caja infinita (en el campo cercano).

x

Box form ISpherical j

Baffle width {cm) 30

Baffle height (cm) | 50

| 1

Cancel | a

lHustracion 6.11 Cuadro de dialogo 'Difraccion de caja en bajas frecuencias'

ARTA usa la siguiente expresion para la funcion de transferencia de graduacion de difraccion en bajas
frecuencias.

W(f)= 1+j.f/f0

2+ /1,
siendo fo =42.7 /d para una caja esférica de diametro d, o fo=34.16 / d para una caja cuadrada con un
ancho d. Estos valores se obtienen aplicando numéricamente la funcion de transferencia W(f) con una
funcion de transferencia de una caja de altavoz esférica. Esta funcion de transferencia se llama
también ecualizador 2m/4n puesto que da la diferencia entre la respuesta de un altavoz de baja
frecuencia a media esfera (270) y la respuesta en el espacio completo (4r). Para una caja rectangular,

con un ancho de caja w y alto h, ARTA usa —como aproximacion —una caja cuadrada equivalente de
ancho d = w (h/w)"".

La Ilustracion 6,12 muestra un ejemplo de la respuesta de altavoz de campo cercano medida (curva
superior) y la respuesta en campo abierto estimada (curva inferior). A unas frecuencias muy bajas, la
diferencia de nivel es de 6dB.

FR Magnitude dB Y/ (smoothed 112 oct)

' A

Do 1 | S RS N A VS S S U S S S R
el el Tt g T Ny T
15.0 A

—_—
d =)
[=) [=)
1
1
1
1
1
J
1
J
1
1
]
JERN R J—— Y

==t ===

GOf------1-4f-4-4-4 B et LR e e E R e Py L e
sof I R S i SRS .
GO - fuf Lol _E _____________________ % __________________________
SAS0F---FF-t-ma-A --------------------% -------------------------
200b-FF-r-1-Faan _E _____________________ % _____________________ f[__
-25.0 ’ ’ L.
100 1000 10000
Curzor: 202 Hz, -32.53 dB Frequency (Hz)

lustracion 6.12 Respuesta de altavoz en campo cercano (curva superior) y la respuesta ecualizada
27/4n (curva inferior).
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6.1.7 Medicion repetida

Cuando esté en una ventana de respuesta de frecuencia suavizada o DFT, el usuario podra repetir la
medicién ejecutando el comando de menu ‘File > Repeat PIR measurement’ [Archivo > Repetir la
medicion PIR]. Este comando abre el cuadro de didlogo para medicion de PIR. Después de la
medicion, la respuesta de frecuencia se calcula automaticamente usando el tamafio FFT, la posicion
del cursor y del marcados desde la ventana PIR.

Una tecla de acceso directo til para repetir rapidamente la medicion es pulsar Alt+R dos veces.

La respuesta de impulso se puede guardar ejecutando el comando de menu File > Save PIR as...'
[Archivo > Guardar PIR coma].
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6.2 Respuesta de etapa

La respuesta de etapa se calcula como la integral de tiempo de la respuesta de impulso. La inspeccién
de la respuesta de etapa es valiosa para supervisar el comportamiento del sistema de bajas frecuencias
y para la alineacion de tiempo de los altavoces en cajas de multiples altavoces.

ARTA muestra la respuesta de etapa en una ventana de tiempo independiente. Obtenemos una
ventana haciendo clic sobre ‘Analysis > Step Response’ [Analisis > Respuesta de etapa] o

. . STEP
sobre el icono de la barra de herramientas F=! .

La Ilustracion 6.13 muestra un ejemplo de la respuesta de etapa en un sistema GSM. La oscilacion
transitoria con el periodo 3.5 ms es habitual para el filtro de entrada del canal de voz a 300 Hz.

i x

File Edit

Step response Myt

260 056 & | Cffset
~ Nulll
130,478

Gain
// s Maxl

0000 u.l'l. — — L S ¥ T, =" =T —
\ \‘ / N ~| Min
120478 l ) Zoom
| Al |

260 956 —
* | Max
Scroll

17.25 2280 2775 22.00 3225 ms

Cursor: 112287 m\, 20.750 ms (332) pate:  3.500 m= (55) ;I—PI

lustracion 6.13 Ejemplo de la respuesta de etapa en el sistema GSM

Los controles del panel derecho son los mismos que en las ventanas de la respuesta de impulsos o de
registro de tiempo. Los comandos de menu permiten almacenar la respuesta de etapa en un archivo de
texto (File > Export ASCII [Archivo > Exportar a ASCII]), guardar el mapa de bits del grafico al
portapapeles (Edit > Copy [Edicién > Copiar]) y cambiar el color del fondo del grafico (Edit > B/W
background color [Edicion > Color de fondo B/N]).

Podra determinar o borrar el marcador con un clic sencillo o doble del boton derecho del raton.
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6.3 Envolvente de respuesta de impulsos (ETC — Curve Energia Tiempo)

En las mediciones acusticas, para controlar los reflejos de la sala y la reverberacion, es util analizar la
envolvente de la respuesta de impulsos — también denominada la Curva Energia Tiempo (ETC).

La envolvente de la sefial x (t) es una envolvente de los valores absolutos de la senal.
Matematicamente, se define como una magnitud de una sefial analistica X (t) +j X(t), con la

expresion:

e =[x +x2m)]"7,

Donde X(t) es la transformada de Hilbert de la funcion x(t),
X

R(t) = H{x(t)} = —% jgdr :%x(t) ®%.

La transformada de Hilbert es una circunvolucion de X(t) y 1/(at). Una forma mas simple de obtenerlo
es con la multiplicacion en el dominio de la frecuencia:

X1 =F'{ jsen(@)X (jo)}= F'{~ jsgn(@)F{x1)}},
lzaw>0
Donde: sgn(w)=<0zaw=0, F{it} =—jsgn(w)
-lzaw <0 g
En ARTA, obtenemos la envolvente de la respuesta de impulso en una ventana independiente

haciendo clic sobre el elemento de menu ‘Analysis > ETC’ [Analisis > ETC] o haciendo clic sobre el

ETC
icono de la barra de herramientas . La Ilustracion 6.14 muestra el ETC de la respuesta del
altavoz. El cursor se coloca en la posicion del primer sonido directo y el marcador se encuentra en la
posicion del primer reflejo fuerte.

Elmpulse response envelope (ETC) = |nlﬁi

Edit
Impulse response envelope (dB) dB range
0.0 T T
| [0 =]
50
| Windaow
0.0 -
E\? | [Speech =]
16,0 |
-20.0
250 !
300 J 1 s
250 . ﬂ All
4510 1 | LN I L w ¥ _Slil
v i i ¥
0,00 15.87 3150 47 33 83.17 ms
Cursor: 0.000 dB, Z.500 ms (1200 Gate: S5.66T ms @2TI) I

llustracion 6.14 Envolvente de la respuesta de impulso (ETC) de una respuesta de altavoz

La parte derecha de la ventana tiene los siguientes controles:

dB range [Gama dB]
- establece la gama de magnitud
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Ventana: - elije el tipo de ventana: Uniforme, Half-Hann, Habla, Causal
Zoom - establece el factor de zoom horizontal a Max o Todos.
Scroll [Desplazarse] - mover el grafico de izquierda o derecha

Sélo hay un subment ‘Edit’ [Edicion] — con elementos:

Copy [Copiar] — copia el mapa de bits del grafico al portapapeles

B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
Set marker [Establecer marcador] - establece un marcador en la posicion del cursor
Delete marker [Borrar marcador] - borra el marcador

Notas:

La mayoria de los sistemas de medicion usan la notacion ETC (Curva Energia Tiempo), pero
preferimos el nombre de envolvente de respuesta de impulso. El nombre ETC lo puso Richard Heyser,
que observo que la ortogonal de los componentes de la sefial analistica es analoga al intercambio de la
energia potencial y cinética en las ondas actisticas. Su conclusion no tiene justificacion tedrica puesto
que los componentes analisticos generan la funcion no causal mientras que la energia ha de ser una
funcidn causal.

Para obtener una curva ETC maés cercana a la funcion causal, ARTA podra aplicar las siguientes
ventanas a los datos del dominio de la frecuencia:

e Ventana Half-Hann — de uso general (ligera supresion de frecuencia extremadamente bajas y
altas),

e Ventana de habla — se usa para mejorar la gama hablada (suprime las frecuencias altas y
bajas),

e Ventana causal — se usa si la respuesta de impulsos se obtiene con la excitacion MLS.

e Uniforme — se usa sin ventana

6.4 Deterioro espectral acumulado

Una tarea muy importante en el analisis de los sistemas de altavoces es la deteccion de resonancias.
Una funcioén de frecuencia-tiempo denominada Deterioro Espectral Acumulado que ayuda
enormemente a detectar las resonancias.

El deterioro espectral acumulativo se define como una funcion frecuencia — tiempo.

e, f)::Th(r)u(r—t)ejz”der

Donde h(t) es la funcion de respuesta de impulso y u(t) es la funcion de etapa de la unidad

Realmente C(t, f) es una transformada de Fourier de la parte de la respuesta de impulse definida a
partir del tiempo 7=t hasta el infinito, tal como se muestra en la [lustracion 6.15. Una aplicacion
repetida de la Transformada de Fourier, cada vez para una parte de la respuesta de impulso que esté
por delante en el tiempo de un intervalo dt, obtendremos la funcion frecuencia-tiempo como en la
Ilustracion 6.16. Para estimar la Transformada de Fourier, ARTA usa el DFT y sustituye la funcion de
etapa de la unidad por una funcion de ventana de longitud finita. Para evitar el corte abrupto de la
respuesta de impulso con la ventana rectangular, ARTA aplica una ventana que sube y baja
gradualmente (el usuario elige el tiempo de subida de 0,02 a 1ms).
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lHustracion 6.16 Deterioro espectral acumulado en el sistema GSM

ARTA muestra el Deterioro Espectral Acumulado en una ventana independiente, pero primero se han

de establecer algunos parametros para la transformada tiempo-frecuencia. El comando de menu

'Analysis-Cumulative spectral decay’ [Analisis-Deterioro espectral acumulado] abre el cuadro de

dialogo ‘Configuracion del deterioro espectral acumulado’ (Ilustraciéon 6.17). El Deterioro espectral

acumulado aparece después de pulsar el boton ‘OK”.

Cumulative Spectral Decay Setup

— iz

~FFT

¥ Log frequency axis

¥ Remove antialiazing range

dB range [10 - 60 dB] I25

FFT zize 256 -

Wwindow rize time [0.02-1ms] (0.2

— Time zlice

tdas. number af time slices IE':I

— Smoathing

[~ Smoathing |1£3 vI octave

Slice zhift [zamples) |2

Drefault Cancel | k. I
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lustracion 6.17 Cuadro de dialogo de configuracion del Deterioro espectral acumulado

El cuadro de didlogo tiene los siguientes controles:

Seccidn Axis [Eje]
Log frequency axis [Eje de frecuencias logaritmicas] — active esta casilla para usar el eje de frecuencias
logaritmicas. Si no se activa se usara el eje lineal.
Remove antialiasing range [Eliminar gama antisolapamiento] — active esta casilla para eliminar los
depositos espectrales cercanos a fs/2,
dB range [Gama dB] - introduzca la gama dinamica en dB.

Seccion Smoothing [Suavizado]:
Smoothing [Suavizado] — active esta casilla para seleccionar un suavizado de 1/n octava de la magnitud

del espectro.
Octave [Octava] — elija 1/1, 1/2, 1/3, 1/6, 1/12 o 1/24 octava.

Seccion FFT:
FFT size [Tamafio FFT] - elija el nimero de muestras de un bloque FFT
Window rise time [Tiempo de subida de ventana] — introduzca el intervalo de tiempo entre el principio
y el fin de la ventana de tiempo, en la que se aplicara la ventana Blackman4.

Seccién Time slice [Fraccion de tiempo]:
Max. number of time slices [Nimero méaximo de fracciones de tiempo] — introduzca el nimero
maximo de ventanas de tiempo movidas.
Slice shift — introduzca el cambio de ventanas de tiempo, en niimero de muestras

El boton ‘Default’ [Defecto] restablece los valores por defecto.
El boton ‘OK’ activa la vista grafica CSD.

El espectro de deterioro acumulado puede dibujarse como un grafico en cascada o como un
sonograma. Las curvas del grafico en cascada se dibujan con distintos colores dependiendo de la
magnitud. El sonograma es un grafico de una funcioén cuya magnitud esta expresada por la cantidad y
orden predefinido de colores, lo que se denomina paleta (Ilustracion 6.19). El uso de una paleta con
una pequeiia cantidad de colores discretos mejora las curvas en el plano de color (Ilustracion 6.20).

La Ilustracion 6.18 muestra un grafico de cascada coloreada de CSD obtenida de la respuesta de
impulsos de los auriculares AKG 240.

E Cumulative Spectral Decay (AKG-K240-L.pir) - |EI|£|
Edit
Cumulative Spectral Decay (smoothed 1/3 actave)
dB
5.0
-12.0
-18.0
-24.0
300 K
200 500 1k 2k 5k 10k 20k
Frequency (Hz)
Palette IJel j |3|:I ::ll Copy
Lolored ' atertall W Lontaured [~ Fiange(dg) B | /
24

lustracion 6.18 E1 CSD mostrado como grafico de cascada coloreado
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La ventana CSD (Ilustracion 6.18) dispone de diversos controles para realizar la manipulacion del

grafico.

Caja combinada Mode [Modo] — elija entre tipo de grafico de cascada o sonograma.
Caja combinada Palette [Paleta] — elija entre varias paletas de colores (Azabache, Gris, Cobre y

Frio).

Colored Waterfall [Cascada coloreada] — active esta casilla para elegir entre un grafico de

cascada coloreado (o son un solo color).

Contoured [Contorneado] — active esta casilla para elegir entre un cambio de color gradual o

contorneado (vea las Ilustraciones 6.19 y 6.20).

Control de efecto Rango (dB) - cambia el rango dinamico del rango de 5 a 70dB.

Boton Copy [Copiar] — copia el grafico actual al portapapeles

Boton B/W [Blanco y negro] — cambia el color de fondo del grafico entre blanco y negro.

Cumulative Spectral Decay

ms 0 - -0.0dB

0.45 - -3.0

0.50 6.0

1.35 - -8.0

1.80 120

224 - -15.0

2,89 -18.0

3.14 -2

3.50 -24.0)

4.04 270

4.49 -30.0

200 500 1k 2k Sk 10k 20k
Freguency (Hz)
lustracion 6.19 CSD como sonograma
Cumulative Spectral Decay
mz 0 A -0.0 dB
0.45 R -3.0
0.50 1 5.0
1.35 4 -5.0
1.80 -12.0
224 1 -15.0
289 - -18.0
3.14 -21.0
3.59 240
404 =270
4.49 I -30.0
200 00 1k 2k Sk 10k 20k
Frequency (Hz}

lustracion 6.20 CSD como sonograma contorneado
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7 Estimacion de los parametros acusticos de la sala

Todas las salas afnaden ecos y reverberacion al sonido "directo" original. El eco es una caracteristica
no deseable de la sala, se puede detectar facilmente con la curva ERC. La reverberacion puede
aumentar la percepcion del sonido, provoca cierto incremento de volumen y una implicaciéon musical,
pero también tiene un efecto nocivo sobre la localizacion de la fuente y la inteligibilidad del habla.

Para estimar adecuadamente las caracteristicas acusticas de la sala, el ISO 3382 define varios
parametros acusticos de la sala que se muestran en la Tabla 7.1. Este estandar también define métodos
para estimar estos pardmetros a partir de la respuesta de impulso medida. ARTA sigue métodos de este
estandar de forma parcial y nos da la estimacion de cinco parametros: Tiempo de reverberacion,
tiempo de deterioro temprano, tiempo central, claridad y definicion.

Simbolo de cantidad Aspecto subjetivo

Tiempo de reverberacion Teo, T30, T20 (s) Reverberacion, volumen, implicacion
Tiempo de deterioro temprano EDT (s) Reverberacion, claridad

Tiempo central Ts (s) claridad

claridad Cgo (dB) claridad

definicion Dsg (%) Definicion del habla

Fuerza G (dB) Nivel relativo

Fraccion de energia lateral Lr, LEF (%) Impresion espacial

Correlacion cruzada interaural IACC Impresion espacial

Tabla 7.1 Resumen de los parametros actsticos generales de una sala (ISO 3382)

El parametro mas importante de la sala es el tiempo de reverberacion - T, Se define como el
intervalo de tiempo necesario para que la energia sonora se deteriore 60dB una vez que se ha detenido
la excitacion.

Para obtener el tiempo de reverberacion, necesitamos medir o estimar la curva de deterioro de energia

una vez que se haya desconectado la fuente de sonido. La curva de deterioro de energia es irregular y
ruidosa r(t) que solemos aproximar con el deterioro lineal, tal como se muestra en la Tlustracion 7.1.

r (dB)

0L

=20

dr

- 40
“ w
- 6l
0 '.I';:‘D i (=)

lHustracion 7.1 Curva de deterioro de energia para una fuente de sonido que se desconecta a t=0.

El tiempo de reverberacion se determina con la pendiente del deterioro lineal, de la siguiente forma:

dt
T, =60—
60 dr

ISO 3382 define:
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T es el tiempo de reverberacion determinado a partir de la pendiente media de la curva de deterioro
de energia obtenida a partir de parte de la curva de deterioro entre -5dB y -25dB.

T3 es el tiempo de reverberacion determinado a partir de la pendiente media de la curva de deterioro
de energia obtenida a partir de parte de la curva de deterioro entre -5dB y -35dB.

7.1 Curva de deterioro de energia

Schroeder ha demostrado por medio de analisis estadisticos que el deterioro de energia medio de la
sala r(t) se puede obtener a partir de la integrada regresiva del cuadrado de la respuesta de impulso.
Usamos la expresion de Schroeder:

r{t) = T h*(c)dz

En su forma logaritmica normalizada mas habitual:

[yt
10logr(t)=10log) +——

[ ()t

Tenga en cuenta que en esta expresion, el denominador representa la energia total.

En ARTA, obtenemos la curva de deterioro de energia haciendo clic sobre el elemento de menu
‘Analysis > Energy Decay' [Analisis > Deterioro de energia] o haciendo clic sobre el icono de la

. REU
barra de herramientas =5

La Ilustracion 7.2 muestra la ventana de deterioro de energia con dos curvas. La curva superior es la
curva de deterioro de energia, y la curva inferior gris es la envolvente de la respuesta de impulsos.

ISO 3383 recomienda el analisis del deterioro de la energia en seis bandas 1/1 octava (125 Hz, 250Hz,
500Hz, 1kHz, 2kHz y 4kHz). ARTA permite medir los parametros acusticos en dos bandas
adicionales: 62,5Hz y 8kHz. Para obtener esto, ARTA filtra la respuesta de impulsos con filtros de
bandas de octava de clase [ IEC. La misma norma recomienda que durante las mediciones:
e Laposicion del microfono ha de estar al menos a 1 m de las superficies reflectantes y no
demasiado cerca de ninguna fuente; la distancia minima desde la fuente se puede calcular con

la ecuacion:
\Y
A =24/— [m
min CT [ ]

Donde: V es el volumen de la sala, ¢ la velocidad del sonido, T es una estimacion del tiempo
de reverberacion esperado.

e La fuente de sonido deberia ser tan omni-direccional como sea posible.

¢ El micréfono ha de ser omni-direccional.

También es importante que el ciclo pre-compensacion de las mediciones con un ruido periddico o con
MLS sea mayor al tiempo de reverberacion.
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llustracion 7.1 Ventana de deterioro de energia La curva superior es la curva de deterioro de energia,
y la curva inferior es la envolvente de la respuesta de impulsos.

Los controles de la derecha se usan para configurar el grafico y estimar los parametros acusticos de la
sala, de la siguiente forma:

Filtering [Filtrado] elija la frecuencia de una respuesta filtrada en bandas de octava o la respuesta de banda
ancha.
dB range [Gama dB] — introduce la gama de magnitud
T60 — inicia los calculos de los parametros acusticos, el valor de los cuales se indica en la parte inferior de la
ventana.
Noise Tail [Cola de ruido] presenta dos controles. En el primer control se elige el porcentaje de la curva de
deterioro que se estima como ruido. El otro control se usa para elegir el método de reduccion de ruido:
Trunc — quiere decir que no se incluira el porcentaje de la cola de la curva en la estimacion del
deterioro.
Sub — quiere decir que el nivel medio de potencia de ruido de cola se resta de la curva de deterioro.
Log [Registro] — se obtiene un informe de los parametros actsticos de la sala que se han calculado.
Zoom - establece el factor de zoom horizontal a Max o Todos.
Scroll [Desplazamiento] — mueve el grafico de izquierda o derecha

ARTA necesita cierta interaccion por parte del usuario para estimar el deterioro de energia y los
parametros actsticos adecuadamente. El usuario ha de estimar el porcentaje de la cola de la curva ETC
en la que el ruido es el principal contribuyente, y el método para reducir ese ruido.

El método mas simple para reducir el ruido es truncar la respuesta de impulso. ISO 3382 sugiere
definir un punto de truncamiento como el punto en el que el nivel de la sefial + ruido es 5dB superior
al nivel medio de ruido de la cola de la respuesta de impulsos. En ARTA el punto de truncamiento se
determina como el porcentaje de la cola de la respuesta de impulsos que esta detras de dicho punto de
truncamiento.

Hay dos métodos para reducir el ruido:
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e Me¢étodo Trunc — trunca (elimina) la cola del ruido de la estimacion del deterioro de energia

e Método Sub — resta el valor medio de potencia de ruido de cola con la integracion de
Schroeder.

La Ilustracion 7.3 muestra el caso en el que se trunca el 40% de la cola de ruido de la estimacion del
deterioro de energia.

Un criterio que se puede usar para validar la estimacion es: en una sala sencilla no acoplada, el
deterioro de energia logaritmico deberia tener un deterioro lineal.

EEnergy decay - |I:I|5|
Edit
Filtering
Energy decay (dBb
oo S D [Tt =]
ool R
S12.00 Jk]l Maise T ail
2.0 i LI
240 ITrunu: vI
Jd_ 1
I I dB range
6.0 W* { B0 T
420 4
l'{' Log
-42.0 | |
Z00fm
-54.0
AN N
0.00 407 .31 215 63 1223 .44 163125 ms j ﬂl
Cursor: -5.099 dB, 95.156 ms Diff: 30316 dB, 910781 ms S crall
| f=1000Hz, TEO=1.874 s [r=-0.999), EDT=1.162 &, CBO=4.33 dB, CA0=214 dB, DE0=621 %, Tz=89.3 ms 4 I * I
4

lustracion 7.3 Ventana de deterioro de energia La curva superior es la curva de deterioro de energia
con el 40% de la cola de ruido eliminada (truncada) de la estimacion del deterioro, y la curva inferior
gris es la envolvente de la respuesta de impulsos.

Los parametros acusticos se estiman a partir de la curva de deterioro de energia.

El usuario ha de elegir una parte mas o menos lineal de la curva de deterioro y fijar el cursor y el
marcador en esa parte de la curva. Segin ISO 3382, el cursor deberia estar cerca del nivel -5dB,
mientras que el marcador deberia estar detras de la posicion en la que el nivel es 30dB por debajo del
nivel del cursor (o al menos 20dB). Si el nivel de deterioro en la posicion del marcador es inferior a -

25dB, ARTA estima T, y si el nivel de deterioro en esa posicion es inferior a -35dB, ARTA también
estima Ts.

Haga clic sobre el boton "T60" para obtener la estimacion del tiempo de reverberacion y otros
parametros acusticos.

Para obtener el tiempo de reverberacion la curva de deterioro se aproxima con una ecuacion lineal y =
ax +b y se estima la pendiente de la curva mediante la regresion lineal. La curva a que mejor se
ajusta y los valores b polarizados se evaltian con el método de los minimos cuadrados. La calidad de
la estimacion ajustada a la linea que se produce con la regresion lineal se describe con el coeficiente de
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correlacion r. El coeficiente de correlacion tiene el rango [-1,1] en la que una alta correlacion produce
unos valores cercanos a la unidad.

El mismo procedimiento se deberia repetir para cada respuesta filtrada en bandas de octava y para la
respuesta en banda ancha.

ARTA memoriza los valores de los parametros actsticos estimados, de forma que cuando se hace clic

sobre el boton 'Log' aparecera el informe de los valores de los parametros actsticos en todas las
bandas de octavas.

7.2 Informe de parametros acusticos de la sala

Haga clic sobre el boton 'Log' para obtener el informe de medicion en el cuadro de dialogo
'Acoustical parameters' [Pardmetros acusticos] que aparece en la Ilustracion 7.4

Acoustical Parameters x|

ROOM ACOUSTICAL FARAMETERS

WideBand 125H= 250Hz= 500H= 1000H= 2000H= 4000H= £000H=
Teld (3} 2.002 2.053 1.5827 1.887 1.7a0 1.591 1.98 3.108
regr -0.995 -0.992 -0.9948 -0.9 -0.997 -0.9393 -0.9688 -0.940
T30 (3) 1.38 2.171 1.5599 1.748 1.721 1.343 1.272 £.057
regr. -0.993 -0.994 -0.397 -1.000 -0.3997 -0.994 -0.987 -0.903
T20 (3} 1.457 2.267 2.06% 1.725 573 2048 0.954 0.871
regr. -0.994 -0.994 -0.995 -0.9939 -0.9594 -0.9598 -0.952 -0.9848
EDT (3) 1.170 1.3545 1.514 1.42 1.193 0.87%9 0.743 0.007
C20 (dB) 8.423 1.349 2.398 1.714 5.3530 g.0a0 13.148 15.55%9
C50 (dB) 6.878 0.365 1.107 -0.454 3.438 5.218 10.007 15.804
D50 (%) 82.973 52.093 56.3348 47.390 68.820 T6.878 90.923 97.4359
Iz (m3) 3l.4 110.7 90.1 91.3 5l.%9 33.5 13.2 4.8

Decimal separator I.j.;.t () vI Save (L.csv) | Copy I QK

lustracion 7.4 Informe de los parametros acusticos de la sala.

En la parte inferior de la ventana, hay tres controles:

Boton Copy — para copiar el informe al portapapeles,

Boton Save (.csv) — para guardar el informe en formato .csv de Excel.

Cuadro desplegable Decimal separator — sirve para establecer el punto o la coma como separador decimal en
el archivo .csv.

La definicion de los parametros actsticos es la siguiente:

EDT

Tiempo de deterioro temprano (EDT) se define como el intervalo de tiempo necesario para que la
energia sonora se deteriore 10dB una vez que se ha detenido la excitacion. Para permitir una
comparacion directa con el tiempo de reverberacion, el resultado se multiplica por 6 El deterioro
exponencial idoneo en un campo difuso, el valor de EDT esperado seria igual a Tg.
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Claridad

La claridad o "indice temprano a tarde" Cgy (Csg) se define como la relacion logaritmica de la energia
de la respuesta de impulso antes del tiempo te, y la energia después de te. El valor te = 50ms se usa
para expresar la claridad del habla, mientras que t. = 80ms sera mas apropiado para la muisica.

80ms 50ms
[yt [ >yt
Cg =10log——— dB Cs =10log—2—— dB
[ o>yt [yt
80ms 50ms

El nombre original en aleméan para el término claridad es "klarheitsmass". Unos altos valores de
claridad indican una gran cantidad de energia temprana, que corresponde con una sensacion subjetiva
de claridad. Por el contrario, unos valores de claridad bajos indican que el sonido no es claro, y es
excesivamente reverberante.

Definicion
La Definicion Dsg o "relacion de energia sonora temprana a total" es una medida de la definicion del
habla. También se conoce por su nombre aleman, Deutlichkeit. Se define como:

50ms

j h(t)dt
D, =100 *— (%)

j h? (t)dt

TS-Tiempo central
El tiempo central TS se corresponde con el centro de gravedad del cuadrado de la respuesta de
impulso:

j t-h?(t)dt
TS=2——
j h(t)dt
0
Los limites superiores de integracion se consideran los puntos de truncamiento, o el final de la
respuesta de impulsos, dependiendo de la opcion de tratamiento de ruido especifica.
El subindice S en el nombre TS es la abreviatura del nombre aleman Schwerpunktzeit. El valor de TS
se expresa en milisegundos. Un TS bajo sugiere una sensacion de claridad, mientras que un valor TS

alto sugiere un sonido reverberante.

TS estd muy correlacionado con EDT (rara vez contiene alguna informacion adicional si lo
comparamos con EDT).
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8 Inteligibilidad del habla

8.1 Funcion de transferencia de modulacion (MTF)

La reverberacion y el ruido degradan la modulacion del habla en las salas reales. Houtgast y Steeneken
han determinado que la modulacion del habla natural se encuentra en la gama de frecuencias de 0,5 a
12,5 Hz.

La Funcioén de Transferencia de Modulacion (MTF) es una funcidén que muestra como el sistema
degrada la modulacion del habla en dicha gama de frecuencias.

Si nos referimos a la [lustracion 8.1 podremos definir simplemente que MTF es la relacion entre el
indice de modulacion en la salida del sistema m, con el indice de modulacion en la entrada del sistema
m;.

1F 1F
] [ ]
Input . V\ Output

.= Moise and
teverberation

-~

Ti1+ m, cos 2xF1) o | To(1+ mgcos 2nF(t+ 1))

WATF [rnodmi)
1,0

0.8} ]
06 | 1
04 1
02

F (Hz)

llustracién 8.1 Tlustracion de la definicion de la Funcidn de Transferencia de Modulacion

Schroeder proporciond la expresion para estimar el MTF usando la respuesta de impulso de un
altavoz, que sera m(F):

j h(t)e 1> Fdt

0

‘ Thz(t)dt ‘

0

m(F) =

En la que F es la frecuencia de modulacion.

A partir de esta definicion, MTF es proporcional a la transformada de Fourier del cuadrado de la
respuesta de impulsos (el denominador, que representa la energia total, normaliza la expresion). Puesto
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que MTF también es dependiente del ruido, durante una medicion de la respuesta de impulso no
debemos usar la compensacion.

ARTA muestra el MTF para la respuesta de impulso filtrada en bandas de octavas en una ventana
independiente (Tlustracion 8.2) que se activa haciendo clic sobre el elemento de ment ‘Analysis >
Modulation Transfer Function' [Andlisis > Funcion de Transferencia de la Modulacion] o

. . . . HTF
haciendo clic sobre el icono de la barra de herramientas rﬂ'.

EMudulatiun Transfer Function =10 x|

Edit  Ockave

MTF mMagnitude - 1000 Hz
0o

[——

——

0.90
0.20
0.0
0.60
0.50
0.40
0.z20
0.z0
0.10
0.00

1 10
Cursar: 1.0Hz. 028 m modulation frequency (HZ

llustracién 8.2 Funcidn de transferencia de modulacion

El subment "Octave’ [Octava] se usa para configurar las bandas de octava, y el submenu 'Edit’
[Edicidn] se usa para copiar el mapa de bits del grafico al portapapeles y cambiar el color del fondo.

La funcion MFT se usa en métodos para la estimacion de la inteligibilidad del habla que se describen
en la siguiente seccion.

8.2 Indice de transmision del habla

La norma IEC-60268-16 define el método para estimar la inteligibilidad del habla y nos proporciona
un indice denominado STI — Indice de transmision del habla — que se acerca a la puntuacion subjetiva
de inteligibilidad. La misma norma define también un método simplificado para estimar la
inteligibilidad del habla denominado RASTI — indice de transmisién del habla rapido.

El STI analiza la funcion de transferencia de la modulacion con 14 frecuencias de modulacion (desde
0,63 Hz a 12,5 Hz, 1/3 octava aparte) y en siete bandas de octavas (desde 125Hz a 8kHz). El indice
STI se obtiene sumando y compensando el MFT tal como se describe a continuacion.

RASTI analiza sélo 9 frecuencias de modulacion (0.7Hz, 1Hz, 1.4Hz, 2Hz, 2.8Hz, 4Hz, 5.6Hz, 8Hz,
11.2Hz) en s6lo dos bandas de octava ( 500Hz y 2kHz )

El procedimiento para calcular el indice STI a partir de un MTF determinado es el siguiente:

1. Para todos los valores MTF m(F) una relacion sonido/ruido para la sefial de modulacion se define
como:

mi
1-m,

2. Los valores de X; estan limitados a £15

X, =10log( ),

95



ARTA User Manual

si X; >15 entonces X; =15,
si X; >-15 entonces X; =-15,

El método STI indica que la relacion sonido /ruido en la gama de frecuencias de -15dB a 15dB es
linealmente dependiente del indice de inteligibilidad en la gama de 0 a 1. Es por esto que la relacion
sonido/ruido se convierte en el indice de transmision — T1L.

Tl = X, +15
30

3. El valor medio de TI; para cada banda de octava (indice de transmision de octava —OTI) se define
con la siguiente ecuacion:
1 14
OTl,=— ) Tl,, n=12,..7
1445

4. Finalmente, el indice STI esta determinado por la siguiente ecuacion:

7 6
STl =Y a,0TI, - > B,,/OTI, xOTI,,,
n=1 n=1

En la que los factores ponderados oy y B estdn experimentalmente determinados para la voz
masculina o femenina (consulte la Tabla 8.1).

Frecuencia (Hz) | 125 | 250 |500 | 1000 | 2000 | 4000 | 8000
Cmaseuting 0.085 | 0.127 | 0.230 | 0.233 | 0309 | 0.224 | 0.173
B sasculing 0.085 | 0.078 | 0.065 | 0.011 | 0.047 | 0.095 | 0
fomenina 0 0.117 [ 0.223 [0.216 | 0.328 | 0.250 | 0.194
B femenina 0 0.099 | 0.066 | 0.062 | 0.025 | 0.076 | 0

lustracion 8.1 Factores ponderados para el habla masculina y femenina — IEC 60268-16.

Los valores STI se encuentran en la gama de 0 a 1. En la Tabla 8.2 se incluyen los correspondientes
indices subjetivos.

STI Indice subjetivo equivalente
0,0 < STI <0,3 Malo

0,3 < STI < 0,45 Pobre

0,45 < STI < 0,6 Suficiente

0,6 < STI < 0,75 Bueno

0,75 < STI < 1,00 Excelente

Tabla 8.2 STI - indices subjetivos equivalentes

El procedimiento anterior para estimar STI sigue la norma IEC 60268-16, salvo por la inclusion de
efectos de enmascaramiento en las bajas frecuencias.

La medicion del STI se ha de hacer con el siguiente procedimiento:
1. Colocar ARTA en Modo de Analisis Espectral.

2. Colocar el microfono a 1 m por delante de un altavoz pequefio, cuyo tamano se acerque al
tamafo de la cabeza de una persona. Excitar el altavoz con una sefial de habla PN.
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3. Ajustar la ganancia del amplificador de potencia para que obtenga una SPL =68dBA.
Controlar el espectro. Ha de tener los niveles de banda de octava que se determinan en la
Tabla 8.3 (si fuera necesario usar el ecualizador de frecuencia).

4. Colocar ARTA en el Modo de Respuesta de Impulso con una sefial de excitacion del tipo
Habla PN. El periodo del ruido periodico ha de ser mayor al periodo de la frecuencia de
modulacion mas baja. (es decir, mayor de 1/0,63Hz=1.58 segundos). Quiere decir que el
nimero de muestras en un periodo (longitud FFT) ha de ser mayor de 1,58F;. La Tabla 8.4 nos
indica la longitud FFT adecuada.

5. Hacer la medicion de la respuesta de impulsos sin la compensacion, en una posicion de
microfono arbitraria.

6. En la ventana de respuesta de impulsos active el comando de menu 'Analysis-STI" o haga
clic sobre el icono de la barra de herramientas.

7. Finalmente, ARTA generara un informe con los valores MTF, los valores OTI y los valores
STI, como en la Ilustracion 8.3.

Banda de octavas (Hz) 125 | 250 | 500 | 1000 | 2000 | 4000 | 8000
Ruido del habla masculina (dB) 971 9.7| 6.0 0.0| -6.0]|-12.0 | -18.0
Ruido del habla femenina (dB) -1 144 7.2 00| -67| -7.6 | -89

Tabla 8.3 Niveles de bandas de octava del ruido del habla (referidos a un nivel de 1kHz).

Fs (Hz) 48000 | 44100 | 32000 | 22020
Longitud FFT | 131072 | 131072 | 65536 | 65536

Tabla 8.4 Longitud de FFT adecuada para medir STI

El mismo procedimiento se usa para medir RASTI, con una diferencia en el paso 6, en la que el
usuario activa el comando de menu 'Analysis-RASTT'.

El método STI es aplicable a los sistemas de banda ancha lineal. No se puede usar para probar
vocoders, es decir, codificacion predictiva LPC, CELP y RELP en un GSM.
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Speech Transmission Index x|
APEECH TRANIMIZSTON INDEX - MTF Matrix _:J

0.63 0.3Z32 0.585862 0.2013 0.9215 0.9653 0.9855 0.9957
0.80 0.52Z82 0.58562 0.9013 0.9215 0.9653 0.9555 0.9957
1.00 0.6305 0.7901 0.8096 0.5433 0.9271 0.9684 0.9909
1.25 0.6305 0.7901 0.8096 0.5433 0.9271 0.9684 0.9909
l.e0 0.5378 0.7089 0.7326 0.7710 0.588935 0.9501 0.9853
£.00 0.5775 0.6435 0.6720 0.7033 0.58533 0.9334 0.979a6
£.50 0.6032 0.5969 0.6243 0.6573 0.583Z3 0.9192 0.9743
3.15 0.al55 0.5634 0. 55831 0.6110 0.5113 0.20a635 0.9634
4,00 0.5660 0.5159 0. 5464 0.52Z0 0.7751 0.&88568 0.9602
5.00 0.5z2z4 0. 4545 0.5214 0. 4465 0.74la 0.5687 0.9523
6.30 0.5205 0.4274 a %?69 0.3971 0.7153 0.5585 0.947%74
g.00 0.5586 0.4087 0.4195 0.3466 0.6786 0.8561 0.94335
1o.00 0.4133 0.3683 0.3633 0.3254 0.6534 0. 5450 0.937a
12.50 0.31350 0.3095 0.1995 0.2719 0.6435 0.5279 0.9237

ATI = 0.7188 (wmale), 0.7446 (female) Rating: GOOD [GOOD
[$ALcons=  3.6304)

Kl

Copy |

llustracién 8.3 Ventana STI

8.3 STl y %ALcons

Ademas de los indice STI para habla masculina y femenina, la ventana STI también muestra el valor
del indice de inteligibilidad del habla denominado %ALqns (Pérdida de Articulacion de Consonantes)
que ha sido definido por Peutz en sus trabajos experimentales. Se usa en la acustica arquitectonica con

el indice subjetivo equivalente que se indica en la Tabla 8.5

Indice de inteligibilidad subjetivo Pérdida de articulacioén de consonantes
(%)
Malo 100 < %ALcons <30
Pobre 30 < %ALons < 15
Suficiente 15 < %AL cons < 6,6
Bueno 6,6 < %AL cons <3
Excelente 0 < %ALcons <3

Tabla 8.5 Indice de inteligibilidad subjetivo y equivalente %ALcons

La relacion entre STI y %ALcons estd determinada por las siguientes ecuaciones:

%AL._ =170,5405-~>41°ST!

cons

STl =-0,1845-In(% ALcons) +0,9842
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lHustracion 8.4 %ALons como funcion de la relacion sonido/ruido y el tiempo de reverberacion (datos
experimentales para la posicion del oyente en el campo de reverberacion difuso).

El %AL¢ons se puede estimar a partir del tiempo de reverberacion medido Teoy de la relacion
sonido/ruido usando los datos experimentales de Peutz de la Ilustracion 8.4 si el oyente esta colocado
en el campo de reverberacion difuso). Si no es asi, si el oyente esta en el campo del hablante directo,

%ALons se puede estimar usando la expresion:

2 2 V D
%AL :20(51—[)1'60’ para d <0,2 /T—
60

En la que V es el volumen de la sala, D es la directividad del hablante, d es la distancia del hablante al
oyente. Esta formula se suele usar en célculos arquitectonicos, pero no tiene en cuenta la influencia del
ruido.

Tanto los indices de inteligibilidad del habla, STI y %ALcons, SON parametros acusticos de la sala
utiles. La comparacion con los indices de inteligibilidad subjetivos muestra que STI nos da una
estimacion dentro de + 5.6% del indice subjetivo, un resultado mejor que el 10% para %AL cons.
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9 Herramientas

Esta seccion describe las herramientas que ARTA afiade para la presentacion de resultados de
mediciones.

9.1 Patrones de directividad

9.1.1 Definiciones basicas

Beranek [44] nos da la siguiente definicion del patron de directividad: “El patrén de directividad de un
transductor empleado para la emision o para la recepcion de sonido es una descripcion que se suele
presentar graficamente, de la respuesta de los transductores en funcion de la direccion (angulo) de las
ondas de sonido transmitidas o incidentes sobre un plano especifico y de una frecuencia especifica.”
Matematicamente, el patron de directividad se suele expresar en funcion de la frecuencia y medicion

del angulo 9 fuera de eje en el plano horizontal o vertical. En ARTA se usan tres definiciones:

D pd, 9) r =const.
2) p(f, ) / p(f, 3=0) I =const.
3) p(f, 9) / pmax(f) I =const.

La primera definicion representa un grupo de respuestas en frecuencia para una distancia de medicion
constante r. La segunda definicion representa el grupo de respuestas en frecuencia normalizadas con
respuesta en frecuencias en el grado cero. Puede ser mayor de uno. La tercera definicion representa el
grupo de respuestas en frecuencia normalizadas con respuesta en frecuencia en un angulo en el que la
respuesta en frecuencia es maxima. Siempre es igual o inferior a uno. Estas tres definiciones se pueden
usar en ARTA para mostrar los graficos de patrones de directividad.

Normalmente, la magnitud de respuesta en el patron de directividad se muestra en la escala de nivel de
dB.

Ademas de la representacion grafica de las caracteristicas direccionales, se definen tres parametros de
directividad [44]:

1) El factor de directividad Q(f) es la relacion entre la intensidad en un eje determinado de un
radiador de sonido a una distancia I concreta respecto de la intensidad que se produciria en la misma
posicion por fuente de punto si estuviera radiando la misma potencia actstica total que el radiador.

2) El indice de directividad DI(f) se expresa en dB como resultado de la expresion DI =
10log(Q).

3) El &ngulo de ancho del haz de un patrén de directividad se define como el angulo entre dos
puntos a cada lado del eje principal (normalmente en el grado cero) en el que el nivel de presion de
sonido es inferior a 6dB desde su valor al grado cero.

9.1.2 Tipos de Patrones de directividad en ARTA

ARTA usa tres tipos de graficos para mostrar el patron de directividad del altavoz:

1) grafico en cascada
2) sonograma
3) diagrama polar

El grafico en cascada es un grafico tridimensional que muestra una serie de respuestas en frecuencia
medidas a una distancia constante pero en un angulo fuera de eje de medicion diferente. En la
Ilustracion 9.1 y la Ilustracion 9.2 se muestran la vista estindar y con giro del grafico en cascada. En
ARTA, las curvas de cascada se pueden dibujar con un solo color o en colores que representen la
magnitud de la respuesta conforme a una paleta de color determinada.
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La construccion del grafico de cascada es simple, s6lo necesitamos medir las respuestas en frecuencia
de los altavoces en angulos diferentes, y de forma opcional normalizar la respuesta con una respuesta
medida en el eje del grado cero.

Directivity pattern (smoothed 1/2 oct)

A
R
T
A
dbB
- -180.0
-3.0
-108.0
=0 F -36.0
5.0 36,0
-12.0
-15.0 TTTTT T T T TTTIT 120.0 deg

I
S0 100 200 00 1k 2k Sk 10k 20k
Frequency (Hz)

lustracion 9.1 Patron de directividad en cascada (normalizado a 0°)

Directivity pattern (smoothed 1/3 oct)

dB
-3.0
5.0
-5.0
=120

-15.0 20k
-180.0 -108.0 -36.0 356.0 108.0 180.0
deg

lustracion 9.2 Patrén de directividad en cascada con giro (normalizado a 0°)
El segundo tipo de grafico de patrén de directividad que se usa en ARTA es un sonograma.

El sonograma grafico bidimensional que muestra planos de color. En cada plano, el nivel de la
magnitud de respuesta se presenta como un valor del color de la paleta de colores predefinida.

La Ilustracion 9.3 muestra el sonograma con colores que cambian gradualmente, mientras que la
Ilustracion 9.4 muestra el sonograma contorneado con colores variables en tramos predefinidos.
Normalmente, el sonograma contorneado muestra los patrones de directividad mas claramente que un
sonograma gradual.
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Directivity sonogram
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lustracion 9.3 Sonograma de directividad

Directivity sonagram

deg

0 dB
-150.0 "é -1.5
-100.0 I =30
' 45
-50.0 I
0.0 s
50.0 =0
-10.5
100.0 20
150.0 -1
, —— T -15.0

100 200 500 k2K Sk 10k 20k

Frequency (Hz)

lustracion 9.4 Sonograma de directividad contorneado

El tercer tipo de patrén de directividad en ARTA es un diagrama polar. Muestra el patron de
directividad para una frecuencia sencilla en el sistema coordinado polar (Ilustracién 9.5). El fondo del
grafico muestra también el factor de directividad Q, el indice de directividad DI y el angulo del ancho
del haz para la frecuencia de corriente. Se asume que el altavoz radia a un espacio sin limites
(condiciones de campo abierto). Se pueden mostrar varios patrones de directividad polar en el mismo
grafico, como curvas de superposicion (como en la Ilustracion 9.6).
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Directivity pattern

f=1000Hz, @ = 234 D= 7.44dB, Angle(-5dB) =170.4°
lustracion 9.5 Diagrama polar

Directivity pattern

lustracion 9.6 Diagrama polar con superposiciones

Para la radiacion en la media esfera suele ser mas apropiado usar un diagrama semi-polar, como en la
Tlustracion 9.7.
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Directivity pattern

07/ Qads

f=1000Hz, @@= 234, DI= 3.7dB, Angle(-6dB)=171.5°

lustracion 9.7 Diagrama semi-polar

9.1.3 Creacion de Patrones de directividad en ARTA

En ARTA, los datos del patron de directividad se crean con archivos PIR que se miden a una distancia
constante del radiador. Estos datos se pueden almacenar en los archivos de patrones de directividad.
Esos archivos tienen la extension “.DPF”.

El archivo DPF se genera automaticamente en ARTa a partir de un conjunto de archivos PIR, que han
de guardarse todos en el mismo directorio con un nombre cuya forma predefinida es:

<name-prefix>_deg[+|-]<num>.pir
Donde:

<name-prefix> es el nombre comiin para todos los archivos .pir

_deg denota que los que le sigue es un valor numérico del angulo de medicion fuera de eje
<num> es un valor del angulo de medicion fuera de eje, opcionalmente precedida por el signo positive
0 negativo.

.pir es la extension de nombre para el archive PIR.
Por ejemplo,

Ls5_deg-30.pir

Ls5 deg-20.pir

Ls5 deg-10.pir

Ls5 deg0.pir

Ls5 degl0Q.pir

Ls5 deg20.pir

Ls5 deg30.pir
es un grupo de archivos PIR que se miden con angulos fuera de eje de -30 a +30 grados.
Para hacer el patron de directividad y el archivo DPF hemos de activar el comando de menu ‘Tools >
Directivity pattern’ [Herramientas > Patron de directividad]. Abre la ventana del “Patron de
Directividad” tal como se muestra en la Ilustracion 9.8.
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[&: Directivity pattern (Untitled.dpf) - O] x|
File Edit
Create directivity pattern file —Palar plot
Sawve directivity pattern file Frequency (Hz)

Load directivity pattern file

1000 _:I
Expart ASCII 1/3 octave daa

Expart ASCII 1/1 octave daa Overlay |

Expart Directivity Index and Angle(-6dE) —
Top div. =

File Info

0° =x0de [

ShowDI W

Thick line W

MndelF‘nIar-FuII 'I pa|EtE|Jet j |10| :II Cnpyl

Colored Waterfall [ Contoured [ Range(dE) B |

llustracion 9.8 Ventana del patrén de directividad
La ventana del ‘Patrdn de directividad’ dispone de un ment y varios controles.

Los comandos del menu son:

File [Archivo]
Create directivity pattern file [Crear un archivo de patron de directividad] — abre un
cuadro de diadlogo para crear un archivo de patron de directividad a partir de los archivos .pir.
Save directivity pattern file [Guardar el archivo de patréon de directividad] — guardar el
archivo de patron de directividad (.dpf).
Load directivity pattern file [Cargar el archivo de patron de directividad] — carga el
archivo de patrén de directividad (.dpf).
Export ASCII 1/3 octave data [Exportar datos ASCII de 1/3 octava] — exporta en valores
de archivo ASCII en frecuencias estandar de 1/3 octava.
Export ASCII & 1/1 octave data [Exportar datos ASCII1 y 1/1 octava] — exporta en valores
de archivo ASCII en frecuencias estandar de 1/1 octava.
Export Directivity Index and Angle (-6dB) [Exporta el indice y angulo de directividad (-
6dB)] — exporta en un archive DI, Q y el angulo en ASCII (-6dB)
File Info [Informacion de archive] — proporciona informacion y texto definido por el usuario
originaria del archive .dpf actual.

Edit [Edicion]

Copy [Copiar] - copia el mapa de bits del grafico y el texto definido por el usuario al
portapapeles

B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en
negro

Los controles inferiores de la ventana son:

Cuadro combinado Mode [Modo] — Selecciona entre el tipo de grafico cascadal, cascada2,
sonograma, diagrama polar, o semi-polar.

Caja combinada Palette [Paleta] — elija entre varias paletas de colores (Azabache, Gris, Cobre
y Frio).
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Colored Waterfall [Cascada coloreada] — active esta casilla para elegir entre un grafico de
cascada coloreado (o son un solo color).

Contoured [Contorneado] — active esta casilla para elegir entre un cambio de color gradual o
contorneado (vea las Ilustraciones 6.19 y 6.20).

Control de efecto Rango (dB) - cambia el rango dinamico del rango de 5 a 70dB.

Boton Copy [Copiar] — copia el grafico actual al portapapeles.

Boton B/W [Blanco y negro] — cambia el color de fondo del grafico entre blanco y negro.

Los controles del lado izquierdo de la ventana son:

Control de efecto Frecuencia — cambia la frecuencia del patrén polar actual a la siguiente
banda de octava estandar de 1/3

Boton Superposicion — abre el cuadro de dialogo del gestor de superposiciones.

0° => 0dB - active esta casilla para usar el patron de directividad con una magnitud
normalizada con el valor de la magnitud en el grado cero, si no se hace asi, el diagrama polar
muestra el patrén con una magnitud normalizada con un valor de magnitud maximo.
Contoured [Contorneado] — active esta casilla para elegir entre un cambio de color gradual o
contorneado (vea las Ilustraciones 6.19 y 6.20).

Show DI [Mostrar DI] — active esta casilla para ver el valor de los parametros de directividad
en el fondo del diagrama polar.

Thick line [Trazo grueso] — active esta casilla para usar una linea de trazo grueso.

El gestor de superposiciones del diagrama polar aparece en la Ilustracion 9.9. Es similar al gestor de
superposiciones de una ventana FR, aunque hay una diferencia significativa. Hay una ventana
emergente que se puede usar simultaneamente con los comandos de las ventanas del patrén de
directividad.

x

Frequency {Hz) | C... | -
1000
1250
1600
2000
2500
3150
4000
5000
§300
8000

=

|
Delete sel | Color |

Delete all | Update I

Replace sel | Add

lHustracion 9.9 Gestor de superposicion para el diagrama polar

Los botones de la ventana del gestor de superposiciones activan los siguientes comandos:

Add [Afiadir] — establece la curva actual como superposicion

Replace sel [Sustituir la seleccidn] — sustituye la superposicion seleccionada por la curva actual
Delete sel [Borrar la seleccidon] — Borra todas las superposiciones seleccionadas
Delete all [Borrar todo] — Borra todas las superposiciones

Color — cambia el color de los elementos seleccionados usando el cuadro de didlogo 'Overlay Colors’

[Colores de superposicion] que se muestra en la Ilustracion. 6.10.

Update [Actualizar] — actualiza las etiquetas del diagrama polar.

Haga clic con el raton sobre el elemento de la lista desplegable y sucedera lo siguiente:
Un solo clic - selecciona los elementos
Un solo clic sobre la casilla de verificacion — hace que sea visible o invisible la superposicion
Doble clic - permite editar el nombre de la superposicion
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El procedimiento para crear un archivo DPF comienza haciendo clic en el ment 'File > Create
directivity pattern file’ [Archivo > Crear un archivo de patron de directividad]. Abre el cuadro de
didlogo ‘Directivity data definition' [Definicion de datos de directividad] (Ilustracion 9.11).
Primero, hemos de pulsar sobre el boton ‘Load Files” [Cargar archivos] para obtener el directorio y
nombre principal de los archivos PIR. Asi se abre el cuadro de didlogo estandar para abrir archivos,
que se muestra en la Ilustracion 9.10. Después de seleccionar uno de los archivos, hemos de pulsar
sobre el boton ‘OK’. A continuacion se abrira el cuadro de dialogo 'Directivity data definition®
[Definicion de datos de directividad] tal como se indica en la Ilustracion 9.11.

open 2] x|
Look in: Ilﬂa-mhd j = =i ER-
MHD 152_deg-5. pir MHD 152_deg-80.pir MHD 152_deg+80.pir
e MHD 152 _deg 10.pir  [PelMHD152_deg 85.pir [ MHD152_deg 1 65.pir
MHD152_deg-15.pi- MHD152_deg-30.pir MHD152_deg+70.pir
MHD 152_deg-20.pi MHD 152_deg+0.pir MHD 152_deq+75.pir
MHD 152 _deg-25.pi- MHD152_deg+5.pir MHD 152 _deqg +30. pir
MHD152_deg-30.pir MHD152_deg+10.pir [“AMHD152_deg+85.pir
Desktop MHD152_deg-35.pi MHD152_deg+15.pir [dMHD152_deg+30.pir
MHD 152_deg-40.pir MHD 152_deg+20.pir
‘ MHD 152_deg-45.pic MHD152_deg+25.pir
MHD 152_deg-50.pic MHD 152_deg+30.pir
e s MHD 152_deg-55.pic MHD152_deg+35.pir
= MHD 152_deg-60.pir MHD 152_deg+40.pir
i_[ ] MHD152_deg-65.pic MHD152_deg+45.pir
— [l MHN 157 _deg-70.pir MHN157_deg+50. nir
My Compiter N .
MHD152_deg-75.pi MHD152_deg+55.pir
&
NS File name: IMHD1 £2_deg+5.pir j Open
Places
Files of type: | Pir Files {*pir) =] Cancel |

lustracion 9.9 Cuadro de dialogo estandar para abrir archivos
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Directivity data definition x|

To define directivity data load ", pir” files with names in form:

Load Files
<name>=_dea[+]-] <num=.pir |
Angle | Mame | Size | Folder -
] MHD'152_deqg+0.pir &4 KB C:\&rctaudio 1a-mhd'
10 MHD152_deqg+10. pir &4 KB C:\&rctaudio 1a-mhd'
15 MHD152_deqg+15.pir &4 KB C:\&rctaudio 1a-mhd' b
20 MHD152_deqg+20. pir &4 KB C:\&rctaudio 1a-mhd'
25 MHD152_deqg+25.pir &4 KB C:\&rctaudio 1a-mhd'
30 MHD152_deqg+30. pir &4 KB C:\&rctaudio 1a-mhd'
35 MHD152_deqg+35. pir &4 KB C:\&rctaudio 1a-mhd'
40 MHD152_deqg+<0. pir &4 KB C:\&rctaudio 1a-mhd'
45 MHD152_deqg+45. pir &4 KB C:\&rctaudio 1a-mhd'
5 MHD152_deq+5.pir &4 KB C:\&rctaudio 1a-mhd' -
1 | v
—Magnitude FFT analysis
smoothing I 1/3 oct vI i~ Ungated from estimated PIR maximum position

™ Ungated from FIR start position

@ Gated  Start (ms) | 7 Length {ms) | 3

User Info
Default |

Cancel |
] I

Mormalize to zero degree v

Symetrical for neg. angles W

—Freqguency range

Low {Hz) I 50

20000

Enter arbitrary user information!!!]

High (Hz)

lustracion 9.10 Cuadro de dialogo ‘Definicion de datos de directividad’

Antes de pulsar sobre el boton 'OK’ que confirma el proceso de generar datos del patron de
directividad, hemos de configurar los pardmetros de creacion de datos usando los siguientes controles:

Seccion Magnitude [Magnitud]:
Cuadro combinado Suavizado — elija el suavizado de la respuesta en frecuencia de 1/1 octava
a 1/12 octava.
Normalize to zero degree [Normalizar al grado cero] — active esta casilla para hacer que las
respuestas del patron de directividad se normalicen con una respuesta en el grado cero.
Symmetrical for neg. angles [Simétrico para &ngulos negativos] - active esta casilla si s6lo
dispone de archivos PIR definidos para angulos positivos y desee que el patron sea simétrico
para los angulos negativos.

Seccion Frecuency range [Rango de frecuencias]:
Low (Hz) [Bajo] — introduzca el limite de las bajas frecuencias para la estimacion de la
respuesta en frecuencia
High (Hz) [Alto] — introduzca el limite de las altas frecuencias para la estimacion de la
respuesta en frecuencia

Seccion FFT analysis [Andlisis FFT]:
Ungated from estimated PIR maximum position [Sin limitacion desde la posicion PIR
méaxima estimada] — active esta casilla para estimar la respuesta en frecuencia a partir de la
respuesta limitada que se determina con el requisito de baja frecuencia y tiempo-ancho de
banda y el punto de inicio del archive PIR que representa la primera muestra cuya magnitud es
20 dB inferior a la magnitud PIR maxima.
Ungated from PIR start position [Sin limitacion desde la posicion de inicio PIR] -
seleccione esta casilla para la estimacion de la respuesta en frecuencia desde la primera
muestra en el archive PIR y con una tamafio FFT determinado por el requisito de baja
frecuencia y tiempo-ancho de banda.
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Gated [Limitada] — seleccione esta casilla para obtener una estimacion de respuesta en
frecuencia a partir de la posicion de inicio definida por el usuario en el archive PIR y la
limitacion de Longitud de tiempo definida por el usuario. El Inicio y la Longitud se han de
introducir en milisegundos.

La seccion de User info [Informacion de usuario] contiene un cuadro de edicion en el que el usuario
introduce un texto arbitrario que se archivard como archivo DPF.

9.1.4 Formato de archivos DPF

El archivo del patron de directividad (DPF) es un archivo binario con el siguiente formato:

char filesignature[4]; // cuatro caracteres de firma: 'D','P','F',\0
unsigned int version; // version del formato de archive comenzando en 0x0100
int numFregs; // cantidad de frecuencias espaciadas logaritmicamente

int numOct3;
// cantidad de bandas de 1/3 octave estandar

int numOctl; // cantidad de bandas de 1/1 octave estandar

int numAngles; // cantidad de angulos de medicion

int smoothingresolution; // resolucion de suavizado: 1,3,6,12

int info_string_size; // tamafio de las cadenas definidas por el usuario
int reserved;

float Angles[numAngles]; // serie de angulos en grados

float Frequencies[numFreqs]; // serie de frecuencias en Hz

int idxOct3[m_numOct3]; // serie de bandas de 1/3 octave estandar

int idxOct1[m_numOctl]; // serie de bandas de 1/1 octave estandar

float Magnitude[numAngles][m numFreqs];  // serie de magnitudes en dB
char info[info_string_size]; // serie de caracteres en la cadena definida por el usuario

Los valores del patron de directividad en las frecuencias de 1/3 octavas o 1/1 octavas estdndar que se
pueden exportar a archivos de texto ASCII.

ARTA también puede exportar valores de los parametros de directividad (Q, DI y angulo de ancho de
haz) en bandas estandar de 1/3 octavas.
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Apeéndice — Mendus, barras de herramientas y teclas
de acceso directo

Menu de la ventana de la respuesta de impulso

File [Archivo]
New [Nuevo] - crea un nuevo archivo llamado “Untitled.pit”
Open [Abrir] — Abre el archivo
Save [Guardar] -
Save As [Guardar como] — guarda el archivo con un nombre nuevo
Info [Informacion] — muestra la informacion sobre el archivo .pir actual
Export [Exportar] — guarda los datos de la respuesta de impulso en los siguientes formatos:
ASCI| file [Archivo ASCII1] — guarda los datos de la respuesta de impulso en formato ASCII.
MLSSA ASCII file [Archivo MLSSA ASCII] - guarda los datos de la respuesta de impulso en
formato MLSSA ASCII.
WAV file [Archivo WAV] — guarda los datos de la respuesta de impulso en formato .wav.
Import [Importar] — importa los datos de la respuesta de impulso de los siguientes formatos:
WAV file [Archivo WAV] — importa los datos de la respuesta de impulso en formato .wav.
MLSSA .TIM file [Archivo MLSSA .TIM] — importa los datos de la respuesta de impulso en formato

MLSSA .TIM.
MLSSA ASCII file [Archivo MLSSA ASCII] - importa los datos de la respuesta de impulso en
formato MLSSA ASCII.
ASCI | file [Archivo ASCII] — importa los datos de la respuesta de impulso (tiempo-amplitud)
en formato ASCII.

Load and sum [Cargar y sumar] — carga el archivo .pir y lo suma a la respuesta de impulso actual
Recent File [Archivos recientes] — abre un archivo que se haya abierto recientemente
Exit [Salir] — Sale del programa

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
Colors and grid styles [Estilos de colores y cuadricula] — activa el cuadro de didlogo de configuracion
del color
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
Set Marker [Establecer marcador] - establece un marcador en la posicion del cursor
Delete Market [Borrar marcador] — Borra el marcador
Invert [Invertir] - cambia la polaridad de la respuesta de impulsos
Rotate at cursor [Girar en el cursor] — gira la respuesta de impulso periodica (el cursor se convierte en
la primera muestra)
Scale [Escalar] — multiplica la respuesta de impulsos por una constante arbitraria
View [Ver]
Toolbar [Barra de herramientas] — muestra u oculta la barra de herramientas
Status Bar [Barra de estado] — muestra u oculta la barra de estado

Record [Registro]
Impulse response [Respuesta de impulsos] - activa el cuadro de didlogo de medicion de la respuesta de
impulso

Analysis [Analisis]

Smoothed Frequency response [Respuesta de frecuencia suavizada] - muestra la respuesta de
frecuencia suavizada en bandas de 1/n octavas

DFT frequency response [Respuesta de frecuencia DFT] — muestra los componentes DFT de la
respuesta de frecuencia.

Step response [Respuesta de etapa] — muestra la respuesta de etapa

ETC - Impulse Response Envelope [ETC - Envolvente de la respuesta de impulso] - muestra la
envolvente de la respuesta de impulso (ETC)

Energy decay [Deterioro de energia] — muestra la curva de deterioro de energia de Schroeder
Cumulative spectral decay [Deterioro espectral acumulado] — muestra el cuadro de didlogo del
deterioro espectral acumulado
Modulation transfer function [Funcién de transferencia de modulacién] — Muestra el MTF de octava
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STI - Muestra el fndipe de transmision del habla - STI
RASTI - Muestra el Indice de transmision del habla rapido - RASTI

Setup [Configuracion]
Audio devices [Dispositivos de audio] - activa el cuadro de didlogo de configuracion de los dispositivos
de audio
Calibrate devices [Calibrar dispositivos] — activa el cuadro de didlogo de calibracion de la tarjeta de
sonido y del micréfono
Analysis parameters [Parametros de andlisis] - activa el cuadro de didlogo de configuracion del analisis
de la respuesta de impulso

Tools [Herramientas] (Este menu estara activo en la proxima version de ARTA)
Plot Combiner (FRD — ZMA) [Combinador de gréficos (FRD - ZMA)] - activa el cuadro de didlogo
para dibujar la respuesta de frecuencia y la curva de impedancia combinadas
SPL meter [Medidor de SPL] — activa el cuadro de didlogo con un medidor SPL virtual
Directivity plot [Grafico de directividad] — activa el cuadro de didlogo para dibujar los patrones de
directividad del altavoz
Spatial Acoustical parameters [Pardmetros acusticos espaciales] — activa el cuadro de didlogo para
estimar los parametros espaciales de la sala.

Mode [Modo]
Impulse response [Respuesta de impulsos] - activa la ventana de la respuesta de impulso
Spectrum Analyzer [Analizador de espectros] - activa la ventana del analisis de espectros
Dual channel - frequency response [Canal doble - respuesta de frecuencia] - activa la ventana de
respuesta de frecuencia en canal doble
Single channel - frequency response [Canal sencillo - respuesta de frecuencia] - activa la ventana de
respuesta de frecuencia en canal sencillo

Help [Ayuda]
About [Acerca de]—proporciona informacion sobre el programa
Registration [Registro] — muestra la informacion de registro / usuario
User Manual [Manual de usuario] - muestra el archivo de ayuda

Ventana de la respuesta de impulso — Barra de estado

...............................................................

Ready {L:-100.0dE | F:-100.0d8 | Impulse Response

El texto de la izquierda muestra el contexto del menu.

El cuadro de texto de la derecha muestra la modalidad de medicion.

Cuadros de texto izquierdo y derecho: Muestran los niveles maximos a escala completa de los canales de entrada
izquierdo y derecho durante la tiltima medicion.

Ventana de la respuesta de impulso — Iconos de la barra de herramientas

Record DFT Impulse  Cumulative
Copy to Measurement im FR
| pulse frequency response Spectral STI
clipboard micdes response comgansation resfunse envelope Decay

! R v

Ca 7 ||Ine Frz Fri Sea | B | =0 mm | (=2 75 059 ASF A9 BN (Y (o | &%

f [ A

Background Audic Smoothed Enat
color BAW devices  frequency  SI®P - TE MTF RASTI
EE[UP rasponsa po

Venta
na de la respuesta de impulso — Barra de control
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Ventana de la respuesta de impulso — Barra de control

FFT [4095 =] Window [Unifom v Delay for phase estimation fms] [0.000 | Get| | Zera| [ Inv]

FFT - establece el tamaiio de la ventana de andlisis FFT

Window [Ventana] — establece el tipo de ventana de sefial

Delay for phase estimation (ms) [Retardo para la estimacion de fase (ms)] — establece el intervalo de
tiempo, desde la posicion del cursor, de referencia para la estimacion de fase.

Get [Obtener] - obtiene el intervalo de tiempo entre el cursor y el marcador

Zero [Cero] — establece un retardo cero

Inv - cambia la polaridad de la respuesta de impulsos

Acceso rapido con el ratén
Puede cambiar la posicion del marcador y del cursor pulsando y arrastrando los botones izquierdo y
derecho del raton.
Haga doble clic sobre el boton derecho del raton para activar o desactivar el marcador.
Arrastrando el ratdn a la zona de las etiquetas se desplaza la curva horizontal o verticalmente.
Haciendo doble clic sobre el boton izquierdo del boton sobre el area del eje de tiempo cambia la etiqueta
de posicion tiempo/muestra.

Acceso rapido con el teclado
Teclas arriba y abajo - para cambiar la ganancia
Teclas Ctrl+arriba y Ctrl+abajo - para cambiar la compensacion vertical
Teclas izquierda y Ctrl+izquierda — para desplazar la curva hacia la izquierda.
Teclas derecha y Ctrl+derecha — para desplazar la curva hacia la derecha
Teclas Shift+izquierda y shift+derecha — para mover el cursor hacia la izquierda y la derecha
Tecla Repag y Avpag - para cambiar el factor de ampliacion
Tecla Ctrl + S — guardan el archivo
Tecla Ctrl + N — crean un nuevo archivo
Tecla Ctrl + O — abren el archivo
Tecla Ctrl + C - copia un grafico de mapa de bits al portapapeles (con las opciones definidas por el
usuario)
Tecla Ctrl + P — copia toda la ventana como mapa de bits al portapapeles
Tecla Ctrl + B — cambia el color del fondo
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Menu de la ventana del analizador de espectros

File [Archivo]
Export ASCII [Exportar a ASCII] — exporta los valores del grafico a un archivo de formato ASCIL.
Exit [Salir] — Sale del programa

Overlay [Superposicion]
Set overlay [Establecer superposicion] — establecer la respuesta en frecuencia actual como
superposicion
Delete overlay [Borrar superposicion] — Eliminar la superposicion
Load overlay [Cargar superposicidon] — Cargar el archivo con la superposicion de la respuesta en
frecuencia
Save overlay [Guardar la superposicidon] — Guardar la respuesta en frecuencia en un archivo de
superposicion

Edit [Edicion]
Copy [Copiar] - copia el mapa de bits del grafico y la etiqueta definida por el usuario al portapapeles
Colors and grid styles [Estilos de colores y cuadricula] — activa el cuadro de didlogo de configuracion
del color

View [Ver]
Toolbar [Barra de herramientas] — muestra u oculta la barra de herramientas
Status Bar [Barra de estado] — muestra u oculta la barra de estado
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
Fit graph top [Ajustar la parte superior del gréfico] — Ajusta los margenes del grafico al valor
maximo de la magnitud

Frequency Axis [Eje de frecuencias]
Lin - lineal
Log - Logaritmico
Octave Smoothing [Suavizado de octavas] - Respuesta logaritmica suavizada en bandas de 1/n octavas)
Octave Bands [Bandas de octava] — Respuestas en bandas de 1/n octavas

Resolution [Resolution]

1/1 octave [1/1 octava] - ancho de banda del filtro de 1/1 octava
1/2 octave [1/2 octava] - 1/2 octava

1/3 octave [1/3 octava] - 1/3 octava

1/6 octave [1/6 octava] - 1/6 octava

1/9 octave [1/9 octava] - 1/9 octava

1/12 octave [1/12 octava] - 1/12 octava

1/24 octave [1/24 octava] - 1/24 octava

Scaling [Graduacidn]
dB FS - relativo a la escala completa (dB)
dB V (SPL) - relativo al valor RMS (dB)
PSD - Densidad espectral de potencia dB/sqrt(Hz)

Voltage units [Unidades de voltaje]
dBV - dBre 1V
Bu - dBre 0,775V (1mW/600€2)

Sound pressure units [Unidades de presion de sonido]
dB re 20uPa - unidad para el nivel de presion en actstica
dB re 1Pa - unidad para el nivel de presion en las recomendaciones ITU T

Weighting [Ponderacion]
None [Ninguna] — no se usa filtro de ponderacion
A —filtro A estandar
B — filtro B estandar
C — filtro C estandar
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Info [Informacion]
Rms Level [Nivel Rms] - muestra el nivel RMS de la sefial
Distortion [Distorsion] - muestra las distorsiones (armonica o intermodulacion)
Distortion+Noise [Distorsion + Ruido] - muestra la distorsion + ruido

Recorder [Grabadora]
Run [Inicio] — comienza la grabacion
Stop [Fin] — se detiene la grabacion
View time record [Ver el registro temporal] - muestra la ventana de registro temporal

Generator [Generador]
Run [Inicio] - comienza la generacion de sefial
Stop [Fin] - se detiene la generacion de sefial
Configure [Configurar] - activa el cuadro de didlogo de la configuracion del generador

Setup [Configuracidon]
Audio devices [Dispositivos de audio] - activa el cuadro de didlogo de configuracion de los dispositivos
de audio

Calibrate devices [Calibrar dispositivos] — activa el cuadro de dialogo de calibracion de la tarjeta de
sonido y del micréfono

FR compensation [Compensacion respuesta en frecuencia] — Activa el cuadro de didlogo de
compensacion de la respuesta en frecuencia

Measurement [Medici6n] - activa el cuadro de didlogo de la configuracion del andlisis de espectros
Graph setup [Configuracion del grafico] - activa el cuadro de didlogo de la configuracion del grafico
de espectros

Scaling [Graduacidn] - activa el cuadro de dialogo de la graduacion de espectros

Use 64-bit FFT [Use FFT de 64 bit] - activa/desactiva el procesado de doble precision de FFT

Mode [Modo]
Impulse response [Respuesta de impulsos] - activa la ventana de la respuesta de impulso
Spectrum Analyzer [Analizador de espectros] - activa la ventana del analisis de espectros
Dual channel frequency response [Respuesta de frecuencia en canal doble] - activa la ventana de
respuesta de frecuencia en canal doble
Single channel frequency response [Respuesta de frecuencia en canal sencillo] - activa la ventana de
respuesta de frecuencia en canal sencillo

Help [Ayuda]
About [Acerca de]—proporciona informacion sobre el programa

Registration [Registro] — muestra la informacion de registro / usuario
User manual [Manual de usuario] - muestra el archivo de ayuda

Ventana del analizador de espectros — Iconos de la barra de herramientas
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Ventana del analizador de espectros — Barra de control superior

Gen [Sine v| FsiHz) [seoo0 =] FFT [e12 =] Wind [Hanning | Ava [None =] [ Reset]

Gen — establece el tipo de generador

Fs (Hz) - establece la frecuencia de muestreo

FFT — establece el tamafio de un bloque de adquisicion FFT
Wnd - establece la ventana de sefial para el analisis FFT
Avg - establece el tipo de compensacion

Reset [Borrar] - borra las compensaciones

Ventana del analizador de espectros — Barra de control derecha
Changes graph top magnitude margin
Fit plotted curve to graph top magnitude margin

Changes graph magnitude range

Opens dialog box for the setup of graph margine

Changes graph high-frequency margin

-l
i

Changes graph low-fraquency margin

Acceso rapido con el ratén:

Si se pulsa y arrastra el boton izquierdo del ratéon se cambia la posicion del cursor

Si se hace clic con el boton derecho del ratén en la zona del grafico se activa el cuadro de didlogo de la
configuracion del margen del grafico.

Si se hace clic con el boton derecho del raton en la zona del titulo se activa el cuadro de didlogo de la
graduacion del grafico.

La rueda de desplazamiento del ratobn mueve el margen superior del grafico hacia arriba y abajo.

Acceso rapido con el teclado:
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Teclas arriba y abajo - cambian el margen del grafico superior

Teclas izquierda y derecha - mueven el cursor hacia la izquierda y la derecha

Tecla Ctrl + C - copia un grafico de mapa de bits al portapapeles (con las opciones definidas por el
usuario)

Tecla Ctrl + P — copia toda la ventana como mapa de bits al portapapeles

Tecla Ctrl + B — cambia el color del fondo

Tecla Ctrl+A - establece la curva trazada actual como superposicion

Menu de la ventana de respuesta de frecuencia (2 canales o0 1)

File [Archivo]
Export ASCII [Exportar a ASCII] — exporta los valores del grafico a un archivo de formato ASCII.
Save as PIR [Guardar como PIR] - transforma la respuesta en frecuencia actual en una respuesta en
impulso que la archiva como un archivo .PIR.
Exit [Salir] — Sale del programa

Overlay [Superposicion]
Set overlay [Establecer superposicion] — establecer la respuesta en frecuencia actual como
superposicion
Delete overlay [Borrar superposicion] — Eliminar la superposicion
Load overlay [Cargar superposicion] — Cargar el archivo con la superposicion de la respuesta en
frecuencia
Save overlay [Guardar la superposicidn] — Guardar la respuesta en frecuencia en un archivo de
superposicion
Generate target response [Generar respuesta objetivo] — Generar una superposicion con respuesta de
filtros de cruce estandar
Delete target response [Borrar respuesta objetivo] — Generar una superposicion con respuesta de filtros
de cruce estandar

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
Colors and grid styles [Estilos de colores y cuadricula] — activa el cuadro de didlogo de configuracion del
color
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro

View [Ver]
Toolbar [Barra de herramientas] — muestra u oculta la barra de herramientas
Status Bar [Barra de estado] — muestra u oculta la barra de estado
Fit graph top [Ajustar la parte superior del gréfico] — Ajusta los margenes del grafico al valor
maximo de la magnitud

Frequency Axis [Eje de frecuencias]

Linear [Lineal] — establece el eje de frecuencias lineal.

Log — establece el eje de frecuencias logaritmico

Octave Smoothing [Suavizado de octavas] — eje logaritmico para magnitudes suavizadas en 1/n

octavas

Octave Bands [Bandas de octava] — barras para bandas de 1/n octavas
Resolution [Resolution]

1/1 octave [1/1 octava] - ancho de banda del filtro de 1/1 octava

1/2 octave [1/2 octava] - 1/2 octava

1/3 octave [1/3 octava] - 1/3 octava

1/6 octave [1/6 octava] - 1/6 octava

1/9 octave [1/9 octava] - 1/9 octava

1/12 octave [1/12 octava] - 1/12 octava

1/24 octave [1/24 octava] - 1/24 octava

Sound pressure units [Unidades de presion de sonido]
dB re 20uPa/1V - unidades para la respuesta de presion en los estandares acusticos
dB re 20uPa/2.83V - unidades para la sensibilidad del altavoz
dB re 1Pa/1V - unidades para la respuesta de presion en las recomendaciones ITU_T

Recorder [Grabadora]
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Run [Inicio] — comienza la grabacion
Stop [Fin] — se detiene la grabacion
View time record [Ver el registro temporal] - muestra la ventana de registro temporal

Generator [Generador]
Run [Inicio] - comienza la generacion de sefal
Stop [Fin] - se detiene la generacion de sefial
Configure [Configurar] - activa el cuadro de didlogo de la configuracion del generador

Setup [Configuracion]

Audio devices [Dispositivos de audio] - activa el cuadro de didlogo de configuracion de los dispositivos
de audio

Calibrate devices [Calibrar dispositivos] — activa el cuadro de didlogo de calibracion de la tarjeta de
sonido y del micr6fono

FR compensation [Compensacion respuesta en frecuencia] — Activa el cuadro de didlogo de
compensacion de la respuesta en frecuencia
Measurement [Medicidn] - activa el cuadro de diadlogo de la configuracion de la medicion de la
respuesta de frecuencia
Graph setup [Configuracion del grafico] - activa el cuadro de didlogo de la configuracion del grafico
de la respuesta de frecuencia

Mode [Modo]
Impulse response [Respuesta de impulsos] - activa la ventana de la respuesta de impulso
Spectrum Analyzer [Analizador de espectros] - activa la ventana del anlisis de espectros
Dual channel frequency response [Respuesta de frecuencia en canal doble] - activa la ventana de
respuesta de frecuencia en canal doble
Single channel frequency response [Respuesta de frecuencia en canal sencillo] - activa la ventana de
respuesta de frecuencia en canal sencillo

Help [Ayuda]
About [Acerca de] - proporciona informacion sobre el programa

Registration [Registro] — muestra la informacion de registro / usuario
User manual [Manual de usuario] - muestra el archivo de ayuda

Ventana de la respuesta de frecuencia — Iconos de la barra de herramientas

Cogy to Measurement Slart Start Spectrum Audia Ganeratar
clipboard modes recarding genarator scaling davicas satup

! ! A

i ¥ |Ine|FreFRa Sea [ 0 @ [ @ |7 | | =0 sm

f Pt L

Background Stop Stop Measurament FR Wiew lime
color BAN recording generator setup  comgpensation record

Ventana de la respuesta de frecuencia — Barra de control

Gen [Fik noiss ¥ FsiHz) [48000 v FFT [16384 =] Delayimsf0.000 Ava [Nore x| | Reset|

Gen — establece el tipo de generador de sefal
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Fs (Hz) - establece la frecuencia de muestreo

FFT size [Tamafio FFT] — establece el nimero de muestras de un bloque FFT

Delay (ms) [Retardo] — establece el retardo en el sistema medido (no usado en la modalidad de canal sencillo),
Avg — establece el tipo de compensacion (Ninguna, lineal, exponencial)

Reset [Borrar] - borra las compensaciones

Acceso rapido con el ratén:
Si se pulsa y arrastra el boton izquierdo del ratéon se cambia la posicion del cursor
Si se hace clic con el boton derecho del raton en la zona del grafico se activa el cuadro de didlogo de la
configuracion del margen del grafico.
La rueda de desplazamiento del raton mueve el margen superior del grafico hacia arriba y abajo.

Acceso rapido con el teclado:

Teclas arriba y abajo - cambian el margen del grafico superior

Teclas izquierda y derecha - mueven el cursor hacia la izquierda y la derecha

Tecla Ctrl + C - copia un grafico de mapa de bits al portapapeles (con las opciones definidas por el
usuario)

Tecla Ctrl + P — copia toda la ventana como mapa de bits al portapapeles

Tecla Ctrl + B — cambia el color del fondo

Tecla Ctrl+A - establece la curva trazada actual como superposicion

Menu de la ventana de la respuesta de frecuencia suavizada

File [Archivo]
Export ASCII [Exportar a ASCII] — exporta los valores del grafico a un archivo de formato ASCII.
Repeat PIR measurement [Repetir medicion PIR] — abre el cuadro de didlogo de la medicion PIR. Si
es correcto, calcula la respuesta de frecuencia usando la posicion del cursor y del marcador a partir de la
ventana PIR.
Save PIR as [Guardar PIR como] — guarda la tltima medicion o archivo .PIR

Overlay [Superposicion]
Set as overlay [Establecer superposicion] — se fija la curva de impedancia actual como superposicion
Set as overlay Below cursor [Establecer superposicion por debajo del cursor] — guarda la parte de
la curva actual por debajo del cursor como superposicion
Set as overlay Above cursor [Establecer superposicion por encima del cursor] — guarda la parte de
la curva actual por encima del cursor como superposicion
Manage Overlays [Gestor de superposiciones] — activa el cuadro de didlogo 'FR Overlay Manager'
[Gestor de superposiciones de respuestas de frecuencia] para editar la lista de superposiciones.
Delete all [Borrar todo] — Borra todas las superposiciones
Delete last [Borrar Gltima] — Borra la ultima superposicion
Generate target response [Generar respuesta objetivo] — Generar una superposicion con respuesta de
filtros de cruce estandar
Delete target response [Borrar respuesta objetivo] — Generar una superposicion con respuesta de filtros
de cruce estandar

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
Colors and grid styles [Estilos de colores y cuadricula] — abre el cuadro de didlogo de configuracion
del color del grafico
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
Use thick pen [Usar trazo grueso] -usa un trazo grueso para trazar las curvas
Cut below cursor [Cortar debajo del cursor] — corta los valores del grafico por debajo del cursor
Cut above cursor [Cortar encima del cursor] — corta los valores del grafico por encima del cursor
Scale level [Nivel de escala] — escala el nivel con un factor arbitrario (diferencia en dB)
LF box diffraction [Difraccién de caja en bajas frecuencias] — Escala los niveles con la respuesta de la
difraccion en bajas frecuencias de la caja del altavoz
Subtract overly [Restar superposicion] — resta los valores del nivel de superposicion de la curva actual
Subtract from overlay [Restar de la superposicion] - resta los valores del nivel de la curva actual de la
superposicion
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Power average with overlays [Compensacién de potencia con superposiciones] — hace que la
magnitud actual sea la compensacion de potencia de la magnitud actual y las magnitudes de las
superposiciones y elimina todas las superposiciones que se muestran de manera opcional.

Merge overlay below cursor [Fusionar la superposicion por debajo del cursor] — fusiona los valores
de la superposicion de la curva actual por debajo del cursor

Merge overlay above cursor [Fusionar la superposicién por encima del cursor] — fusiona los valores
de la superposicion de la curva actual por encima del cursor

View [Ver]
Magnitude [Magnitud] — muestra la magnitud de la respuesta de frecuencia
Magn+Phase [Magnitud + Fase] — muestra la magnitud y la fase de la respuesta de frecuencia
Phase [Fase] — muestra la fase de la respuesta de frecuencia
Group delay [Retard de grupo] — muestra el retardo de grupo
Minimum phase [Fase minima] - muestra la fase minima del sistema
Excess phase —muestra el exceso de fase
Excess group delay — muestra el exceso de retraso de grupo
Unwrap Phase [Fase sin envolver] — muestra la fase sin envolver
Time-Bandwidth Requirement [Requisitos ancho de banda-tiempo] — si se activa esta casilla, se
trazan s6lo las curvas de las frecuencias en las que el producto ancho de banda — tiempo es mayor de 1.

Sound pressure units [Unidades de presion de sonido]
dB re 20uPa/V - establece las unidades para la sensibilidad del altavoz
dB re 20uPa/2.83V - establece las unidades para la sensibilidad del altavoz (ref. 1W/8ohm)
dB re 1Pa/1V - establece las unidades para el nivel de presion de acuerdo con las recomendaciones
ITU T

Smoothing [Suavizado]

1/1 octave [1/1 octava] - ancho de banda del filtro de 1/1 octava
1/2 octave [1/2 octava] - 1/2 octava

1/3 octave [1/3 octava] - 1/3 octava

1/6 octave [1/6 octava] - 1/6 octava

1/9 octave [1/9 octava] - 1/9 octava

1/12 octave [1/12 octava] - 1/12 octava

1/24 octave [1/24 octava] - 1/24 octava

Acceso rapido con el teclado:

Teclas arriba y abajo - cambian el margen del grafico superior

Teclas izquierda y derecha - mueven el cursor hacia la izquierda y la derecha

Tecla Ctrl + C - copia un grafico de mapa de bits al portapapeles (con las opciones definidas por el
usuario)

Tecla Ctrl + P — copia toda la ventana como mapa de bits al portapapeles

Tecla Ctrl + B — cambia el color del fondo

Tecla Ctrl+A - establece la curva trazada actual como superposicion

Tecla Ctrl+M - abre el cuadro de didlogo de gestion de superposiciones

Menu de la ventana de la respuesta de frecuencia DFT

File [Archivo]
Export ASCII [Exportar a ASCII] — exporta los valores del grafico a un archivo de formato ASCIL.
Repeat PIR measurement [Repetir medicion PIR] — abre el cuadro de didlogo de la medicion PIR. Si
es correcto, calcula la respuesta de frecuencia usando la posicion del cursor y del marcador a partir de la
ventana PIR.
Save PIR as [Guardar PIR como] — guarda la tltima medicion o archivo .PIR

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
Colors and grid styles [Estilos de colores y cuadricula] — abre el cuadro de didlogo de configuracion
del color del grafico
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
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View [Ver]

Magnitude [Magnitud] — muestra la magnitud de la respuesta de frecuencia

Magn+Phase [Magnitud + Fase] — muestra la magnitud y la fase de la respuesta de frecuencia

Phase [Fase] — muestra la fase de la respuesta

Group delay [Retard de grupo] — muestra el retardo de grupo

Sound pressure units [Unidades de presion de sonido]

dB re 20uPa/V - establece las unidades para la sensibilidad del altavoz

dB re 20uPa/2.83V - establece las unidades para la sensibilidad del altavoz

dB re 1Pa/1V - establece las unidades para el nivel de presion de acuerdo con las recomendaciones

ITU T

Setup [Configuracion] — activa el cuadro de didlogo para la configuracion de los margenes del grafico

Time-Bandwidth Requirement [Requisitos ancho de banda-tiempo] - si se activa esta casilla, se

trazan solo las curvas de las frecuencias en las que el producto ancho de banda — tiempo es mayor de 1.

Teclas de acceso directo del teclado (también para el resto de ventanas):

Teclas arriba y abajo - cambian el margen del grafico superior

Teclas izquierda y derecha - mueven el cursor hacia la izquierda y la derecha

Tecla Ctrl + C - copia un grafico de mapa de bits al portapapeles (con las opciones definidas por el
usuario)

Tecla Ctrl + P — copia toda la ventana como mapa de bits al portapapeles

Tecla Ctrl + B — cambia el color del fondo

Menu de la ventana de la respuesta de etapa

File [Archivo]
Export ASCII [Exportar a ASCII] — exporta los valores del grafico a un archivo de formato ASCIL.
Edit [Edicion]
Copy [Copiar] - copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro

Menu de la ventana de deterioro espectral acumulado

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro

Ventana de deterioro de energia

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
Set marker [Establecer marcador] - establece un marcador en la posicion del cursor
Delete Market [Borrar marcador] — Borra el marcador
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro

Ventana de la envolvente de respuesta de impulsos (ETC)

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
Set marker [Establecer marcador] - establece un marcador en la posicion del cursor
Delete Market [Borrar marcador] — Borra el marcador

Menu de la ventana MTF

Edit [Edicion]
Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles
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B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
Octave [Octava]

125 Hz

250Hz

500Hz

1000Hz

2000Hz

4000Hz

8000Hz

Ventana de directividad

File [Archivo]

Create directivity pattern file [Crear un archivo de patron de directividad] — abre un cuadro de
dialogo para crear un archivo de patron de directividad a partir de los archivos .pir.

Save directivity pattern file [Guardar el archivo de patrén de directividad] — guardar el archivo de
patron de directividad (.dpf).

Load directivity pattern file [Cargar el archivo de patrén de directividad] — carga el archivo de
patréon de directividad (.dpf).

Export ASCII 1/3 octave data [Exportar datos ASCII de 1/3 octava] — exporta en valores de archive
ASCII en frecuencias estandar de 1/3 octava.

Export ASCII & 1/1 octave data [Exportar datos ASCII y 1/1 octava] — exporta en valores de archivo
ASCII en frecuencias estandar de 1/1 octava.

Export Directivity Index and Angle (-6dB) [Exporta el indice y angulo de directividad (-6dB)] -
exporta en un archive DI, Q y el angulo en ASCII (-6dB)

File Info [Informacion de archive] — propociona informacion y texto definido por el usuario originaria
del archive .dpf actual.
Edit [Edicion]

Copy [Copiar] — copia el mapa de bits del grafico y el texto definido por el usuario al portapapeles

B/W background color [Color de fondo B/N] — determina el color de fondo en blanco o en negro
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